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Introduction

Beamex was founded in 1975 by people with experience in calibration and quality
maintenance of instruments. CMX is developed based on that knowledge. CMX also

represents Beamex 3™ generation of calibration management software.

Beamex CMX Calibration Management Software helps you to manage your
instrumentation assets safely and to plan and execute calibrations efficiently,

even in highly regulated industries. CMX communicates seamlessly with Beamex
documenting calibrators and the Beamex bMobile Calibration Application, enabling
automated calibration and documentation. All calibration results are permanently
stored to maintain a full calibration history, and data is easily available for analysis
and reporting, as well as for generating calibration certificates.

The main features are:

* Role-based access control

» Instrument and refence management

+ Digital data flow between CMX and supported mobile solutions

» Calibration scheduling and guided execution

* Uncertainty calculations

 Full calibration history

» Evolving lifecycle solution with extensive services

CMX supports the following Beamex documenting calibrators: MC6, MC6-Ex, MC6-
T, MC6-WS, MC4 and MC2-MF. The communication with older Beamex calibrators or
3™ party calibrators may work but is not officially tested or supported.

CMX Variants

CMX is available with different licenses and installation options to suit everyone, from
small companies to large multi-site enterprises.

CMX Professional

CMX Professional is a highly configurable solution that can be customized to fit a
wide range of needs. The standard functionality includes all CMX main features, and
optional advanced features are also available. CMX Professional is available as a
workstation or floating server installation.

CMX Enterprise

CMX Enterprise is an all-in-one calibration solution for large, multi-site companies.
It includes all CMX main and advanced features as standard and is fit for even the
most highly regulated industries. CMX Enterprise is a floating server installation that
offers maximum flexibility and productivity.
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See Feature Comparison for more information of differences between CMX variants.

How to see/know which CMX variant you have

The splash screen shown when CMX is started shows which variant you have at
hand. Another way to identify your CMX variant and version is opening the About
screen using menu commands Help > About.

Also: A CMX Help window has in its upper right corner a picture that presents the
CMX variant the help was called from.
How to know which features presented here apply to your CMX

Features presented in this manual are mentioned at the beginning of the topic if they
are optional in a certain variant.

Feature Comparison

The following table presents the features available in CMX products:

Table 1: Feature Comparison

CMX Features, Options and Related CMX CMX Enterprise
Products Professional

LICENSES AND INSTALLATION

Single workstation license with hardware Professional N/A
license key

Floating server license with software license |Professional FS |Standard
key

Cloud installation Ask Beamex Ask Beamex
DATABASE SUPPORT

SQL Server (Express, delivered as default) |Standard Standard
CMX database manager tool for SQL Server | Standard Standard
Oracle database support (not available Optional Standard
for new customers, existing databases

supported)

ROLE-BASED ACCESS CONTROL

User accounts, user groups and permissions | Standard Standard
Site user maintenance Standard Standard
SSO/LDAP External Authentication Optional Standard
INSTRUMENT MANAGEMENT

1000 positions/devices in the database Standard N/A
5000 positions/devices in the database Optional N/A
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CMX Features, Options and Related CMX CMX Enterprise
Products Professional

10,000 positions/devices in the database Optional N/A
Unlimited number of positions/devices in the |Optional Standard
database

Hierarchical plant structure Standard Standard
Position and device database Standard Standard
Position and device sets Standard Standard
Wizard for instrument database population |Standard Standard
Calibration procedure management Standard Standard
Function templates to generate calibration Standard Standard
procedures

User-defined transfer functions, temperature |Standard Standard
sensors, pressure units and list items

Saved filters Standard Standard
Electronic signatures for instruments® Optional Standard
Data Loader to add or edit large numbers of |Optional Standard
instruments

Business Bridge Equipment Import for Optional Optional
importing instruments from CMMS

REFERENCE MANAGEMENT

Calibrator database with manufacturer and | Standard Standard
model

Calibrator reference modules with e.g. Standard Standard
quantities and ranges

Weight sets for weighing instrument Optional Standard
calibration

Predefined uncertainty specifications for Standard Standard
Beamex calibrators

User-defined calibrators/references Standard Standard
Calibrators due for calibration Standard Standard
Link between calibrator and position to Standard Standard
synchronize calibration interval and due date

data

Electronic signatures for calibrators*® Optional Standard
CALIBRATION SCHEDULING AND GUIDED EXECUTION

Scheduling instrument calibration Standard Standard
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CMX Features, Options and Related CMX CMX Enterprise
Products Professional

Calibration procedures and methods sent to |Standard Standard
mobile solutions to guide the execution

Approval of instruments and calibrators can |Optional Standard
be required for calibration execution*

Communication (USB) with documenting Standard Standard
calibrators (MC6 family, MC4, MC2)

Wireless communication with MC6 family Standard Standard
calibrators

Communication with bMobile Calibration Standard Standard
Application (requires CWSI)

Calibration Web Service Interface (CWSI) as | Standard Standard
the communication link between CMX and

documenting calibrators or bMobile

Beamex Sync for asynchronous data Professional FS | Standard
transfer between CMX and mobile solutions

Manual data entry Standard Standard
CALIBRATION RESULTS, REPORTING AND ANALYSIS

Calibration results in numerical and Standard Standard
graphical format

Full calibration history Standard Standard
Average and uncertainty calculation Standard Standard
Calibration certificates with As Found and As | Standard Standard
Left results

Automatic result validation with email Optional Standard
notifications*

Result approval with electronic signature* Optional Standard
Standard reporting templates (19 pcs) Standard Standard
Report template import/export Standard Standard
Report Design for maintaining report Optional Standard
templates

History Trend for analysing results over a Optional Standard
period

CMX Analytics Dashboard for a visual Optional Optional
overview of calibration data and KPls

REGULATORY COMPLIANCE MANAGEMENT

Change Management (includes many Optional Standard
configurable functionalities marked with *)
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CMX Features, Options and Related CMX CMX Enterprise
Products Professional

Instruments, references and calibration Optional Standard

results as electronic records™

Electronic signatures for electronic records* | Optional Standard

Audit trail i.e. change log that tracks Optional Standard

database changes and events*

Mobile Security Plus for ensuring calibration | Optional Standard
data integrity when executing calibrations
offline (requires a MC6 family calibrator or

bMobile)

ADVANCED APPLICATIONS

Configurable User Interface Optional Standard
Maintenance Inspections (requires bMobile) |Optional Standard
Weighing Instrument Calibration Optional Standard
Enhanced Work Order Handling (requires Optional Standard

Business Bridge)

Business Bridge Work Order Handling Optional Optional
(EWOH option recommended)

SOFTWARE UPDATES AND SUPPORT
Software Service Agreement (SSA) Optional Optional

*part of the Change Management option

SSA and Support

A calibration solution is a long-term investment, and a software service agreement
(SSA) helps you maximize the return on that investment. With an SSA from Beamex
you will benefit from the latest updates and innovations developed by our R&D team
to improve the functionality and reliability of your CMX software. You also have
access to support services from our helpdesk team should problems arise. The
online Beamex support portal is the fastest and easiest way for our customers to
contact us for help anytime, anywhere in the world.

Table 2: Contact Information to Beamex Support Services

Telephone: +358 10 550 5301
E-mail: support@beamex.com

Support Portal: https://support.beamex.com
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About This Document

The user of this document is expected to be familiar with the Windows® environment
and such terms as Clicking, Selecting, Double-clicking, Marking, using the
Secondary Button of the mouse, Drag and drop, Resizing a window, etc. If you are

unsure of a term, please refer to a Windows® User Guide.
This document focuses on giving you advice on how to use CMX. For information

concerning a device communicating with CMX, please consult the instruction manual
of that particular device.

The installation media in which the software was shipped also includes this document
in PDF format.

Typographic Conventions

This document uses the following typographic conventions:

» All words related to a CMX window are shown using a bold font style. More
specifically:

o Menu and submenu commands:
Example: File > Exit

o Command buttons:
Example: Click OK.

o Window names:

Example: the Calibrators window.

» File names and directories are in capital letters:
Example: D:\\CMX\CMX.EXE.

A Short Presentation of the Sections in This Document

This chapter briefly presents all sections found in this document.

Introduction

Basic Information about CMX, this document and calibration.

Starting CMX

A short section telling you how to start CMX and how to select a database.
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General Presentation of CMX

Gives you a detailed description of CMX'’s user interface, menus common features
etc. Please read this carefully before you start taking CMX into serious use.

Basic Settings

Contains information that should be reviewed when CMX is taken into use. Many
of the settings described in this section are usually done only once, like the Plant
Structure data. Certain parts, like the User and User Group settings are updated
whenever changes occur.

Adding Instruments to the Database

Tells you how to add instruments to CMX’s database using either the Wizard or
entering Position, Device, Function and Calibration Procedure data one by one. This
section also describes how to edit, link and unlink Positions/Devices.

Queries, Filters and Sets

A section for finding out what kind of tools CMX provides when you need to limit the
displayed data somehow.

Check Out / Check In Feature

Check Out / Check In Feature is a tool for locking instruments chosen for calibration
so no other user may edit the instrument data during calibration. After calibration

is done, the instrument is unlocked. Locking instruments may be done manually or
automatically depending on your settings.

Calibration

Here are the ways to utilize CMX for calibration presented; Communication with a
calibrator as well as manual data entry. This section also includes a presentation on
how to view the calibration results in CMX.

Calibration Certificates and Other Documents

Tells about the Documents types that are available in CMX; Calibration Certificates,
Reports and Labels.

Change Management and Audit Trail

This feature is optional in CMX Professional.

Change Management and Audit Trail make it possible to log changes made to
the database. This chapter also presents the Electronic Signature and Audit Trail
archiving features.

Calibrating Weighing Instruments

This feature is optional in CMX Professional.

Weighing Instrument Calibration allows you to calibrate Weighing Instruments using
the Manual Entry window. If you also have bMobile, you will furthermore be able to
calibrate Weighing Instruments using it.
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Maintenance Inspection
This feature is optional in CMX Professional.

Maintenance Inspection allows you to perform check procedures according to
IEC 60079-17 standard and also according to your own needs. The actual check
procedure is done using bMobile.

Work Order Handling

This feature is optional in CMX Professional.

Work Order Handling is a tool for handling work orders sent from asset and work
management software. CMX receives the necessary data and after calibration using
CMX manual entry, a calibrator or bMobile, updates and returns the work order data
back to asset and work management software.

Mobile Security Plus

This feature is optional in CMX Professional.

Mobile Security Plus enables users of CMX and supported Mobile Devices to secure
data integrity when performing calibrations.

Data Loader

This feature is optional in CMX Professional.

Data Loader is a tool for importing instrument data from other systems to CMX via
an Excel file. CMX Data Loader Printing can also be used to create an Excel file, in
which data can be edited and imported back to CMX.

Automated Result Validation

This feature is optional in CMX Professional.

Automated Result Validation allows CMX to automatically validate calibration result
data according to a predefined set of validation rules. It is possible to configure

and have CMX send second approval requests via e-mail when an automatically
invalidated calibration result requires a second approval.

CMX Database Manager

Presents a tool for database experts. CMX Database Manager allows you to backup,
restore and copy CMX databases.

Additional Information

Contains useful information on working with CMX.



Introduction - 17

Other Documents

When CMX is installed, some additional Help files are also included:
« CWX Cal cul ations

This Help file presents all the calculations that CMX performs. This Help file can be
opened in CMX Main Windows' Help menu. Select CMX Calculations.

+ CMX Report Vari abl es

This Help file presents all variables available in the Report Designer. See Creating
Your Own Certificates. This Help file can also be opened in CMX Main Windows'
Help menu. Select CMX Report Variables.

« CMX Application Server Help

This Help file presents the CMX Application Server shipped with CMX for Servers,
available in CMX Enterprise or CMX Professional FS versions. This Help File can
be opened in the CMX Server Service Manager Window' Help menu. Select CMX
Server Help... in the Help menu.

* Calibration Wb Service Interface (CW\8l) Help

This Help is installed separately with CWSI Client or CWSI Server. The help file
presents all settings available in CWSI Client and CWSI Server and it can be
opened either in the CWSI Client or the CWSI Server Configurator. Select Help or
Open help.

Note: These help files are also available pdf format in the Documents
0 folder of the CMX installation media.

What's New

The following sections/parts have been updated in this document when updating to
CMX version 2, revision 2.17.1:

* As a part of CMX's standard functionality Repeatability tests can now be
configured for conventional instruments. Chapters Calibration Procedure
Property Window Fields and General Info for Repeatability Test in the webhelp
contain more information about how the setup works.

» The electronic signature functionality which is part of the Change Management /
Audit Trail option has been extended by letting users create dynamic and
temporary Signature Approval workflows. See chapter Signature Workflows.

+ Filter functionality is now also available when working with Calibrators, Modules
and Module Ranges. See chapter How to Filter Data for more information.
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The following sections/parts have been updated in this document when updating to
CMX version 2, revision 2.16.1:

+ Point specific time in Calibration results and Manual Entry. Each calibration
point is automatically saved with a point specific time stamp when entering results
with CMX Manual Entry. More information on how to enable the related fields in
CMX can be found in the CMX webhelp, section Calibration Settings Fields.Point
specific time stamps are also received from calibrators supporting this feature.
MC6 family calibrators support this feature with firmware version 5.00 or later.
Supported Beamex bMobile application version is 2.9.0 or later.

» Support for using Single Sign-On with OpenID Connect Azure was added. More
information can be found in section External Authentication Settings.

* Logging in CMX Server Service and -Manager was added. For detailed
description see CMX Application Server Help.

Other minor enhancements and additions have also been done.

For detailed information concerning CMX updates, including update history, see the
Release Note included in the installation media.

About Calibration

A Calibration Procedure means measuring a process instrument's accuracy against
another more accurate device, for example a calibrator. The calibrator normally
contains measurement modules allowing the measurement of different engineering
units at different ranges.

What Can Be Calibrated?

The calibration may be carried out for a process Position (sometimes also called a
"Tag") with an installed Device, or the calibration may be for an uninstalled Device;
more precisely, the calibration is for a particular Function of the Position/Device.

The Three Steps

The calibration process is normally a three step event containing:

* As Found calibration, done to verify the current state of the instrument before
adjustment.

+ Adjustment, done to bring the instrument within the required specifications.

» As Left calibration, the final calibration in order to establish the state of the
instrument after the adjustment.
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When entering the result manually to CMX there is no limitations in the amount of As
Found and As Left calibrations or the number of calibration points. If you are sending
instruments for calibration using communicating calibrator, refer to the calibrator

manual to find out whether there are any limitations in either the amount of As Found
and As Left calibrations or the number of calibration points.
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Starting CMX

With the CMX delivery, separate installation instructions are included on the
installation media. Refer to them when installing CMX.

The installation instructions of all CMX family members are included on the
installation media.

How to Start CMX

When CMX is installed you can start using the software. Locate the CMX icon in your
Start menu to start the software.

Figure 1: CMX Icon

To use a fully functional CMX, the License Key must be in place. Without the License
Key CMX starts up as a Limited Evaluation version. Detailed info of the License Key
is in License Key.

CMX automatically places the current Windows User ID as the default user for
logging into CMX. If you are logging in for the very first time you must use the
Supervisor User ID and Password delivered with CMX. Then change the Supervisor
User ID and add other Users according to your needs. Adding Users is described in
Users and User Groups.

See also User Interface Language.

the same User ID by default. CMX Professional with floating server license
option and CMX Enterprise login is remembered also in last database
opened.

o Note: If you check Remember Used ID, next time you log in CMX uses

Note: If Lightweight Directory Access Protocol (LDAP) or OIDC Single

0 Sign-On (OIDC SSO) is enabled in CMX, use your network user name and
password to log into CMX. More on External Authentication in External
Authentication Settings.

Lightweight Directory Access Protocol and OIDC Single Sign-On are part of
the SSO / LDAP External Authentication feature, which is optional in CMX
Professional.
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Opening a Database

Available databases:

+ CMX_Demo_Database is a demo database for getting acquainted with CMX. This
is the default database when CMX is started for the first time after installation.

+ CMX_Database is an empty database for creating your own database. When
needed, you may switch to this database as described further on in this chapter.

own database. When the demo positions/devices are no longer needed,

0 Note: You may also use CMX_Demo_Database as the basis for your
just remove them from the database.

Note: By default, the Oracle database is case sensitive. Pay attention to
o letter cases when handling items in the Oracle database.

» Other databases. You may create your own CMX databases using the tools
available in CMX Database Manager. This however requires that you have
experience in working with databases and database servers.

Note: All databases mentioned above have the same Supervisor User ID
O and Password (shipped with CMX installation media). More info of CMX
versions is in CMX Variants.

Switching between databases

During login CMX offers to connect to the latest database used. To switch database,
select another (host and) database from the login window.

Alternatively, when CMX is already running, use the main window's menu to select:

* File > Log Off in CMX Enterprise or CMX Professional with the floating server
license option or

» File > Database in CMX Professional without the floating server license option.

Then enter required information to log into another database.

Authentication (default) or Windows Authentication. Use the

0 Note: CMX includes a possibility to utilize either SQL Server
Authentication selection list to choose the one you want.

See also User Interface Language.
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User Interface Language

When starting CMX or switching between databases, the login window includes the
possibility to select the user interface language from the Language combo. The
available user interface language options depend on the selected user interface
languages during installation.

Certain pick-up list options are displayed using the language of the base

o Note: During the installation, the base database was also selected.
database.

Function Templates and their Calibration Procedures have the same
language as the base database.

Starting CMX Using Startup Parameters

CMX may also be started using certain startup parameters in the command line.
In 32 bit Windows® operating systems:

"C:\Program Files\CMX\BxbMUIPD.exe" /DB:CMX_Demo_Database
/LANG:ENGLISH /USER:123 /PWD:SECRET /P:"101DR-P10014"

In 64 bit Windows® operating systems:

"C:\Program Files (x86)\CMX\BxbMUIPD.exe" /DB:CMX_Demo_Database
/LANG:ENGLISH /USER:123 /PWD:SECRET /P:"101DR-PI0014"

Begin the command line entry with the path where your CMX is installed and the
name of the CMX software (BxbMUIPD.exe) followed by the necessary parameters.
Each parameter starts with a preceding space and a slash character.

The following command line parameters are available:

Table 3: Command Line Parameters

Parameter Definition

/DB:DATABASE NAME The name of the database to be opened.

/DB: parameter is mandatory.
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Parameter Definition

ILANG:LANGUAGE The user interface language. Language name should
be written as is it seen in language selection list during
normal start/login, e.g. "FINNISH".

If no /[LANG: parameter is specified, CMX uses the
language chosen in a previous start.

If no /[LANG: parameter is specified and no previous
starts (with current version of CMX) have been made,
English language is used.

/USER:USER ID User ID to be used when opening the database.
If no /JUSER: parameter is specified, CMX login dialog
is displayed.

IPWD:PASSWORD Password to be used when opening the database.

If password is required and no /PWD: parameter is
specified, CMX login dialog is displayed.

/P:POSITION ID The Position property window is opened and the data
of the specified position is displayed.

If the Position ID is invalid, the Position property
window is not opened.

/ID:DEVICE ID The Device property window is opened and the data of
the specified device is displayed.

If the Device ID is invalid, the Device property window
is not opened.

If both a /P: and a /D: parameter is entered, the /P: takes precedence and the /D:
parameter is ignored.

Wildcards can also be used. For example "/P:101%" displays all positions that begin
with "101". Wildcards used in a Microsoft SQL Server database are presented in
Wildcards.
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unauthorized people may get hold of User IDs and Passwords. The
command line displays all text written in it, even the User ID and the
Password.

0 Note: Do not use the command line if there is a possibility that

Database settings must be set correctly before command line parameters
can be used. Set the Provider, Server, Server Login and password settings
to the database server where the wanted database is located. Set the
parameters by opening the database manually before using the command
line parameters.

Each time CMX is started with command line parameters, a new CMX
instance will be started. So, to free CMX licenses, remember to close the
CMX instance after use.

If your Position IDs and/or Device IDs contain space characters, include the
ID inside quotes, e.g.:

.../P:"DEPT 714 - PT101.3".

License Key

The License Key must always be connected to the computer while you are using a
fully functional CMX. Without the License Key, CMX starts up as a Limited Evaluation
version. Most of the functionality is still available, but CMX uses a demo database
with a limited amount of positions/devices. The maximum amount of positions/
devices in the demo database is 20.

Where should the License Key be located?

* In CMX Enterprise and CMX Professional with the floating server license
option:

The License Key must be installed into the server where CMX Application Server
iS running.
* In CMX Professional without the floating server license option:

The License Key must be installed into the workstation where CMX is running.
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General Presentation of CMX

The relation between CMX and its Instrument Database is like the relation between
a word processing software and the document you write. CMX, just like the word
processor, is a tool for handling the information you create. With CMX you create a
database instead of a document.

All instrument data as well as calibration history data is saved in the database. CMX
is the tool for opening, viewing and editing the database.

About CMX’'s User Interface

A general description of CMX’s user interface.

The Main Window
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Figure 2: The Main Window

The Main Window is divided into the following main parts:

1. Title Bar. Contains the Name of the software and sometimes also additional
information depending on the selected item.

2. Menu Bar. The Menu structure is presented in a subsequent chapter.
Toolbar. The Toolbar structure is presented in a subsequent chapter.

4. Tree View Selection Tabs. Selects whether the Plant Structure Tree or the
Position Tree is shown (Position Tree shown in the previous picture).

w
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5. Plant Structure List. (Not shown when the Plant Structure Tree is shown
instead of the Position Tree). This is the primary level filtering for the Positions
shown in the Position Tree. More of the plant structure in a subsequent chapter.

6. Position Query List. (Not shown when the Plant Structure Tree is shown
instead of the Position Tree). This is the secondary level filtering for the
Positions shown in the Position Tree, i.e. the query is carried out to Positions
located in the selected part of the plant structure. More of the queries in a
subsequent chapter.

The Filter Button is the tertiary level filtering for the Positions shown in the
Position Tree. More of the filter in a subsequent chapter.

7. Position Tree. Shows a list of Positions (all or part of them depending on the
selections in the two lists and the Filter button above the Position Tree) and
their contents in a tree like structure. More of the tree structure in a subsequent
chapter.

8. Viewing Calibration History Check Box. If unchecked, only the latest
calibration is shown in the Position Tree. When checked, all calibrations are
shown in the Position Tree.

9. Status Bar. Shows the current date, the name of the currently logged user and
the database response time. Hints for increasing the response time can be found
in CMX webhelp, see General Settings Fields.

10. The Work Area. A place for opened Property window, Devices window, Set
window, Print window, Send to Calibrator and Receive from Calibrator
windows.

The Tree

The Tree Structure on the left side of CMX’s main window shows either a list of
positions (all or part of them depending on the Plant Structure List, Position Query
List and Filter settings) or the Plant Structure including all Positions.

The color of the Position ID is:

» Black when the Position’s calibration date is not due soon.

* Yellow when the Position is due for calibration but the next calibration date hasn’t
been exceeded yet. The time period when the Position ID is yellow is user defined.
See Function Due List Settings.

* Red when the Position’s due date for the calibration has expired.

Calibrators, Devices, Calibrator Modules and Users in their respective

0 Note: The same colors indicating the need for calibration are used for
trees.
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The Tree Structure shows position data in the following hierarchical order:

B Top level of the tree (a query)
=) A position with two installed devices

=-E Afunction for the position above, e.g. a pressure transmitter
Calibration procedure definition for the function above
Calibration results for the function above (unapproved)
Approved calibration results
m Locked calibration results (must be approved first)

FFEL

% Invalid calibration results

CHEHE

& Aninstalled device containing the function above
-2 Another function for the position above, g.9. a pressure indicator
-2 Third function for the position above, e.q. a pressure comverter
@ Another installed device containing the two functions abaove
& Afourth function for the position above, not assigned to a device
= Achecked out position and
w B
@ a device
-4 A deactivated position with no device installed to it
@ tore.. Al positions are not shown in the Tree Structure,
Select "More" to expand the tree

Work Order related icons (if applicable)
Top of the Work Order tree
- Work Order icons

Figure 3: The Tree Structure

When you double-click one of the items in the Tree Structure, a property window
opens in the Work Area. There all item related data is displayed for viewing and
possible editing.

When the property window is already open, a single click in the Tree Structure
changes the contents of the property window to display the data of the clicked item.

Several other main functions of CMX may also be started from the Context Menu
“popping up” above the Tree Structure, but they are covered later in in this manual.
This is just a reminder to frequently use the context menu that opens by clicking the
secondary mouse key.

Deactivation means that a Position/Device etc. is no longer in use. A
deactivated item has a small red “x” in the lower right corner of the icon. A
checked out Position/Device has a red border surrounding the icon. More
of checking out in Check Out / Check In Feature.

0 Note: CMX supports deactivating items shown in the Tree Structure.

Position icon indicates if position is linked to a Calibrator/External Module.
See details in Linking Position with Calibrator/External Module

Work Order Handling is described in Work Order Handling.
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The Work Area

The work area is used for showing the following types of windows:

* The property window for displaying additional information of the item selected in
the Tree Structure.

+ Send To Calibrator and Receive From Calibrator windows while communicating
with a calibrator

» Print window for printing Certificates, Reports and Labels.
* Devices window (rightmost window in the picture below).
* Position Sets and Device Sets windows (also shown in the picture below).
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Figure 4: Devices window, Device Sets window and Position Sets window
The Devices window, Device Sets window and Position Sets window all work like

the Tree Structure except that they are “floating” in the work area. Sets are described
in Queries, Filters and Sets.

The Menu Structure

The menu structure is described in the table below:

Table 4: Menu Structure - File

File

Database... Opens a dialog for viewing/changing the database
connection.

Available in CMX Professional with no floating server
license option.
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File

Log Off...

Opens a dialog for viewing/changing the database
connection.

Available in CMX Enterprise and CMX Professional with
floating server license option.

Import, Document
Layouts...

A possibility to import Certificate, Report and Label layouts
from another database/source.

Export, Document
Layouts...

A possibility to export Certificate, Report and Label layouts
to make them available for another database.

Exit

Closes CMX

Table 5: Menu Structure - Database

Database

Wizard... Launches the Wizard that creates a new Position, a linked
Device etc.

Device Opens the window for viewing/defining Device

Manufacturers... Manufacturers

Calibrators... Opens the window for viewing/defining Calibrators (and
further on the Calibrator Manufacturers)

Lists... Opens the window for viewing/defining CMX lists, i.e. sets

of predefined alternatives, available in several windows.

Function Template...

Opens the Function Template window where the Function
Templates may edited and new Templates added.

Table 6: Menu Structure - View

View
Properties Opens/closes the property window
Devices Opens/closes the Devices window

History Trend

Opens/closes the History Trend window. This is an optional
feature in CMX Professional.

Position Sets

Opens/closes the Position Sets window

Device Sets

Opens/closes the Device Sets window

Refresh

Refreshes the active tree.

Table 7: Menu Structure - Calibration

Calibration

Send...

Opens the window used for sending instruments/functions
to the connected calibrator.




General Presentation of CMX - 30

Calibration

Receive... Opens the window used for receiving calibration results of
instruments/functions from the connected calibrator.

Sync... Opens the window used for Beamex Sync communication.

Manual Entry... Opens the window used for entering calibration results.

This is useful when a calibrator does not communicate with
CMX.

Table 8: Menu Structure - Documents

Documents

Certificates, Print...

Opens a window where you can select instruments with
calibration results and print calibration certificates.

Certificates,
Design...

A possibility to create your own certificates. This is an
optional feature in CMX Professional.

Reports, Print...

Opens a window where you can select instruments and
print reports.

Reports, Design...

A possibility to create your own reports. This is an optional
feature in CMX Professional.

Labels, Print...

Opens a window where you can select instruments and
print calibration labels.

Labels, Design...

A possibility to create your own labels. This is an optional
feature in CMX Professional.

History Trend,
Print...

Opens a window where you can select instruments and
print history trend graphs. This is an optional feature in
CMX Professional.

History Trend,
Design...

A possibility to create your own history trend graphs. This is
an optional feature in CMX Professional.

Data Loader, Print...

Opens a window where you can select instruments and
save them into a Data Loader excel file. Data Loader is an
optional feature in CMX Professional and CMX Enterprise .

Data Loader,

A possibility to create your own Data Loader excel files.

Design... Data Loader is an optional feature in CMX Professional and
CMX Enterprise. Report Design is an optional feature in
CMX Professional.

Settings... Opens a window where you can view/edit Automated

Document Generation Settings.

Table 9: Menu Structure - Tools

Tools

Audit Trail...

Opens the Audit Trail window. This is an optional feature in
CMX Professional.
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Tools

Settings...

Opens the Settings window. Here are all CMX’s basic
settings viewed/edited.

Security, Users...

Opens the window where Users and User Groups are
maintained.

Security, Change
Password...

Allows the current user to change one's CMX password.
Note that this menu option is only available if passwords
are required in the Security page of the Settings window.

Security, Change
Mobile Password

Allows the current user to change one's Mobile Password.
Note that this menu option is only available if Mobile
Security Plus is activated in the General page of the
Settings window and Mobile Passwords are required.
This is an optional feature in CMX Professional.

User Interface, Edit

Activates the Direct Edit of CMX’s User Interface. This is an
optional feature in CMX Professional.

User Interface, Save

Saves the changes made to the User Interface during
Direct Edit. This is an optional feature in CMX Professional.

User Interface,
Cancel Changes

Cancels the changes made to the User Interface during
Direct Edit. This is an optional feature in CMX Professional.

User Interface,
Customize...

Opens the window used for customizing CMX’s user
interface. This is an optional feature in CMX Professional.

External links

Allows you to add a quick link to any kind of file (including
applications) recognized by the operating system. The
linked files are listed in a submenu below the External Links
menu option.

The link may also be an internet link as long as the
beginning (http://) is cut off.

Beamex Tools

Contains links to Beamex calibrator tools, e.g Picture
Capturers, Device Description Senders, Demos etc.

Data Loader...

Opens the Data Loader window. This is an optional feature
in CMX Professional and CMX Enterprise.

Table 10: Menu Structure - Window

Window

Cascade

Reorders the subwindows found in the Work Area.

Tile Horizontal

Reorders the subwindows found in the Work Area.

Tile Vertical

Reorders the subwindows found in the Work Area.

- 31
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Table 11: Menu Structure - Help

Help

CMX Help... Opens CMX’s main help in the operating systems default
browser.

CMX Calculations... |Opens CMX Calculations help which describes the
calculations that CMX performs.

CMX Report Opens CMX Report Variables help which describes CMX
Variables... variables available in CMX's Report Design tool.
Index... Opens CMX help's index page.
Search... Opens CMX help's search page.
About CMX... Opens the window where CMX’s license and copyright info
is displayed.
The Toolbar

The main window toolbar comprises of the following tools:

Table 12: The Toolbar

Wizard Opens a Wizard utility for creating a new Position
(and a Device). This is the fastest way of creating an
instrument. Only the most significant fields are shown.

Properties Opens/closes the Properties window in the Work Area.

Devices Opens/closes the Devices window in the Work Area.

Position Sets Opens/closes the Position Sets window in the Work
Area.

Device Sets Opens/closes the Device Sets window in the Work
Area.

Calibration Contains a menu with calibration related functions, the

same as in the main windows’ Calibration menu.

Documents Contains a menu with available types of documents
(Certificates, Reports, Labels, History Trend and

Data Loader). Selecting one of the items opens a
window with the possibility to print the selected type of
Document.
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Other Windows

There are three main types of windows in CMX:

1. The main window, described in the previous chapters.

2. Windows appearing in the work area of the main window, e.g. the item properties
window.

These windows are closely related to things presented in the main window.
That’s why they are located in the work area. Additionally, you may open several
of this type of windows at the same time.

3. Windows that appear outside the CMX main window.

More or less "stand-alone" windows available for a specific task, e.g. the
Calibrators window.

You can open only one of these windows at a time. Also, working in the main
window is not possible as long as one of these windows are open. To return to
the main window, close the "stand-alone" window.

The Manual Entry window falls into this category with the following exceptions:
You can open several Manual Entry windows and also use the main window
while the Manual Entry window(s) is/are open.

The layout and functionality of the third and second type of windows vary a lot, so
there are not many common features in them. The Toolbar is however relatively
common:

Table 13: The Toolbar

New Clears all fields in the window and allows data entry of
a new item

Delete Deletes the currently shown item.

Edit Allows editing the fields of the currently shown item

Cancel Active only when adding a new item or editing an
existing item. Cancels the edited/added item.

Save Active only when adding a new item or editing an
existing item. Saves the edited/added item.

Close Closes the window

Help Opens the Help page displaying help for the task at

hand.
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Multiple Users

The following chapters describe how CMX handles Simultaneous Data Editing and
Accessibility in a Multiple User Environment.

Simultaneous Data Editing

When multiple users are working on the same database and two or more users are
simultaneously editing the same record, then the one who saves his edits first "wins".
This is called optimistic concurrency control.

The changes made by other users are rejected and a message informing of the
situation is shown for them.

See also Manual Check Out / Check In.

Accessibility

CMX's Accessibility feature allows limiting access of data on user group level. Define
users in groups according to the department/plant etc. The accessibility for the
following database items may be defined:

* Plant Structure, see Plant Node Fields, CMX webhelp.

» Calibrators, see Calibrator Fields, CMX webhelp.

+ Calibrator Modules, see Calibrator Module Fields, CMX webhelp.

» Positions, see Position Property Window Fields, CMX webhelp.

* Devices, see Device Property Window Fields, CMX webhelp.

+ Saved, see What Is a Filter.

The accessibility setting is done for each item individually (available among the item's
properties). The setting is hierarchical; if the access of a plant node is denied for

certain user groups, access to all nodes, positions and devices below that node are
also denied.

This feature is useful, e.g. when a single database contains data of several
departments/plants etc. Then users arranged to groups according to their
department/plant see only the database items that concern them.

accessibility settings. To edit accessibility you always need modify
permission to the object that the accessibility affects. So e.g. if you want to
edit Device Accessibility you must also have Device Edit permission.

o Note: Only users with the proper authorization can view and/or edit
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Note: When changing accessibility for a plant node containing sub-nodes,
0 CMX confirms whether the accessibility is updated also for underlying plant
nodes.

See also Users and User Groups and Site User Maintenance both in section Basic
Settings.

Uncertainty Calculation

CMX's Uncertainty Calculation feature can be configured according to your own
needs:

» The uncertainty of Beamex calibrator modules is automatically available, e.g.
among calibration results.

« CMX supports up to eight user defined uncertainties (B type uncertainties). They
may be activated via the user interface customization tool. See Customizing the
User Interface.

+ In Calibration Settings, you may select whether the expanded uncertainty of all
uncertainty components is shown among results or not.

Common Features

This chapter and its subchapters describe some features/utilities that is used not just
in one window but in several CMX windows.

Context Menus (Pop-up Menus)

A Context Menu (pop-up menu) is a menu that appears when you click on the
secondary mouse key. The menu is called a Context Menu because it provides tools
suited for the place where the Context Menu was invoked.

CMX is provided with a wealth of Context Menus. If you are not sure what you can do
at a certain moment or with a certain item, try opening the Context Menu. Then you
will see a list of common tasks.
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Drag and Drop Feature

Many of CMX’s windows support the drag and drop feature. It is a quick tool for doing
certain tasks in CMX, like selecting instruments for calibrations, printing, sets as well
as linking Devices and Positions.

Selection List Features

Many of CMX’s lists allow you to add a new item to it, if none of the available
alternatives suit your needs.

If the item to be added does not require any additional information, e.g. a process
connection, just write the new connection type and it is added to the list of process
connections.

When the item to be added requires additional information, CMX shows an item titled
“<New...>" in the list. Selecting this option opens a window where you can create an
all new item for the list.

An example of the latter feature is when you add a new calibrator to the database. If
the Calibrator Model you are adding is not listed among

Calibrator Models found in the database, select “<New...>”. A window opens where
you can add the new Model and its Manufacturer into the database. All this is done
without opening the Calibrator Manufacturers window where Calibrator Model and
Manufacturer data is viewed and maintained.

Activation/Deactivation

CMX's Activation/Deactivation feature allows activation and deactivation of Positions,
Devices as well as most of the other items shown in a Tree Structure. Deactivation of,
e.g. a Device means that the Device is no longer used. The deactivated item has a
small red “x” in the lower right corner of the icon shown in the Tree Structure.

Deactivation is hierarchical. When you, e.g. deactivate a Plant Structure node, all
Positions, Devices, Functions and Procedures below that node are also deactivated.
Furthermore: (re)activation is also hierarchical.

Note: Deactivation is not possible for a Device that is installed in a
0 Position. Unlink the Device and then deactivate it.
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Check Out / Check In Feature

Check Out / Check In feature is a tool that locks Positions/Devices for other users
than the one who did the Check Out. This feature is presented in Check Out / Check
In Feature.

Calibration Result Lock/Unlock

Calibration Result Lock/Unlock allows locking/unlocking approved calibration results.
Locking prohibits any unintentional changes to the calibration results.

This is an optional feature in CMX Professional.

This feature is presented in Locking Calibration Results.

Note: This "Common Feature" is available only when Mobile Security Plus
0 Option is in use

Document Links

Several items in CMX’s database include a possibility to link documents to them.

Document Links

m

ES:CLII.IEEQ.I MName File In Databaze faen
e O TR | CMOX\Connection - 1010R-PI0014 png File

C M X Professional ... [JACMXMNCME Professional - Installation [l
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File Link
Internet Link

Figure 5: Document Links

CMX supports three kinds of methods for linking/embedding documents (options as
seen in the pop-up menu that opens from the Add button):

* File. This embeds the document into the database. Because of the risk of
increasing the database size, this option can be enabled/disabled in CMX
Settings windows' General Settings.

For an embedded file, the check box in File in Database column is checked.
» File Link. This option adds a link to an external file. The file itself is not embedded

in CMX's database, just the link. For a linked file, the check box in File in
Database column is not checked.
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* Internet Link. This adds an internet link to the list. When adding the link, omit the
beginning (http://).

Note: The number of links for each item is not limited. Additionally,
0 there are no file type restrictions. Any file will do just as long as you have
software suited to view the file.

Note: Itis not recommended to save a lot of large embedded documents
0 in the database. Database size grows fast, which may cause performance
issues. Use File Links with large files.

User Fields

User Fields may freely be used for whatever suits your needs. They are however not
visible by default.

Note: This feature is a part of CMX Professional's option: "Configurable
0 User Interface".

Free Field 1
Free Field 2
Free Field 3
Free Field 4
Free Field &
Free Check 1 Free Check 2 0

Free Check 3 Free Check 4 0

I

Free Check 5
Figure 6: User Fields

To make the User Fields visible you must have the user rights to customize CMX’s
User Interface. Customizing is described in Customizing the User Interface.

The text fields and check boxes may be freely used. The label text for the free field
may be edited using either the User Interface customizing tools or the Direct Editing
of the User Interface tool (see Direct Editing of the User Interface).

Certain modern calibrators support calibration related User Fields and Checks.
Any data entered into these fields are retrieved to CMX and can be seen among
calibration results. To activate these fields in CMX (and compatible calibrators),
customize the Calibration Result Properties window. See Customizing the User
Interface.
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Long Text Fields

CMX has certain text fields, which can contain longer text. To be able to see the
whole text content CMX has a long text form for such text fields. When a long text
field has some content or item is in edit mode, double clicking opens the field content
in a separate long text form. Note, that empty field is not opened when item is in view
mode.

The long text form can be left open, so that its content can be read in parallel while
working with CMX. Several long text forms can be opened at the same time. When
an item, which has an open long text form is closed or another item is selected, CMX
automatically closes its open long text forms.

Double clicking certain grid cells containing text and having ... at the end opens that
text in a separate long text form.

When the item is in edit mode, the text content can be edited there. Edition is
accepted by OK button or Enter key. Edition is cancelled by Cancel button or Esc key.
Note, that Ctrl-Enter key can be used to add line feed inside the text.

Item's edit mode can not be completed and saved if the long text form is still open.
CMX warns and requires closing it, so no entered data is lost. When item edition is
cancelled, possible text changes in the long text form are also cancelled.

Software Options

This chapter presents available software options for CMX, i.e. additional features that
are purchased either at the same time as CMX or later on to add CMX's functionality.

Note: All of the features presented further on are optional in CMX
o Professional and most are standard features in CMX Enterprise.

Report Design Option

Allows you to create your own Calibration Certificate, Report, Label and History
Trend Layouts.

See Creating Your Own Certificates.
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Change Management and Audit Trail Option

Change Management and Audit Trail option is a tool for keeping track of changes
made to CMX's database.

For more information, see Change Management and Audit Trail.

Weighing Instrument Calibration Option

Allows you to use CMX when calibrating Weighing Instruments.

For more information, see Calibrating Weighing Instruments.

Maintenance Inspection Option

A tool for doing checks that yield answers "yes" or "no".

More info in Maintenance Inspection.

Enhanced Work Order Handling Option

An enhanced utility for handling work orders sent from/to ERP (Enterprise Resource
Planning) or CMMS (Computerized Maintenance Management System) software.

For more information, see Work Order Handling.

History Trend Option

Allows you to view Calibration History data both numerically and graphically. The
option makes it possible to evaluate calibrations and e.g. determine the instrument's
drift between different calibrations.

For more information, see History Trend.

Mobile Security Plus Option

CMX's tool that conforms to data integrity requirements.

For more information, see Mobile Security Plus.

40
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Configurable User Interface Option

Allows you to edit the user interface to suit your needs.

For more information, see Editing the User Interface.

SSO/LDAP external authentication Option

Allows you to use Lightweight Directory Access Protocol (LDAP) or Single Sign-on
with the Microsoft Entra ID service (OpenlD Connect Azure) for user authentication.

For more information, see External Authentication Settings.

Data Loader Option

A tool for importing instrument data from excel file to CMX.

For more information, see Data Loader.

41
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Basic Settings

The Basic Settings section contains information on CMX’s settings that should be
checked/edited before taking CMX into full use. All settings can be changed later on
too, but going through the them first, makes the daily work more efficient.

Settings for Weighing Instruments. It contains information of Weight Sets,

0 Note: If you utilize the Weighing Instrument Calibration feature, see Basic
Weights and other Weighing Instrument Calibration related Basic Settings.

The Settings Window

The Settings window can be opened from the main window’s Tools menu. It allows
you to define the following type of settings:

* General Settings. What type of database queries are run at startup etc.

* Function Due List. Settings that define when CMX indicates that a Function is in
need of calibration.

» Calibrator Due List. Settings that define when CMX indicates that a calibrator is
in need of re-calibration.

* ID Generation. Needed if you want CMX to automatically generate Position/
Device IDs.

» Certificate. Contains fields for defining how the calibration certificate number is
generated.

+ Calibration. Fields for defining calibration related settings.

» Security. Whether a password is required when logging in to CMX as well as
other security matters.

* Mobile Security. Data Integrity settings for the Mobile Security Plus settings.

This is an optional feature in CMX Professional.

+ External Authentication. Lightweight Directory Access Protocol and OpenlD
Connect Azure settings.

This is an optional feature in CMX Professional.

+ Messages. Message service related settings.
This is an optional feature in CMX Professional.
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+ Change Management. Different Audit Trail and Electronic Signature related
settings.

This is an optional feature in CMX Professional.

* Work Order. Work Order related settings.

This is an optional feature in CMX Professional.

* Sync. Beamex Sync service related settings.

This is an optional feature.

The subsequent chapters have additional information of each setting.

General Settings

As the name implies, the page contains settings that define what is done while
starting up CMX (e.g. Position Query) or when opening certain windows, like the
Calibrator window.

Field level information is available in the webhelp delivered with CMX.

Function Due List Settings

In the Tree view, CMX uses yellow text color for the Position ID / Device ID to indicate
that one or more of the Position’s/Device's Functions need to be calibrated soon.
Here you can define the time interval CMX uses for activating the “Function in need
of calibration” color.

calibration of one or more of the Position’s/Device's Functions are overdue

o Note: Red text color for the Position ID / Device ID indicates that the
(the scheduled calibration date has expired).

The same colors indicating the need of recalibration are used for
Calibrators and Calibrator Modules in their respective trees.

Field level information is available in the webhelp delivered with CMX.

Calibrator Due List Settings

This page allows you to define the time interval CMX uses for activating the yellow
“Calibrator in need of re-calibration” color.

Field level information is available in the webhelp delivered with CMX.
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ID Generation Settings

Each Position and Device needs to have a unique ID. It is used for identifying
Positions and Devices.

The Position ID and/or the Device ID can be manually entered or created
automatically, if activated on this page. Also the format of the automatically created
IDs (prefix-number-suffix) can be defined.

Field level information is available in the webhelp delivered with CMX.

Certificate Settings

Each calibration is assigned with a unique certificate number. This number will
appear on every calibration certificate which is produced for that calibration.

Field level information is available in the webhelp delivered with CMX.

Calibration Settings

This page allows you to define calibration related settings, like is "Save as Both"
allowed, i.e. the results of one calibration repeat is saved both as As Found and as
As Left results when no adjustment was needed.

Field level information is available in the webhelp delivered with CMX.

Security Settings

On this page you can define whether users need a password as well as various other
password related settings.

Changing these settings is allowed to database administrators and users with the
rights to change security settings.

Field level information is available in the webhelp delivered with CMX.

Mobile Security Settings

Mobile Security Plus is CMX's Data Integrity feature.
This is an optional feature in CMX Professional.

Field level information is available in the webhelp delivered with CMX.
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External Authentication Settings

This section describes the External Authentication related settings. Three different
configration alternatives are available. CMX user interface will show different sets

of configurable settings depending the External Authentication method selected.
Database administrators and users with the right to maintain External Authentication
settings are allowed to change these settings.

This is an optional feature in CMX Professional.
The available configurations are:

* None is the default configuration in CMX - users are authenticated with credentials
stored in CMX database. No additional settings can be configured when this
method is selected.

+ LDAP (Lightweight Directory Access Protocol) is a method used in networks
to authenticate/identify users. When you try to log into a network, an LDAP server
approves (or disapproves) your login.

If LDAP is enabled in CMX, it overrules the CMX's password settings. The user's
password is checked on the LDAP server in the network, instead of checking
users' passwords in CMX's database. The network user name must however exist
as a CMX User ID as well.

Editing LDAP settings should be performed by, or with the help of, people with
experience of LDAP and knowledge of company's Local or Wide Area Network
settings. Preferably someone from company's IT support.

Field level information is available in the CMX webhelp.

+ OIDC SSO (OpenID Connect Single Sign-On) is a protocol used to authenticate/
identify users. If OIDC SSO is enabled in CMX, it overrules CMX's password
settings. CMX will do the Authorization based on local users as the SSO service
will provide an unique identifier (after a successful authentication). This unique
identifier is mapped to a local CMX user. Microsoft Entra ID is used as the
authentication service for performing Single Sign-Ons.

Editing OpenID Connect Azure settings should be performed by, or with the help
of, people with experience of Microsoft Entra cloud-based identity and access
management services. Preferably someone from company's IT support.

CMX offers a tool for managing the External and Local User mappings. See the
description in External User Mapping.

Field level information is available in the CMX webhelp.

CMX License Key number as the User ID and Master Password as the
password. Please submit a request at hittps://support.beamex.com to get
further information about the Master Password for your CMX. You will be
asked to change the Master Password on initial login.

0 Note: You may override the External Authentication by using the
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External User Mapping

Each person using the database may be assigned a unique User ID. A User can
belong to one or more User Groups, depending on the responsibilities of that
particular User.

Field level information is available in the webhelp delivered with CMX.

When the OIDC SSO is enabled in CMX, an External user mapping view is
available for Supervisors, and Users that have the External Authentication - manage
user mappings permission. This view can be accessed through Tools > Security >
External user mapping.

This view is designed for mapping local CMX User ID:s against the cloud identities
fetched from the Microsoft Entra ID.

When this view is in use, the user needs to authenticate against the end point defined
in Application Id for Admin first. Check the OpenlID Connect Azure Settings Fields
section in CMX webhelp, to acquire the cloud identities from the Microsoft Entra ID.

The window presents a list of CMX User IDs on the left and cloud identities on the
right. Both lists have separate controls for performing searches and applying filters
on the identifiers. CMX local User IDs are automatically acquired from the database,
while a Cloud identity search must be performed manually in order to populate the
list. Cloud identity searches are made based on the Display name-attribute and
require that at least 3 letters are entered. Click the All button to toggle beween the
following modes:

» All - shows all users matching the entered Search-condition.
* Unpaired - shows only unpaired identifiers matching the entered Search-condition.
» Paired - shows only paired identifiers matching the entered Search-condition.

The Paired column is marked with an X for paired identifiers and with a - symbol for
unpaired IDs. To pair a CMX User ID with a cloud ID, select the correct CMX User
ID and the correct cloud ID on the External identifiers list and click Pair. To Unpair
a mapping select both the correct CMX User ID and the mapped cloud ID and click
Unpair.

Messages Settings

This page allows you to configure CMX to have it send messages via e-mail for
certain events.

0 Note: The messaging functionality requires internet access.

Note: In the current CMX, the only available event is for second approval
ﬂ requests that are sent as a part of the automatic result validation.
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Change Management Settings

This is an optional feature in CMX Professional.

If Change Management feature is part of your CMX, this page allows you to change
settings concerning changes to the instrument database.

The uppermost check box determines whether Audit Trail used or not. Other fields
refine how Audit Trail is utilized.

If required, activate the Electronic Signature feature using the check box with the
same name.

In this view you can manage Automatic result validation as well as the list of active
rules. See Automatic Result Validation for more information.

Field level information is available in the webhelp delivered with CMX.

For more information about the Audit Trail window and the Electronic Signature, see
Change Management and Audit Trail.

Work Order Settings

This page allows you to configure work order related settings. It also lists some
essential settings that are configured in Business Bridge.

Field level information is available in the webhelp delivered with CMX.

Sync Settings

This page allows you to configure settings for Beamex Sync, which is a service
enabling asynchronous communication between CMX, Beamex calibrators and
Beamex bMobile.

Users and User Groups

The Users window can be opened from the main window’s Tools menu. It is located
in the Security submenu.

The left pane of the window displays either a Tree Structure list of Users or User
Groups / Sites, depending on which tab is selected. The right pane displays property
data for the User or User Group / Site, selected from the list on the left pane.



Basic Settings - 48

Actually, the tabs on the left pane do not reveal anything new (compared with each
other). They display the same information but the viewpoint is different:

* When the Users tab is selected, all users are shown and for each user the groups
he/she belongs to can be seen on the next tree level.

* When the User Groups tab is selected, all User Groups / Sites are shown and for
each group/site, the users belonging to it can be seen on the next tree level.

To streamline the use of large corporate databases in CMX, a possibility to define
Sites and Site Managers is also available. More of Site User Maintenance is available
in Site User Maintenance.

Note: Users entered into CMX’s database need not be users that actually

O do calibrations. Users responsible for the calibration/maintenance duties
may also be entered. They for instance sign calibrations and accept
changes made to the database.

What to Do With Users and User Groups

The easiest way to work with CMX is using only one user definition with the password
security inactivated. The password security settings are easily available via the

Tools menu in the Users window (as well as from the main window’s Tools menu’s
Settings window’s Security page). The drawback for this easy method is that
anyone with access to the computer where CMX is installed may start the software
and do what they please.

When CMX is installed and started for the first time: The safe way is to change the
administrator password from its default value (delivered in an envelope together with
the software installation kit), memorize the new administrator password and create a
suitable set of Users and User Groups.

Each User must belong to at least one User Group. If the password security is
enabled, a button for defining the user’s password is available in the user’s property
data.

Define the permissions (what the group members are allowed to do with CMX) for
each User Group.

Note: CMX automatically places the current Windows User ID as the
0 default user for logging into CMX. For ease of use, enter the same User
IDs into CMX.
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Supervisors

Supervisors are by default allowed to do anything that can be done with CMX, e.g.
add Users, reactivate a User account, define User Groups etc. A Supervisor need not
be assigned to any Group, Supervisors have all rights anyhow.

Whether a user is a Supervisor or not, can be seen (or edited, if you have the
permission) in the property data shown on the right hand side of the Users window.

There is no upper limit for the amount of Supervisors but at least one Supervisor is
required. CMX does not allow deleting the last Supervisor.

See also note in User Deactivation and Lock Out.

Master Supervisor

To login as the Master Supervisor, use the CMX License Key number as the User
ID and the Master Password as the password. Please submit a request at https://
support.beamex.com to get further information about the Master Password for your
CMX.

On initial login, the Master Supervisor will be prompted to change the Master
Password. Once logged in, the Master Supervisor is treated and managed as
a regular supervisor user in CMX, which also means that the password can be
changed again later (like for any other user).

It is also possible to remove the Master Supervisor user from CMX. The Master
Supervisor user will not be visible in CMX. However, you can use the CMX License
Key credentials again to login as the Master Supervisor. You will be prompted to
change the Master Password, just like during the initial login.

Users

Each person using the database may be assigned a unique User ID (assigned by
a Supervisor) and optionally a password. A User can belong to one or more User
Groups depending on the duties of that particular User.

If Mobile Security Plus option is in use, define users of supported Mobile Devices
as Mobile Users and, users who may have more permissions in the Mobile Devices,
as a Mobile Supervisor. More of Mobile Security Plus in Mobile Security Plus.

If the Mobile Security Plus option is not in use, it is possible to configure CMX

via General Settings Fields to allow defining users as Mobile Users. When this is
enabled CMX will send only Mobile Users to Mobile Devices. User list is then shorter,
which makes user selection easier on Mobile Devices.

Field level information is available in the webhelp delivered with CMX.
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Note: The permissions are defined for User Groups. Once a User is
ﬂ assigned to a Group, he/she gets the permissions defined for that Group. If
LDAP authentication is enabled, for all CMX users:

Enter the same CMX User IDs as is used as User Names in Windows
network. See also External Authentication Settings.

At the Users window's bottom left corner is a check box: Show only
mobile users. When checked, all non-Mobile Users are temporarily
hidden. This is of use especially when Mobile Security Plus option is used
or CMXis configured to Allow defining Mobile Users and some users have
been defined as Mobile User.

Changing the Password

Each user may change their own password. Changing the password is available in
the main window’s Tools, Security menu (provided that passwords are used).

Supervisors (see Supervisors) and Users belonging to User Groups (see User
Groups) with the permission to maintain Users and User Groups may change the
password of all users in the Users window which can be opened from the main
window’s Tools, Security menu.

Note: If an External Authentication method is enabled, passwords are not
0 changed in CMX. See External Authentication Settings.

For details on how to change Mobile User Password, see Settings Window.

User Deactivation and Lock Out

CMX automatically defines users as Inactive Users if the User’s Expiration Date
has passed. A User may also be Locked if too many illegal attempts to log into the
database was done using that particular User Name.

The Supervisor and a User belonging to a User Group with the permission to
maintain Users and User Groups have the rights to activate and release locked
Users.

To activate a user, edit the Expiration Date field.

To unlock a User, click the Release User button.

Note:
O User's expiry date does not apply to Supervisors. A Supervisor can access
the database as long as he/she has Supervisor rights.

CMX 2.15.1 and above: Supervisors can now be locked out from the
database as the user's expiry date now applies to Supervisors as well.
CMX from this version forward requires at least one supervisor to not have
an expiration date set on their profile.
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User Groups

A Supervisor or a User belonging to a Group with permission to maintain Users and
User Groups may add and remove User Groups as well as change the permissions
of User Groups.

Field level information is available in the webhelp delivered with CMX.

Permissions

The permissions tab shown for User Groups contains a list of commands and tasks
available in CMX.

A command or a task that is unchecked in the list may not be performed by users
belonging to that group. They are disabled in CMX’s menus and toolbars.

A list of available permissions is available in CMX webhelp.

See also Accessibility.

Site User Maintenance

CMX's Site User Maintenance makes it possible to organize the use of CMX in, e.g.
large groups of companies.

Standard Users (see Users) and User Groups (see User Groups) are all managed
by Supervisors (see Supervisors) or Users belonging to a User Group that have
permissions to maintain Users and User Groups. However, when a CMX database is
commonly managed for several sites, all Users with permissions to maintain Users
and User Groups can see/edit all Users and User Groups.

When utilizing Site User Maintenance, Supervisors can create Site Groups and Site
Managers who maintain Users in the site and groups they belong to only.

Owner Group and Owner selection lists. See Working with Site User

o Note: Site User Management affects Accessibility (see Accessibility),
Maintenance.

Working with Site User Maintenance

First of all, you need to enable Site User Maintenance. This is done in Tools,
Settings Window's Security section. Make sure the Enable Site User Maintenance
check box is checked. Note that this setting can be changed by Supervisors
and Users having the permission to maintain security options. After Site User
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Maintenance is enabled, Site Groups and standard User Groups can be created by
Supervisors only.

Here's how a Supervisor creates Site Groups and Site Managers and takes the
feature into use:

1. Create new User Groups with Site Group check box checked. Each Site Group
is a site/plant/company/sub-organization in the group of companies as defined by
the Supervisor. Site Groups have special characteristics as presented further on.

2. Add a standard User Group with User Maintain permission, among other
suitable permissions. You may name the User Group freely, but a descriptive
one, like Site Managers is recommended.

3. If no standard User Groups with permissions for different tasks exist, create
them.

4. Add all Users that you want to include as Site Managers to the Site Managers
group, other applicable standard User Groups and applicable Site Group(s).

Note that after Site User Maintenance is enabled, all new non-supervisor
users need to belong to a Site Group.

5. Add/assign other Users to Site Groups and applicable standard User Groups, or
give this task to a Site Manager.

6. Additionally, to fully utilize Site User Maintenance, the Accessibility settings
should be set according to the current Site Group definitions. More of this further
on.

Note: Adding standard User Groups is recommended, since they can be

0 used to define different permissions for different Users. Each User is then
assigned to (at least) one standard User Group that defines the User's
permissions and also to a Site Group which defines the User's location in
the organization.

Any non-supervisor Users added before Site User Maintenance was
enabled may (inadvertently) be unassigned to a Site Group. Users not
assigned to any Site Group are not able to log into CMX. Make sure all
non-supervisor Users are assigned to at least one Site Group when Site
User Maintenance is active.

About Site Managers

+ A Site Manager is allowed to maintain users belonging to the Site Groups and
Standard User Groups the Site Manager belongs to.

» If a Site Manager adds Users to CMX, each User must be assigned to a Site
Group and (preferably) also to a standard User Group.

* Only the Site Groups and standard User Groups the Site Manager belongs to are
visible to him/her.

+ Site Managers may view but not edit the permissions of any groups visible to him/
her.

» Site Managers cannot create new Site Groups or standard User Groups.
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About Site Groups

» A Site Group is shown among standard User Groups. To distinguish a Site Group
from a standard User Group, the group name for the Site Group is shown in blue in
the tree structures. To more easily distinguish a Site Group from a User Group, the
use of a prefix is recommended, e.g.: "> Paper Mill, Finland".

» Although permissions may be defined for a Site Group (by a Supervisor), it is not
recommended. All Users assigned to a Site Group will inherit the permissions from
the Site Group as well as the permissions from the standard User Group the User
belongs to.

About Accessibility and Owner Settings

Site managers:

Accessibility, Owner Group and Owner are selection list fields available in several
property windows. They define the visibility and ownership of the item currently
viewed.

» Accessibility is available in:

Plant Structure Node, Position, Device, Calibrator, Module and Filter property
windows.

* Owner Group is available in:

Plant Structure Node, Position and Device property windows.

* Owner is available in:
Plant Structure Node, Position, Device and Procedure property windows.
The contents of the selection lists vary depending on whether Site User Maintenance
is enabled or not:
* When Site User Maintenance is enabled:

o Accessibility and Owner Group selection lists contain Site Groups. Only the
Site Groups the current User belongs to are shown. Supervisors have all Site
Groups available.

o Owner selection list contains Users that belong to the same Site Group(s) the
current User belongs to.
* When Site User Maintenance is disabled:

o Accessibility and Owner Group selection lists contains contains all User
Groups.

o Owner selection list contains all Users.

For more information on accessibility, see Accessibility.
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Plant Structure

The Plant Structure is opened from by selecting Plant Structure from the main
window’s Tree View Selection Tabs.

Working With Plant Structure Nodes

The Plant Structure displays a hierarchical view of where the Positions (instruments)

are located.
Positions Flant Structure
[Z3 Plant Structure
=<5 1. Production plant [FI]
=& 1. Mixing

g 171-GCAL-2003-P

+- (@) 4-0CAL-2003-F
+-E 2 Mixing
= 3, Mixing

+- [ 5-0CaL-2003-P

=& 2. Production plant [U5]
1< 1. Turbine
1= 2 Turbine

£ 3. Production plant [K)

[ Show calibration history
Figure 7: An Example of a Plant Structure

CMX’s Plant Structure allows you to create as many levels as is needed for the Plant
Structure. The green slanted squares in the example picture are “Plant Structure
Nodes”. A Node can be anything that somehow defines all or part of the plant.

Positions are at the end of a hierarchical chain of Nodes. Positions need not be
located at a certain hierarchy level. They may be placed on any level.

Creating a Plant Structure is optional, but if you create one, we recommend creating
it before you start adding Positions. Then, while adding Positions you are able to
select its location in the readily made Plant Structure.

Adding Plant Structure Nodes

Adding a Plant Structure Node is done in the following manner:

1. Select an existing Node that is hierarchically just above the level of the intended
new node (or the green folder on top of the Plant Structure).
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2. Either click the secondary button on your mouse above the selected node or use
the New button found in the Node Property window’s toolbar.

The new node is added hierarchically below the previously selected/viewed
node.

3. Enter a Name for the Plant Node and make sure that the Active Plant Node
Check box is checked. All other fields are optional.

All other fields are optional.

Full field level information of the Node properties are available in the webhelp
delivered with CMX.

Note: Adding a Node to a Position is not possible. A “chain of Nodes” ends
0 in a Position.

You cannot add a Position to the Plant Structure’s top level (the green
folder). The items just below the top level have to be Nodes. A description
of how to add Positions to CMX’s database is in Adding Instruments to the
Database.

Editing Plant Structure Nodes

Make sure you have the properties window opened in the Main Window’s Work Area.
If not, click the Properties button in the Main Window toolbar.

To edit a Plant Structure Node, select it in the Tree Structure and click the Edit icon in
the properties window’s toolbar.

Deleting Plant Structure Nodes

To delete a Plant Structure Node, open the Context Menu (Pop-up Menu) and select
the Delete option.

Note: Deleting a node also deletes all items hierarchically below the node
0 to be deleted.

Device Manufacturers

The Device Manufacturers window can be opened from the main window’s
Database menu. Select the Device Manufacturers option.
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Working With Device Manufacturers

The Device Manufacturers window is primarily meant for editing existing
Manufacturer and Model data. Adding Manufacturers and Models can easily be done
in the main window while adding Devices. There is of course the possibility to add
Manufacturers and Models in the Device Manufacturers window too, if you want it.

Also: Entering Device Manufacturer and Model data is optional. If full device data
(e.g. rangeability, wetted parts material process connection etc.) is entered for all
instruments anyhow, this is a way of creating “device templates” that speed up the
adding of Positions (instruments to be calibrated) later on.

Note: There is a separate window for Calibrator Manufacturers (see
o Calibrator Manufacturers), so only data for instruments to be calibrated
should be entered here.

Adding Device Manufacturers

To add a Device Manufacturer to CMX’s database, select either File, New, Device
Manufacturer, use the Context Menu or click the New icon on the Manufacturers
window’s toolbar while a Manufacturer is selected in the Tree Structure.

Full field level information of the Device Manufacturer properties is available in the
webhelp delivered with CMX.

Note: A Device Manufacturer is also added to the list of Calibrator
O Manufacturers (see Calibrator Manufacturers).

This minimizes the workload if a single manufacturer delivers both devices
that need to be calibrated and calibrators.

Editing Device Manufacturers

To edit a Device Manufacturer in CMX’s database, select it in the Tree Structure
and choose either File, Edit Record or click the Edit icon on the Manufacturers
window’s toolbar.

Deleting Device Manufacturers

To delete a Device Manufacturer from CMX’s database, select it and then choose
either File, Delete or use the Context Menu or click the Delete icon on the
Manufacturers window’s toolbar.

Note: Deleting a Device Manufacturer is not possible if there is a reference
0 to the Manufacturer in the database.
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Working With Device Models

Device Models are a kind of “templates” in CMX. Create a model of all types of
Devices a Device Manufacturer produces (and is in use on your plant). Then each
time a new item of that same model is bought, you only need to select the model
from CMX’s list and enter the serial number to add the instrument to the database.

Adding Device Models

To add a Device Model to CMX’s database, select either File, New, Device Model,
use the Context Menu or click the New icon on the Manufacturers window’s toolbar
while a Device Model is selected in the Tree Structure.

Full field level information of the Device Model properties are available in the webhelp
delivered with CMX.

Tree Structure. If a Device Model is selected, the new Device Model will be

o Note: The Device Model will be added to the selected Manufacturer on the
added to the same Device Manufacturer as the selected Device Model.

Currently there is no possibility to move a Device Model from one
Manufacturer to another.

Editing Device Models

To edit a Device Model in CMX’s database, select it in the Tree Structure and choose
either File, Edit Record or click the Edit icon on the Manufacturers window’s
toolbar.

Deleting Device Models

To delete a Device Model from CMX’s database, select it and then choose either
File, Delete or use the Context Menu or click the Delete icon on the Manufacturers
window’s toolbar.

Note: Deleting a Device Model is not possible if there is a reference to the
O Device Model in the database.
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Calibrators

The Calibrators window can be opened from the main window’s Database menu.
Select the Calibrators option.

Working With Calibrator Data

If you have purchased the Weighing Instrument Calibration option, see chapter Basic
Settings for Weighing Instruments in section Calibrating Weighing Instruments.
It contains information of Weight Sets, Weights and other Weighing Instrument
Calibration related Basic Settings.

Here you can manage all the calibrators you use. Entering Calibrator, Calibrator
Module and Module Range data is needed for the traceability of the performed
calibrations. The Module Range is a quantity the module is capable of measuring or
sourcing within a certain measurement range.

The left pane of the window contains a Calibrators and a Modules tab.

» The Calibrators tab displays a Tree Structure of all Calibrators with the installed
Modules, suitable external Modules and the measurement Ranges of the Modules.
The Tree Structure does however not show any free internal Modules.

+ The Modules tab shows a Tree Structure of all modules. The Module’s Ranges
are shown and if the Module is installed in a Calibrator, the Calibrator is shown
below the Module before the Ranges. The Tree Structure does however not show
any Calibrators with no installed Modules.

To be able to use a Calibrator it has to have one or more Modules (with measurement
Ranges) installed.

module), just repeat the Calibrator data for the module and then add the

o Note: If you have a Calibrator that is not modular (or has only one
Module Range(s) for the calibrator.

Adding Calibrator Manufacturers and Models can be done while adding
Calibrators. Just select the “<New...>” option from the list of Models/
Manufacturers.

Adding Calibrators

How to add a Calibrator to CMX’s database depends on the Calibrator at hand:

» For communicating Beamex calibrators: Connect the calibrator to a computer
with CMX, CWSI, or the Beamex Sync client installed. Use the Detect Calibrator
button in the lower left corner of the Calibrators window or select Detect
Calibrator in the Tools menu. CMX will automatically add the connected
Calibrator, its Modules and Measurement Ranges to the database.
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Note: Before communicating with the calibrator, you may need to install
a USB driver or pair the device via Bluetooth. For more information on
calibrator communication, refer to the Calibrator Communication section.

» All other Calibrators (and their Modules and measurement Ranges) are manually
added to the database. Select either File, New, Calibrator, use the Context Menu
or click the New icon on the Calibrators window’s toolbar while a Calibrator is
selected on the Tree Structure on the left.

The required fields are Calibrator Model and Serial Number. The Serial Number
field is required since it identifies the new Calibrator from others that are of the
same Model. Entering a Calibration due date, allows CMX to indicate the need to
recalibrate. Therefore the Due Date field is recommended.

Select the Calibrator Model from the list of pre-entered Models. See \Working With
Calibrator Models or if you are adding a new Model, select the last item on the
list: <New...> and enter new Calibrator Model data as described in Working With
Calibrator Models.

Full field level information of Calibrator properties are available in the webhelp
delivered with CMX.

To manually add Modules to a calibrator, see Adding Modules and Installing and
Removing Modules to/from a Calibrator.

Modules tab gives seemingly no results. Since the new calibrator has no
installed modules it is only shown in the Tree Structure of the Calibrators
tab.

0 Note: Adding a Calibrator manually while viewing the Tree Structure of the

Adding Modules

When adding modules, check first where the highlight is in the Tree Structure:

 If you are viewing the Calibrators tab and the highlight is on the query level (the
uppermost row of the Tree Structure), the new Module will be a free Module not
shown in the Tree Structure of the Calibrators tab. To view your newly created
Module, switch to the Modules tab.

» If you are viewing the Calibrators tab and the highlight is on any other level than
the query level, the new Module will automatically installed to the highlighted
Calibrator. If a Module or a Range is highlighted, the new Module will be installed
to the same Calibrator as the highlighted Module/Range.

 If you are viewing the Modules tab and the highlight is on a Calibrator level, a new
internal Module will automatically installed to the highlighted Calibrator. In all other
cases, the new Module will be a free Module.

The required fields are: Module, Model Manufacturer and Serial Number. The Serial
Number field is required since it identifies the new Model from others that are of the
same Model.
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Select the Manufacturer from the provided list. Similarly, select the Module Model
from the list of pre-entered Module Models see \Working With Module Models or if
you are adding a new Model, select the last item on the list: <New...> and enter new
Module Model data as described in Working With Module Models.

Full field level information of Calibrator Module properties are available in the
webhelp delivered with CMX.

Adding Module Ranges

To add a measurement Range to a Module, select the Module or a Range that is
already added to the Module. Then select either File, New, Module Range, use
the Context Menu or click the New icon on the Calibrators window’s toolbar while a
measurementRange is selected on the Tree Structure on the left.

The primary required fields are: Range Name, Quantity, High Limit and Low Limit.
Pressure Type field is needed when the Quantity field is set to Pressure.

Temperature Scale and Sensor Type fields are needed when the Quantity field is set
to Temperature.

Reference Junction and RJ Temperature fields are needed when the Sensor Type
is a Thermocouple. If the RJ Mode field is set to "External”, then also the External
Sensor Type and External Wire field need values.

Wire is needed when the Sensor Type is a RTD-sensor or the unit for the Electrical
quantity is “ohm” or “kohm”.

Fields starting from Temp. Coefficient are needed for error calculation and uncertainty
calculation. Leaving any of the fields unchecked may result in unpredictable error/
uncertainty results.

Full field level information of the Calibrator Module Range properties are available in
the webhelp delivered with CMX.

Installing and Removing Modules to/from a Calibrator

If you add Modules to CMX’s database using the CMX’s possibilities efficiently (see
Adding Calibrators and Adding Modules), the Modules are automatically installed to
the Calibrators.

If you however for some reason need to install or remove Modules, select the
Calibrator in the Tree Structure (no matter on which tab, Calibrators or Modules),
From the properties window on the right, select the Installed Modules tab. Then you
will see a list of free Modules and Modules installed to that calibrator. Click the Edit
button on the Property window’s Toolbar. Then the buttons between the two lists
allow you to move Modules from one list to another.

Calibrator in CMX software. Refer to the Manuals of the Calibrators on how

O Note: This chapter explains how to “install and remove” Modules from a
to do it for the actual Calibrator (if it is allowed for calibrator users).
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Editing Calibrators/Modules/Module Ranges

To edit a Calibrator/Module/Module Range in CMX'’s database, select it in the Tree
Structure and click the Edit icon on the property window’s toolbar or select Edit
Record from the File menu.

Deleting Calibrators/Modules/Module Ranges

To delete Calibrators/Modules/Module Ranges from CMX’s database, select it and
then choose either File, Delete or use the Context Menu or click the Delete icon on
the Calibrators window’s toolbar.

Note: Deleting is not possible if there is a reference to the Calibrator/
O Module/Module Range in the database.

If a calibrator to be deleted is on a list of Calibrators to Use, CMX asks for
confirmation before the calibrator is deleted. Calibrators to Use field can
be found among Calibration Procedure data. See Calibration Procedure
Property Window Fields, CMX webhelp.

When deleting a Calibrator/Module/Module Range, all items hierarchically
below the item to be deleted will also be deleted.

Copying Calibrators

CMX includes a possibility to copy Calibrators together with its Modules and Module
Ranges. This is useful when you have several similar calibrators in use. Add just one
and copy the rest from the first one. All you need to do is add the serial numbers to
the copied items.

When in Calibrators window, viewing Calibrators, click with mouse's secondary
button (rightmost button for right handed users) on a Calibrator you want to copy. The
pop-up menu includes a Copy option.

This pop-up menu option copies the calibrator, all modules and module ranges linked
to it and prompts for serial numbers to the new Calibrator and its Modules.

The Copy option is also available in Calibrators window's File menu. The
functionality is the same as for the option in the pop-up menu.

O Note: Possible document links are not copied.

Linking with Position

A calibrator and an external module can be linked to a position. This means, that the
calibration interval and due date changes of the position procedure and calibrator/
external module are synchronized between position and calibrator/external module.
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The linked position field should be made visible by the Customized User Interface
tool for calibrator and external module views. When the position field is visible in the
calibrator and external module view, the linked position is shown there.

Position and calibrator/external module linking is defined on the position level. See
Linking Position with Calibrator/External Module

When calibration interval or due date field is changed for calibrator/external module,
those fields are updated also for linked position procedures. If the calibration interval
or due date field is empty in the position procedure, synchronization is not done.

If the Electronic Signature feature is enabled and the calibration interval or due date
is modifed, an electronic signature is requested and saved both for the position and
linked calibrator/external module. It is recommended, that both Electronic Signature
and Electronic Signature for Calibrators are enabled in Change Management
Settings.

Calibrator Manufacturers

The Calibrator Manufacturers window can be opened from the Calibrators
window’s Database menu. Select the Calibrator Manufacturers option.

Working With Calibrator Manufacturers

Just as with Device Manufacturers, entering Calibrator Manufacturer and Model data
is optional but makes it easier to add similar Calibrators and Calibrator Modules to
the database. Full data is entered only once. Then only the unique data (e.g. the
serial number) need to be entered for individual Calibrators and Calibrator Modules.

Note: There is a separate window for entering Device Manufacturers, so
o only data of calibrators should be entered here. See Device Manufacturers.

Adding Calibrator Manufacturers

To add a Calibrator Manufacturer to CMX’s database, select File > New > Calibrator
Manufacturer, the New button in the toolbar or use the Context Menu.

The only required field is the Manufacturer Name field. All other fields are optional.

Full field level information of Calibrator Manufacturer properties are available in the
webhelp delivered with CMX.

Note: A Manufacturer of Calibrators is also added to the list of Device

0 Manufacturers. See Device Manufacturers. This minimizes the workload if
a single manufacturer delivers both calibrators and devices that need to be
calibrated.
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Editing Calibrator Manufacturers

To edit a Calibrator Manufacturer in CMX’s database, select it in the Tree Structure
and choose either File, Edit Record or click the Edit icon on the Calibrator
Manufacturers window’s toolbar.

Deleting Calibrator Manufacturers

To delete a Calibrator Manufacturer from CMX’s database, select it and then choose
either File, Delete or use the Context Menu or click the Delete icon on the Calibrator
Manufacturers window’s toolbar.

Note: Deleting a Calibrator Manufacturer is not possible if there is a
ﬂ reference to the Manufacturer in the database.

Working With Calibrator Models

The functionality for handling Calibrator Models can be accessed inside the
Calibrators Manufacturers window.

Adding Calibrator Models

To add a Calibrator Model to CMX’s database, select File > New > Calibrator
Model, use the Context Menu, or click the New button in the Calibrator
Manufacturers window’s toolbar while a Calibrator Model is selected in the Tree
Structure.

The only required field is the Model field. All other fields are optional.

Full field level information of Calibrator Model properties are available in the webhelp
delivered with CMX.

the Tree Structure. If a Calibrator Model or a Module Model is selected, the
new Calibrator Model will be added to the same Calibrator Manufacturer as
the selected Calibrator Model or Module Model.

0 Note: The Calibrator Model will be added to the selected Manufacturer on

Currently there is no possibility to move a Calibrator Model from one
Manufacturer to another.

Editing Calibrator Models

To edit a Calibrator Model in CMX’s database, select it in the Tree Structure
and choose either File, Edit Record or click the Edit icon on the Calibrator
Manufacturers window’s toolbar.

Deleting Calibrator Models

To delete a Calibrator Model from CMX'’s database, select it and then choose either
File, Delete or use the Context Menu or click the Delete icon on the Calibrator
Manufacturers window’s toolbar.
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Note: Deleting a Calibrator Model is not possible if there is a reference to
ﬂ the Model in the database.

Working With Module Models

The functionality for handling Calibrator Module Models can be accessed inside the
Calibrators Manufacturers window.

Adding Module Models

To add a Module Model to CMX’s database, select File > New > Module Model,
use the Context Menu, or click the New button in the Calibrator Manufacturers
window’s toolbar while a Module Model is selected in the Tree Structure.

The required fields are Model, Manufacturer and Module Type. In order to
enable CMX to communicate with the calibrator in which the module is installed, a
Communication Name must be defined. All other fields are optional.

Full field level information of Module Model properties are available in the webhelp
delivered with CMX.

Manufacturer on the Tree Structure. If a Calibrator Model or a Module
Model is selected, the new Module Model will be added to the same
Calibrator Manufacturer as the selected Calibrator Model or Module Model.

0 Note: The Calibrator Module Model will be added to the selected

Currently there is no possibility to move a Calibrator Module Model from
one Manufacturer to another.

Editing Module Models

To edit a Module Model in CMX’s database, select it in the Tree Structure and choose
either File, Edit Record or click the Edit icon on the Calibrator Manufacturers
window’s toolbar.

Deleting Module Models

To delete a Module Model from CMX’s database, select it and then choose either
File, Delete or click the Delete icon on the Calibrator Manufacturers window’s
toolbar.

Note: Deleting a Module Model is not possible if there is a reference to the
0 Model in the database.
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Lists

To minimize the workload of repetitive tasks, CMX offers the Lists functionality.
Subsequent chapters describe the functionality and management of Lists and
present them in details.

What is a List?

Most devices have a process connection, e.g. a 4" thread for that particular
purpose. If you enter a lot of device data it will be an arduous work to write the same
connection info over and over. To minimize the workload of repetitive tasks, CMX
offers the Lists.

Enter the frequently repeated data into the lists. Then whenever the data is needed
you just pick it from the list of pre-entered options. No need to write it over and over
again.

The Lists window is primarily meant for editing existing list data. Adding list items
can easily be done while selecting data from a list seen in other windows. There

you just enter the missing item to the list. There is of course the possibility to add list
items in the Lists window too, if you want it.

Currently CMX provides the following lists:

+ Calibrator Hierarchy

* Process Connection

* Process Medium

» Signature Status (*

* Audit Trail Description (*, and

» User Defined Units

*) Optional in CMX Professional

Editing Lists

The Lists window can be opened from the main window’s Database menu. Select
the Lists option.

Select one of the available lists and view the current list items in the table below.
Editing existing items in a list

Select File, Edit, click the Edit icon in the toolbar or use the Context Menu’s Edit
option.
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Adding items to a list

Select File, New, click the New icon in the toolbaror use the Context Menu’s New
option.

Deleting items from a list

Select File, Delete, click the Delete icon in the toolbar or use the Context Menu’s
Delete option.

Note:
O Adding User Defined Units is not done in the Lists window. Users can only
be edited/deleted in the Lists window.

A User Defined Unit is added using one of the following methods:

1. Add a new instrument. See Adding Instruments to the Database For its
Function, select Value as Input and/or Output Quantity. Then enter
the Range values and instead of selecting an existing User Defined
Unit, just write your own unit.

2. Create a new Function Template. See Function Templates. Set Input
and/or Output Quantity as Value and enter a new User Defined Unit
as part of the measurement/keyed Range.

3. Edit an existing Function with Value as Input and/or Output Quantity.
Enter a new User Defined Unit as part of the measurement/keyed
Range.

When a User Defined Unit is added using one of the above mentioned
methods, the new unit is included in the list of User Defined Units shown in
Lists window.

Note:

0 If a User Defined Unit is linked to any function, function template or module
range, it cannot be deleted from CMX and a message informing about
the related function name(s) and/or module range(s) will be displayed.
Also note that a unit which has been used during an instrument calibration
cannot be deleted, since this is part of the calibration event history.

Function Templates

CMX's Function Templates help adding Functions to Devices and Positions. CMX

is shipped with a pre-entered set of Function Templates. The pre-entered Function
Templates may be edited and new templates may be created/copied according to

your own needs.

Each Function typically has at least one Calibration Procedure. The procedure
contains, among other things, the Calibration Points and error limits.
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To maintain the existing Function Templates and their Calibration Procedures, select
Database > Function Template in the main window's menu.

Function Template fields are similar to Function Property Window Fields, see
Function Property Window Fields, CMX webhelp.

Field level information of the Calibration Procedures is available in the webhelp
delivered with CMX.

Editing Function Templates and Calibration Procedure
Templates

Select the item you want to edit in the Function Template window. Then either press
the Edit button on the Toolbar or use the File menu's Edit Record option.

To save or cancel the edits, use either the option available in the toolbar or the
corresponding options available in the File menu.

Creating a New Function Template

To create a new Function Template from scratch:

Make sure you have selected a Function Template in the Tree Structure. Click New
on toolbar. The fields in the property window are cleared to allow you to create a new
Function Template from scratch.

Another way to create a new Function Template is using the New option either in the
File menu or in the pop-up menu of a Function Template.

A new Calibration Procedure Template is automatically created for the new Function
Template. Please check its contents to make sure it suits your needs.

Function Template fields are similar to Function Property Window Fields. See
Function Property Window Fields, CMX webhelp.

See also Copying a Function Template. It allows you to make a new Function
Template and Calibration Procedure Template(s) using an existing Function Template
and its Calibration Procedure Template(s) as the sources for the new items.

Creating a New Calibration Procedure Template

To create a new Calibration Procedure Template from scratch:

Make sure you have selected a Calibration Procedure in the Tree Structure. Click
New on toolbar. The fields in the property window are cleared to allow you to create a
new Calibration Procedure from scratch.
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Another way to create a new Calibration Procedure is using the New option either in
the File menu or in the pop-up menu of a Calibration Procedure .

The new Calibration Procedure Template is automatically linked to the selected
Function Template. If a Calibration Procedure Template was selected, the new
Calibration Procedure Template is linked to the same Function Template that the
selected Calibration Procedure Template is linked to. A Function Template may have
several Calibration Procedure Templates or even no Calibration Procedure Template
at all.

Calibration Procedure Template fields are similar to Calibration Procedure Property
Window. See Calibration Procedure Property Window Fields, CMX webhelp.

See also Copying a Function Template. It allows you to make a new Function
Template and Calibration Procedure Template(s) using an existing Function Template
and its Calibration Procedure Template(s) as the sources for the new items.

O Note: When adding Functions using the wizard:

The first active Calibration Procedure Template of a Function Template is
always selected for use when creating a Position/Device/Function.

When adding Functions using the Tree Structure's pop-up menu:

The new Function contains all Procedures created for the selected
Function Template.

Copying a Function Template

Copying allows you to create a new Function Template and Calibration Procedure
Template based on existing ones.

To copy a Function Template and its Calibration Procedure Templates, select the
Copy option from the pop-up menu appearing in the Tree Structure or use the
corresponding option found in the File menu. Make sure you rename the new
Templates according to your own needs.

The new Function Template inherits all the Calibration Procedure Templates of the
original Function Template.

Deleting Function Templates and Calibration Procedure

When deleting a Function Template or a Calibration Procedure Template, use one of
the following methods:

» Select Delete from the toolbar.
» Select Delete from the Tree Structure's Pop-up menu.
» Select Delete from the File menu.
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Editing the User Interface

This is an optional feature in CMX Professional.

CMX has handy tools for editing the user interface according to your needs.

All texts may be changed.

Fields that are of no interest to you may be hidden (does not apply to required fields).

Field edition can be disabled by locking fields.

See also User Interface Language.

Note: If you have activated Window's UAC (User Account Control) feature
O do as follows:

Run CMX in Run as administrator mode when editing the User Interface.
This is done, e.g. by clicking the secondary mouse button above CMX's
icon and selecting Run as administrator from the pop-up menu.
Otherwise you will lose all your edits.

Direct Editing of the User Interface

This is an optional feature in CMX Professional.

To use the Direct edit tool, select the main window’s Tools menu’s User Interface
option. Choose the Edit option from the submenu. Now all fields in all CMX windows
are available for editing.

Edit a field text by clicking on the secondary button of your mouse. Press Enter to
stop editing the field text.

Remember to save the changes. The Save as well as the Cancel Changes options
are in the menu where the editing was invoked.

Customizing the User Interface

This is an optional feature in CMX Professional.

User interface customizing is started from the main window’s Tools menu’s User
Interface option. Choose the Customize... option from the submenu. Then a
separate window for customizing the user interface is opened.

Select the window to be edited/customized from the list on the left side of the window.
Press the Edit button and then edit/customize a field by clicking on the secondary
button of your mouse.
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The following editing/customizing utilities are available:
+ Editing the field text
* Resetting the field to display the default text

» Defining a field as hidden or making a previously hidden field visible. This option
is not available for required fields

» Defining a field as locked or making a previously locked field unlocked. See more
in Field Locking

Field Locking

This is an optional feature in CMX Professional.

Sometimes there may be a need to disable data editing for individual fields, even for
users who have editing permission. Such fields can be configured as locked fields
via Customizing the User Interface. Several different CMX views can be defined to
contain locked fields.

When entering Edit mode, locked fields are shown with a lock icon. Data cannot be
edited in locked fields, but other fields can be modified and saved.

Special cases where field locking is not used:

* When creating a new item in CMX, all fields are editable. Also with the Wizard.
* When copying an item in CMX, all fields are editable.

* Function/procedure template maintain do not use field locking, because all fields
should be editable for the templates.

» CMKX filtering allows entering data also for locked fields, so those fields can be
used to find items in the CMX database.

Supervisor users that have 'Edit Locked Fields' permission may also edit locked
fields.

Note: The Data Loader does not allow updating data for locked fields via
0 an excel file. Data Loader validation shows a warning message if the excel
file contains data for locked fields.

CMX can be configured to allow Data Loader to update all data from an
excel file. See more in CMX webhelp, in section General Settings Fields.

the field data that is sent from there, is locked and not editable in CMX.
Such data is called Master Data and the CMMS system needs to be used
to enter data for those fields. Field locking is done only for those items that
are received via Beamex Business Bridge. Master Data field locking is
shown with different lock icon in CMX Edit mode.

o Note: The Beamex Business Bridge XML-schema can be defined so that
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Adding Instruments to the Database

CMX supports four ways of adding instruments to its database:

» Using the Wizard is a quick way of adding single Function Positions with an
installed Device.

See Using the Wizard.

* Using the Tree Views seen in the main window. This method leaves all control to
you. Positions, Devices, Functions and Calibration Procedure definitions are all
added according to your own needs.

See Using the Main Window’s Tree Views.

» Copying a Device and/or a Position. This possibility is found in the context menus
of Tree Structures.

See Copying Positions and Devices.

* Receiving new instruments from a calibrator supporting this feature (e.g. Beamex’s
communicating MC series calibrators do support this feature).

See Receiving Calibration Result Data.

» Importing new instruments from an excel file with Data Loader tool.

See Data Loader.

About Instruments, Positions and Devices

For CMX an Instrument is anything that needs to be calibrated or otherwise
periodically checked. CMX adds the Instruments as Positions and Devices containing
Functions and Calibration Procedures.

A Position (also called a “Tag”) is the instrument’s location seen in plans and
drawings. Typically, it is the symbolic name for the Function(s) that is/are needed at a
particular place of the plant (e.g. “TTIR” is the symbolic name used for a Temperature
Transmitter, Indicator and Recorder found in instrumentation drawings).

A Device is the physical instrument installed in a Position. It realizes the Function(s)
defined by the Position. Devices are occasionally removed from a Position (e.g.

for maintenance), stored as Spare Devices and then reinstalled to either another
Position or even the same Position it was installed in before.

CMX supports installation, removal and reinstallation of Devices. The chapters further
on describe how to create and work with Positions and Devices.
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Maximum Amount of Positions, Devices and
Functions

The following table presents the amount of Positions, Devices and Functions that can
be added to different CMX versions.

Table 14: Maximum Amount of Positions, Devices and Functions

CMX version Max. amount of Max. amount of

Positions/Devices Functions inPositions/
Devices

CMX Professional 1000/1000 1300/1300
5000/5000 6500/6500
10,000/10,000 13,000/13,000
or unlimited or unlimited

CMX Enterprise Unlimited Unlimited

The maximum amounts in CMX Professional are fixed when CMX Professional is
purchased.

Using the Wizard

The Wizard is a fast tool for creating a new Position and an installed Device. You only
need to fill in the fields required to create a Position (and a Device).

Note: The wizard creates a Position/Device with a single Function. To add
0 more functions use the method described in Adding Functions.

For maximum amount of Positions, Devices and Functions, see Maximum
Amount of Positions, Devices and Functions.

Step 1 of 5 - Position Data

Enter the basic Position data and its location in the Plant Structure. Either enter the
plant path manually or select it by opening the Plant Structure Tree from the button
on the right side.
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Note: When entering the path manually, remember to use the path
0 separator defined in General Settings.

You cannot create the Plant Structure here, but select/enter the location of
a previously added Plant Structure.

Field level information is available in the webhelp delivered with CMX.

Step 2 of 5 - Device Data

Enter the basic Device data.
Field level information is available in the webhelp delivered with CMX.

Step 3 of 5 - Function Template

Select one of the available Function Templates or use the last item on the list to
create a User Defined Function.

All pre-entered templates are described in the webhelp delivered with CMX.

suitable Function Type available, consider creating a custom Function Type

0 Note: If a certain function need to be entered several times and there is no
Template for it. See Function Templates, CMX webhelp.

Step 4 of 5 - Function Data

Specify the input and output data for the Function. The fields shown vary depending
on the selected Function Template.

Field level information is available in the webhelp delivered with CMX.

Step 5 of 5 - Calibration Procedure Data

Remember to add a Calibration Due Date to the new Instrument and either accept or
edit the default calibration procedure data values on the other fields.

See also chapter Advanced Error Limits.
Field level information is available in the webhelp delivered with CMX.
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Note: When you have added an instrument using custom User Defined

ﬂ templates in the wizard, please check all Function and Procedure fields
in the property window. The wizard may have omitted some fields. In that
case, enter necessary data manually.

Using the Main Window’s Tree Views

The Wizard is a shortcut for making a Position/Device with a single Function. This
chapter together with its subchapters describes how to make any type of instrument,
e.g. one with multiple Functions.

All instrument data located in CMX’s Instrument Database are hierarchically arranged
in the same order as the following chapters.

Adding Positions

There are three ways of adding a Position in CMX:

* Click the Secondary Button on the mouse in the uppermost row of the Position
Tree.

» Click the secondary button on the mouse above a Plant Structure node in the
Plant Structure Tree.

* When viewing the properties of an existing Position there is a button for creating a
New Position in the property window.

Position ID is the only required field, all others are optional. The Position ID field
may have a default value based on your database settings. If it is empty, you need to
enter a unique ID.

Field level information is available in the webhelp delivered with CMX.

tree. Open the menu with your mouse pointer above a position icon and

0 Note: A new position may also be created using the context menu of a
select the Copy option.

For maximum amount of Positions, see Maximum Amount of Positions,
Devices and Functions.
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Adding Devices

There are four ways of creating Devices in CMX:
» Click the Secondary Button on the mouse above a Position seen in the Position
Tree.

» Click the secondary button on the mouse above a Position seen in the Plant
Structure Tree.

» Click the secondary button on the mouse in the uppermost row of the Device Tree.
Open the Devices window, if it is not visible.

* When viewing the properties of an existing Device there is a button for creating a
New Device in the property window.

Note: This note is for the two first methods. If the Position from which the

o adding of the Device was invoked has functions but no installed Devices,
the new Device will be installed to the Position and automatically “inherits”
the same functions as the Position.

Otherwise the device will be added to the Device Tree as a free Device. All
other methods also add the Device to the Device Tree as a free Device.

Device ID is the only required field, all others are optional. The Device ID field may
have a default value based on your database settings. If it is empty, you need to
enter a unique ID.

Note: Adding Device Manufacturers and Models can be done while
0 adding Devices. Just select the “<New...>” option from the list of Models/
Manufacturers.

A new device may also be created using the copy option of a context menu
of a tree. Open the menu with your mouse pointer above a device icon and
select the Copy option.

For maximum amount of Devices, see Maximum Amount of Positions,
Devices and Functions.

Field level information is available in the webhelp delivered with CMX.

Adding Functions

To add Functions you need to have an existing Position or a Device to add the
Function to. There are four ways of creating Functions in CMX:

» Click the Secondary Button on the mouse above a Position seen in the Position
Tree.

» Click the secondary button on the mouse above a Position seen in the Plant
Structure Tree.
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+ To add a Function to a Device, open the Devices window and click the secondary
button on the mouse above a Device.

* When viewing the properties of an existing Function there is a button for creating a
New Function in the property window. The new Function will be added to the same
Position and/or Device as the previously viewed Function.

automatically adds the new Function to the installed Device too. If the
Position has several Devices installed to it, the new Function is added to
the Position but not to any of the installed Devices.

O Note: Adding a Function to a Position with an installed Device

The definition of a Function starts with selecting the Function Template.

Field level information for Function Templates is available in the webhelp delivered
with CMX.

The fields to be entered depend very much on the chosen template. CMX helps you
out by adding default values to the fields that do require some entry.

Field level information for Functions is available in the CMX webhelp.

For maximum amount of Devices, see Maximum Amount of Positions, Devices and
Functions.

Note: If a certain function needs to be entered several times and there
0 is no suitable Function Template available, consider creating a custom
Function Template for it. See Function Templates.

Fieldbus Device Specifics

This chapter presents some fieldbus instrument specifics allowing faster creation of
these types of instruments.

FOUNDATION™ Fieldbus and Profibus PA Devices

When adding a FOUNDATION™ Fieldbus or a Profibus PA instrument into CMX's
database, the following settings should be used:

» Select Digital Variable as the Output Category.

* When you have chosen the Output Quantity, select either Foundation H1 or
Profibus PA as the Output Method.

HART® Devices

When adding a HART instrument into CMX's database, the Analog Output (AO) and
the Digital Output (PV) should be added as two Functions with the following settings:

* The Analog Output (AO) as a transmitter with the output category analog
variable selected.

» The Digital Output (PV) as a transmitter with the output category digital variable
selected. Select the same Quantity both for the input and the output. Select HART
as the Output Method
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User Defined Transfer Function

Among Function data is a field for defining the instrument's Transfer Function, i.e.
input/output correlation. In addition to standard Transfer Functions, an option called
"User Defined Transfer Function" is also available. See User Defined Transfer
Funtion, CMX webhelp.

This option is usable when CMX's standard Transfer Functions do not apply, but
corresponding input/output pair values are known.

When user defined transfer function is selected as the instrument's Transfer
Function, a table for entering up input/output pairs appears. You need not enter
exactly ten input and output pairs, although it is the default amount of rows in the
table, but as many as is needed (minimum amount: 3 rows). Leave excess rows
empty and they will be removed when you finish editing and reopen the function
property window. To add more rows to the table, move to the current last row and
press the Enter key.

Note:
O » First input and output pair (point) must be the same as input and output
0 % range values.

+ Enter absolute input and output values in increasing order (percentage
of span point of view).

» Last input and output values must be equal or greater than input and
output 100 % range values.

Note: CMX and calibrators supporting user defined transfer function

0 approximate the values between entered input/output pairs by calculating
a curve between a pair of points that connects smoothly to the adjoining
curve. The entered input/output pairs need to be points of a strictly
increasing function.

User defined transfer functions are supported in CMX's manual entry
and in modern calibrators, like Beamex MC4 and later. When trying to
send instruments with "User Defined Transfer Function" as the Transfer
Function to a calibrator not supporting this feature, the following error
message appears:

"Unsupported transfer function™.

User Defined Pressure Units
CMX has a comprehensive set of pre-entered pressure units. However, if they are not
suited for your needs, you can create custom pressure units as follows:

1. Select the Unit list for a pressure input or output.
2. Scroll down to the bottom of the list and select option "New".
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3. Enter required data in the opened window:

* Unit Name. A free descriptive text. See note below.

* Reference Unit. The pre-entered unit that is used as the basis for calculating
the user defined pressure unit.

» Factor. A factor for converting the measured pressure from the reference unit
to the user defined pressure unit.

4. Select OK and you are ready.

Note: To minimize the risk of confusion that may lead to serious accidents,
O avoid using unit names that resemble "reserved names", i.e. names of
standard units available in CMX.

Use some sort of prefix or suffix, e.g. "#", in the unit name. This is to
indicate that this is a custom pressure unit, not to be confused with
standard units available in CMX.

Currently this feature is available in CMX's Manual Entry window and
modern calibrators.

Editing/Deleting Custom Pressure Units

To edit, check or even delete a custom pressure unit, select the unit and close the
list. Click the Secondary Button on the mouse above the unit list. A pop-up menu
opens with the options Edit and Delete. Select appropriate option.

H pigze |
Edit
Delete

Figure 8: Editing/Deleting Custom Pressure Units

User Defined Temperature Sensors

CMX supports entering user defined temperature sensors used, e.g. as reference
sensors. Here's how to add a user defined temperature sensor:

1. Select the Sensor Type list for a temperature input or output.

2. Scroll down to the bottom of the list and select option "New".

3. Enter required data in the opened window. The contents depend on the selected
sensor formula.

For Callendar - van Dusen User Defined Temperature Sensors, enter the
following data:
+ Sensor Name. A free descriptive text. See note below.

* High & Low Limit. Defines the temperature range in which the custom sensor is
used.

* RO0. The custom sensor's resistance in Ohms at 0 °C.
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« A, B & C are factors that customize the user defined temperature sensor.
* Resolution. The resolution of the custom sensor.

For ITS-90 User Defined Temperature Sensors:

+ Sensor Name. A free descriptive text. See note below.

* High & Low Limit. Defines the temperature range in which the custom sensor is
used.

* Rtpw, the custom sensor's resistance in Ohms at 0 °C
* Deviation Formula (Below Zero). Select the temperature range below zero.

+ A & B are factors that customize the user defined temperature sensor below zero
temperatures.

» Deviation Formula. Select the range/calibration point data from the available
options.

+ A,(B, C & D) are factors that customize the user defined temperature sensor. The
amount of factors depends on the selected Deviation Formula.

* Resolution. The resolution of the custom sensor.

Using Factor for User Defined Temperature Sensors:

+ Sensor Name. A free descriptive text. See note below.

» Factor. A factor that offsets the standard temperature curve selected in Sensor
Type.

+ Sensor Type. Select a standard Sensor Type. A simple way of doing it is taking

a standard RTD sensor with a 1 ohm resistance @ 0 °C, e.g. Pt1. Then enter the
real resistance @ 0 °C as the Factor.

* Resolution. The resolution of the custom sensor.

avoid using sensor names that resemble "reserved names", i.e. names of

0 Note: To minimize the risk of confusion that may lead to serious accidents,
standard sensors available in CMX.

Use some sort of descriptive text, e.g. sensor's serial number, in the sensor
name. This is to indicate that this is a user defined temperature sensor, not
to be confused with standard sensors available in CMX.

User defined temperature sensors are supported by modern calibrators,
e.g. Beamex MC6 Documenting Process Calibrator. MC4 and MC2 only
supports Callendar - Van Dusen formula.

More of Callendar - van Dusen equation in CMX Calculations help. Open
it from CMX Main Windows' Help menu. Select option CMX Calculations.
Look for main topic User Defined Temperature Sensor Calculations and
from there subtopic Callendar - van Dusen Equation.

Editing/Deleting User Defined Temperature Sensors

To edit, check or even delete a user defined temperature sensor, select the sensor
and close the list. Click the Secondary Button on the mouse above the sensor list.
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A pop-up menu opens with the options View, Edit and Delete. Select appropriate
option.

Pt100 (383) - S/N 357385 L |
Edit

Delete

Figure 9: Editing/Deleting User Defined Temperature Sensors

Adding Procedures

CMX automatically creates a Procedure with default settings for new Functions
except if the Function was created using the New button in the Function property
window. Then the Procedure needs to be manually added.

Procedures may also be added if you need another Procedure for certain needs (e.g.
there is a separate Procedure for quality related calibrations and another for less
demanding calibrations).

There are four ways of creating Procedures in CMX:

» Click the Secondary Button on the mouse above a Function seen in the Position
Tree.

» Click the secondary button on the mouse above a Function seen in the Plant
Structure Tree.

» Click the secondary button on the mouse above a Function seen in the Device
Tree.

* When viewing the properties of an existing Procedure there is a button for
creating a New Procedure in the property window. The new Procedure will be
added to the same Function as the previously viewed Procedure.

Enter a name for the Procedure and check the default values CMX have added to the
fields that do require some entry.

See also chapter Advanced Error Limits.

Note: CMX always uses the first available Procedure for the Function (the

o uppermost active Procedure shown in the Tree). If a Function has several
Procedures, deactivate all Procedures preceding the one you want to use
for calibration.

There are no limitations for the amount of Calibration Procedures, except
the available memory in the computer(s)/server(s) used to run CMX and
store its database.

Field level information for Calibration Procedures is available in the webhelp
delivered with CMX.
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Advanced Error Limits

CMX supports the defining of advanced error limits for Calibration Procedures. An
Advanced Error Limit button entitled Settings is available in both the Wizard's
Procedure page and Tree View's Procedure page. The button opens a window for
defining the advanced error limits.

Note: The advanced error limit settings can be viewed in CMX's Manual

O Entry window and in the Calibration Result window. The same Settings
button can be seen there. It opens the windows presenting the advanced
error limit definitions but the information is read only.

Multiple Error Limits

An instrument's measurement span may be divided into subranges. Each subrange
may have their own constant and relative error limits. For each subrange, the
limitations of Reject Error's Constant and Relative parts apply, but only for the
subrange they are valid in, i.e. the combined Reject Error limit may not cross the zero
error limit within the subrange. Additionally, the subrange's change points may be
outside the span but the change points have to be in increasing order relative to the
span.

The amount of subranges are not limited in CMX. However, certain calibrators/
devices may not support multiple error limits at all or support a limited amount of
multiple error limits, e.g. max amount multiple error limits is 10.

When trying to send instruments with multiple error limits to a calibrator/device that
cannot handle the amount of multiple error limits, CMX shows an error message. The
instrument is not sent for calibration to the calibrator/device in question.

Asymmetric Error Limits

The Advanced Error Limit Settings window also includes the possibility to define
an asymmetry for the error limits, e.g. the positive error limit is double the negative
error limit. The Error Limit's Asymmetric Expansion is defined in two fields:

» The first field defines the multiplier. The value needs to be equal to one or larger.
* The second field defines which error limit is expanded using the multiplier.
Just as for Multiple Error Limits, if a calibrator/device does not support Asymmetric

Error Limits, it is not possible to send an instrument for calibration to the calibrator/
device in question.
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Note: The multiplier applies to the full span of the instrument's
ﬂ measurement range, no matter how many subranges with different error
limits the instrument has.

Other Instrument Related Functions

This section describes the following tasks:

+ Linking and Unlinking Devices

» Assigning Spare Devices

» Copying Positions and Devices

+ Editing Positions, Devices, Functions and Procedures
» Deleting Positions, Devices, Functions and Procedures
 Linking Position with Calibrator/External Module

Linking and Unlinking Devices

When you link a Device to a Position you inform CMX that the physical Device is
installed to that Position.

You may later produce a report detailing where a certain Device has been in the
plant(s), or you may even see which Devices have been installed in a certain
Position.

When you create a new Position and/or a Device, there is a simple possibility to
link the Position and the Device. Existing Positions and Devices are linked by using
another method. Both methods are described in the following subchapters.

Linking While Creating the Instrument Database
There are two ways to link a Device to a Position when creating (or adding a Device
to) the database:
» Create a new Position using the Wizard.
See Using the Wizard.

Then you also add a Device to the Position. This method requires that neither the
Position nor the Device already exist in the database.
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+ Add a Device to an existing Position seen in the Position Tree (alternatively, the
Plant Structure Tree). Open the Context Menu (pop-up menu) of the Position
and add a Device. Then the new Device inherits all Functions and Procedures
of the Position and is automatically linked to the Position. This method requires
that the Device does not already exist in the database but the empty Position with
Functions does exist.

In both cases the new Device inherits all free Functions and Procedures of the
Position and is automatically linked to the Position. Note that a Function and a
Procedure added to the Position after the Device was created will only be the
Position’s Functions/Procedures, not the Device’s. It's the creation order that
determines what happens.

Keep in mind that these two last methods of linking are handy only when creating
the instrument database (or adding a new Device). When both the Position and the
Device already exist in instrument database, see subchapter below.

Linking Several Devices to the Same Position

Out of the two methods presented above, the latter allows you to link several Devices
to the same Position. If a Device is linked to a Position but the Position still has free
Functions, A new device created to the Position "inherits" all free Functions. As a
result, the Position now has two installed Devices.

Additionally: If you add more Functions to the Position and then add a yet another
Device, the new Device "inherits" the free Functions.

way. See Linking Existing Positions and Devices to find out how to link
several already existing Devices to an existing Position. There you can also
find out how to link a single Device to several Positions.

0 Note: This method of linking several Devices to a Position is not the only

Linking Existing Positions and Devices

To link a Device to a Position, open the Devices window, select an uninstalled Device
(a green circle without a yellow “cup”) and drag-drop it to the desired Position seen in
the Position Tree (alternatively, the Plant Structure Tree).

A dialog window opens. There you can either link the device as an installed one or as
a spare device for the Position.

Another way to link a Device is unlinking an already linked Device and selecting a
spare Device as the new linked Device. Both the unlinking and the linking are done
using the Context Menu (pop-up menu) available in the Position Tree (alternatively,
the Plant Structure Tree).

If CMX displays an error message stating that automatic linking is not possible, drag-
drop the Device’s Functions to the Position’s corresponding Functions one by one.

This method is needed when the Position/Device has several similar Functions or the
amount of Functions is not the same in the Position and the Device.
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to a Position, the Device will automatically inherit Position's Function/
Procedure data with the following exceptions: Initial Calibration Date,
Initial Calibration Count and Total Calibrations fields stay unique for
Position and Device.

0 Note: When linking a Device with existing Function(s)/Procedure(s)

Linking Several Devices to the Same Position

If a Position has more Functions than the first linked Device, the free Functions of the
Position may be linked to another Device with suitable Functions. To link: drag the
Device's Functions to the Position's free Functions.

If the Position still has free Functions after linking the second Device's Functions,
a third Device's Functions may be linked to the Position. The Position may have as
many linked Devices as there are Functions and there is no limit to the amount of
Functions in a Position.

Note: This method of linking applies to situation when both the Devices

0 and the Position already exist in the instrument database. See Linking
While Creating the Instrument Database to learn how to add several new
Devices to a Position.

Linking the Same Device to Several Positions

If a Device has more Functions than the Position it was first linked to, the remaining
Functions may be linked to other Positions. Drag the free Functions to Functions in
other Position.

The Device may be linked to as many Positions as there are Functions in the Device
and there is no limit to the amount of Functions in a Device.

General Notes Concerning Linking

* In order to link a Device to a Position, the Functions' Input/Output Category, Input/
Output Quantity and Transfer Function of the Position and the Device data must
"match". Rest of the function data will be synchronized (Position Function data
overwrites possibly conflicting Device Function data).

* A Device with a Function can not be linked to a Position without a "matching"
Function.

* An inactive Device cannot be installed to a Position.

* An already linked Device cannot be linked to another Position. The Device must be
unlinked first.

* An unlinked Device can be a spare Device for many Positions, but as soon as
it is installed into a Position, it can no longer be a spare for any Position. CMX
automatically removes the spare Device definitions.

* Alink leaves a "trace" in the CMX database only if the Device is calibrated while
installed to a Position.

+ Assigning a Device as a spare Device does not require that the Functions of the
spare Device and the Position match.
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Unlinking Devices

To unlink a Device open the Position Tree (alternatively, the Plant Structure Tree),
expand the tree at the Position where the Device to be unlinked is located. Open the
Device’s Context Menu (pop-up menu) and select the Unlink option.

This method applies to both installed and Spare Devices.

Assigning Spare Devices

To assign a Device as a Spare Device to a Position, open the Device Tree, select an
uninstalled Device and drag-drop it to the desired Position seen in the Position Tree
(alternatively, the Plant Structure Tree).

A dialog window opens. Make sure that the “Install as Spare Device” check box is
selected. Then select Ok.

If you want to assign an already installed Device as a spare Device for the same
Position, click the secondary button on the mouse. The context menu has an option
to assign the linked Device as a spare Device.

Note: Assigning a Device as a spare Device does not require that the
o Functions of the spare Device and the Position match.

Copying Positions and Devices

CMX's Position, Device and Plant Structure Trees have in their context menus the
possibility to copy a Position and/or a Device.

Click your mouse's Secondary Button above either a Position or a Device. The
context menu has a Copy option (provided you have the user privileges to create a
Position and/or a Device).

» For an empty Position, a window opens where you can add the Position ID, Name
and Plant path data.

You may also set Position's Accessibility. This however, depends on your
privileges to edit Accessibility data.

» For a free Device, a window opens where you can add the Device ID, Serial
Number and Model data.

You may also set Device's Accessibility. This however, depends on your
privileges to edit Accessibility data.
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* For alinked Position/Device, both previously mentioned windows are shown (one
at a time).

If the Position has multiple linked Functions and Devices, a copy window will be
shown for each Device that is about to be copied.

Note: Copying a Position/Device also copies all Functions and Calibration
0 Procedures the original Position/Device had.

Note: When copying a Position that has a spare Device linked to it, only
0 the main Device(s) will be copied, not the spare Device. This has to be
manually created and linked to Position.

Editing Items Displayed in a Tree

When viewing the properties of an existing Position, Device, Function and
Procedure there is a button for Editing the data in the property window.

Items shown in sub windows (Manufacturers, Calibrators, Users, Lists and
Function Template windows) also have an Edit Record option in the window’s File
Menu.

Positions and Devices always apply to the Procedure/Function of both the

O Note: Editing linked Functions or Calibration Procedures of linked
Position and Device.

Deleting Items Displayed in a Tree

The option to delete an item shown in a Tree is shown in the item’s Context Menu
(pop-up menu). The toolbar also contains a button for deleting items.

Items shown in subwindows (Manufacturers, Calibrators, Users, Lists and
Function Template windows) also have a Delete option in the window’s File Menu.

Note: Deleting of an item is allowed only if user has the appropriate
0 permissions. Delete permissions are needed for all underlying items to

be able to do hierarhical deletion. If position contains function, device and

calibration, it can be deleted only, if user has Position - delete, Device -

delete, Function - delete, Calibration Procedure - delete and Calibration -

delete permissions. With only Position - delete permission user can delete

only empty positions without function and device.
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Linking Position with Calibrator/External Module

A calibrator and an external module can be linked to a position. This means, that the
calibration interval and due date changes of the position procedure and calibrator/
external module are synchronized between position and calibrator/external module.

Position and calibrator/external module linking is defined on the position level. Only
one calibrator/external module can be linked to one position and vice versa.

The linked calibrator and external module fields should be made visible by the
Customized User Interface tool for position view. When those fields are visible in the
Position view, the calibrator or external module can be selected as a linked item to
the position from the corresponding combo box.

Position containing linked calibrator/external module is indicated with own icon in the
Tree structure.

Linked calibrator/external module can be opened from the position by clicking the
Secondary Button on the mouse above the selected calibrator/external module.
Select Show Calibrator from the opened pop-up menu item. The Calibrators
window is opened and the selected calibrator/external module data is shown. If the
position is in Edit mode the Calibrators window is opened in read-only mode. The
Calibrators window should be normally closed to return back to the position level.

When the calibration interval or due date field is changed for position procedure,
those fields are updated for the linked calibrator or external module. If the calibration
interval or due date field is empty in the position procedure, synchronization is not
done.

If the Electronic Signature feature is enabled and the calibration interval or due date
is modifed, an electronic signature is requested and saved both for the position and
linked calibrator/external module. It is recommended, that both Electronic Signature
and Electronic Signature for Calibrators are enabled in Change Management
Settings.

If the position procedure contains an active work order received via Beamex
Business Bridge and the work order contains calibration interval or due date fields,
those fields may not be changed in CMX. If calibration interval or due date fields are
modified in the calibrator/external module, they will not be synchronized to a linked
position with an active work order.
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This section describes tools that help you sort, group and view the instrument data

according to you own needs.

What Is a Query

A query is a tool found in all database software. It contains search criteria that select

the data to be displayed.

Available Queries

CMX has queries available for Positions, Devices, Calibrators and Calibrator
Modules. Queries are part of the software and therefore available at any time. Use
filters for temporary filtering the instrument data.

The available queries are shown in a list just above the Tree. The following table
describes all currently available queries.

Query Description Position Device Calibrator/

Queries Queries Module
Queries

Does not filter out anything. All Positions All Devices All Calibrators/

Everything is shown. Modules

Shows Only the items due (OI’ Due for Due for Due for

overdue) for calibration. o o o
Calibration Calibration Calibration

Shows the items due within a Due within... Due within... Due within...

specified period.

Shows unlinked Positions/ Empty Free Devices |-

Devices only. Positions

Shows all currently added
Positions. See also the note
below.

New Positions
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Queries. It is automatically created when adding Positions and also

0 Note: The “New Positions” query is not available in the list of Position
disappears automatically when you choose another query from the list.

Keep in mind that the Position Query list is the secondary level query. The
Plant Structure List, shown above the Position Query list, is the primary
level filtering for the Positions shown in the Position Tree.

What Is a Filter

A filter is a handy tool for limiting the displayed data. You may define what to filter in
the Position Filter Conditions window or Device Filter Conditions window. Filters
are also available for Calibrator Filter Conditions, Module and Module Range
Filter Conditions as well as Audit Trail Filters.

and create more sophisticated searches using the SQL Editor. See

0 Note: You also have the possibility to save useful filters for future needs
subsequent chapters.

How to Filter Data

To open the Position Filter Conditions window, press the filtering button on the right
side of the Main Windows’ Position query list. The button has an icon that looks like a
funnel. The same feature is in the Devices window that displays the Device Tree.

Calibrator Filter Conditions and Module and Module Range Conditions are
available when working with the Calibrator through the Database > Calibrators...
menu.

When you click either of the filtering buttons, a window with all filterable fields is
presented. Then select suitable filtering parameters.

For text fields: Enter any amount of characters that suit your filtering needs. While
searching for matches, all fields starting with the same characters are selected for
display in the Tree with the filtered data. See also Wildcards.

To activate a filter:

When all filter conditions are set, press the Apply button in the Filter Conditions
window. Then the Position or Device Tree only shows the Positions/Devices that fit
the filter parameters.
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Note: Both the Position Tree and the Device Tree may have their own
0 independent filters active.

Filters are not case sensitive. TIRCA and Tirca returns the same results.

You may also search for empty fields. Enter IS NULL as the search criteria.
This is the exception to case sensitivity: IS NULL need to be written with
capital letters.

For all error limit fields:

When entering numeric values, use the same decimal separator as is
defined for your CMX database. Keep in mind that the decimal separator in
your database may differ from the decimal separator used by the operating
system. When in doubt, consult your IT specialist.

Check boxes have three possible states: Checked, unchecked or mixed.
Mixed displays as a little green square in the check box. By default, all
check boxes in Filter Conditions windows are displayed in mixed state. This
means the value of the check box does not matter. If you change the check
box's state to either checked or unchecked, the check box is part of the
filter query.

To deactivate a filter:

» Double click the Filter icon seen in the Main Window.

* Open the Filter Conditions window again, press the Clear Fields button and then
the Apply button.

Wildcards

Wildcard characters are special characters that represent one or more other
characters. They help filtering data. The following table lists all supported wildcards
and describes how they are used.

Table 15: Wildcards

Wildcard Wildcard Filtering example
character description
% Any string of zero | Setting, e.g. the Position ID filter criteria
or more characters. |to “%CA” the following Position IDs are
accepted:
LIRCAZ100,
LCA101,
PICA102,
TCAZ103
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Wildcard Wildcard Filtering example

character description

_ (underscore) Any single Setting the Position ID filter criteria to

character “ CA’ the following Position IDs are

accepted (compared with the previous
result):
LCA101,
TCAZ103

[1 Any single Setting the Position ID filter criteria to

character within the | “|A.L]CA” the following Position ID is
specified range ([a- | accepted (compared with the previous
f]) or set ([abcdef]). |results):

LCA101
[~ Any single Setting the Position ID filter criteria to
character not “[*A-L]CA” the following Position ID is

within the specified | accepted (compared with the previous
range (["a-f]) or set |results):

Aabcde
(I ) TCA101

Note: The above mentioned wildcards apply for Microsoft SQL Server. If
0 you are using Oracle database, refer to Oracle's own wildcard definitions.

Using Saved Filters

If you have already saved a useful filter, you may take it into use by choosing from
the Filter Name list.

Saving Filters

You may give a name to a filter, set its accessibility and enter a description for it using
the uppermost fields in the Filter Conditions window.

treats the filter as private, i.e. no other user has access to it. If you want
other users to have access to a filter you created, check as many user
groups as you want in the Accessibility list.

0 Note: If no user group is selected in the filter's Accessibility list, CMX

To save a new filter, click the New button in the toolbar and then enter a name for the
filter. After all settings are as required, save the filter by clicking the Save button in
the toolbar.

To edit an existing filter, click the Edit button in the toolbar. Then do the necessary
edits and click the Save button in the toolbar.
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SQL Editor

The SQL Editor button found in the Filter Conditions window shows the current
filtering settings as a standard SQL query.

The Filter Conditions windows’ SQL Editor allows users with SQL knowledge to edit
queries. E.g. all filter parameters in the normal filter window use the AND operator
between all queried fields. In the SQL editor the operator may be changed to OR.

4 Position Filter Conditions

|_J New ¢ Delete | =] Edt

Filter Name

ALccessibility

Description

WHERE POSITION.POSCODE <= 0 AND POSITION.POSCODE IN (SELECT POSITION.POSCODE
FROM POSITION WHERE POSITION POSID LIKE "12% B8] POSITION. NAME LIKE Pressure™)

’ Clear Fields ] [ Apply l ’ Close

Figure 10: SQL Editor

A more advanced SQL query cannot be displayed in the normal filter window. In that
case the Close Editor button is disabled and that particular query may only be edited
in the SQL Editor view.

Note: Your edits may create a query that does not give any results at all.
0 Make sure you type all SQL parameters correctly.

What Is a Set

Sets are groups of Devices or Positions that are selected as part of a collection.
Usually a set contains items that are calibrated at the same time and/or are located
e.g. in the same department.

Device and Position Sets

The Device Sets as well as the Position Sets window is opened (and closed) from
the main window’s toolbar or from the View menu. The upper part of the window

contains a list of existing sets. The last item in the list includes a possibility to create
a new set.

A set is saved with the database and remain available until it is deleted.
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Editing a Set

To add an item to a set, drag-drop it from a Tree containing similar items as the set.

» Devices can only be dragged from the Device Tree seen in the Devices window.
If the window is not visible, open it from the main window’s toolbar or the View
menu.

» Positions can be dragged from the Position Tree or the Plant Structure Tree. One
of the Trees is always available on the left side of the main window.

Removing an item from the set is done from the item’s Context Menu (pop-up
menu). Similarly, the whole set is deleted from the Context Menu opening from the
set name (the uppermost row in the set Tree).
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Check Out / Check In Feature

Check Out / Check In feature is a utility that allows you to "lock" the Positions/
Devices currently under calibration (or being edited). The data of Positions/Devices
that are Checked Out may not be calibrated/edited by other CMX users than the one
who did the Check Out. When Checking In, the Position/Device is "unlocked" and
may again be calibrated/edited by all CMX users.

Check Out / Check In Characteristics

This chapter presents the common characteristics of the Check Out / Check In
feature.

Automatic Check Out / Check In and Manual Check Out / Check In specifics are
presented in their own subchapters.

Postions 1| Plant Structure

=101 DR (Dryer 1) -

mﬁdl positions -

m All positions (3)

=-{#] 101DR-PID014

. =} Pressure Indicator
: [ Procedure for Pressure

[ 07.02.2013 10:31:33

L 10.02.2012 14:43:33

L 13.02.2011 12:32:33

- 101DR-TT0021

i | m | 3

Figure 11: Locked Position and Device

» A Position/Device that is Checked Out, has a red frame around its icon (see
picture above).

* When a Position/Device is Checked Out, all data belonging to it: Position, Device,
Function(s), Procedure(s) and Calibration History is locked.
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» The data of a locked Position/Device may be deleted/edited only by the user that
did the Check Out.

» A locked Position/Device may be sent for calibration or chosen for Manual Entry
only by the user that did the Check Out.

* The uppermost row of a locked item's property window displays the following

information:

[Checked Out By <User Name> / <Date> <Time>]

* Alocked item does not lock documents linked to it.
* Alocked item does not lock pick-up lists it uses.
* You may use CMX's filtering utility to find/view locked items.

 If you utilize Audit Trails (see Change Management and Audit Trail), all Check
Outs and Check Ins are saved in the Audit Trail.

Note: You may still calibrate Positions/Devices without utilizing the Check
0 Out / Check In feature.

0 Note: Calibration cannot be approved when Position/Device is Checked
Out.

Automatic Check Out / Check In

When activated, the Automatic Check Out / Check In feature automatically checks
out a Position/Device sent for calibration or selected for Manual Entry. Similarly, when
the calibration results are saved to CMX's database, the instrument is automatically
Checked In.

By default, Automatic Check Out / Check In feature is not activated. To activate it,
use menu commands Tools, Settings). Check the check box Automatic Calibration
Time Check Out / Check In to activate Automatic Check Out / Check In feature. See
General Settings.

Note: Calibrating a single Function of a multi-function Position/Device
0 locks the Position/Device and all its Functions until the single Function is
calibrated and results are saved in the database.

When several Functions of a multi-function Position/Device are sent for
calibration, the Position/Device is locked until the results of all Functions
are saved in the database.
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Manual Check Out / Check In

Manual Check Out / Check In can be used no matter if Automatic Check Out /
Check In is activated or not. Additionally, a Position/Device Checked Out using
automatic Check Out may be checked in using manual Check In.

Manual Check Out / Check In is more versatile than Automatic Check Out / Check
In. It can be used, e.g. for locking an item that needs editing. Then, in a multi-user
environment, no other users may simultaneously edit the same data and cause
clashes.

Checking Out a Single Instrument

An instrument may be manually Checked Out from any tree structure (Position Tree,
Device Tree, Plant Structure Tree, Position Set Tree, Device Set Tree). Click on
the mouse's Secondary Button to open a context menu above either a Position or a
Device.

If the Position/device is not checked out, the context menu has a Check Out option.

| e

Ho@) OCAL Prink b

+
+

-~ R b

£-0@) Cal Calibration 3
+

0 OCAL Hiskory Trend

Delete

Filker, ..

Figure 12: Checking Out a Single Instrument

Note: Checking out/in is available only for users with permission to edit
0 Position and Device data.

Checking Out Multiple Instruments

A group of instruments may be manually Checked Out from the Query level of a tree
(the uppermost item in a tree, see the picture below).

This method locks all items belonging to the group except the items that were already
locked. They stay locked for the user who originally checked them out.
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Figure 13: Checking Out Multiple Instruments

Note: When doing multiple Check Outs, CMX displays a dialog asking to
O confirm the operation.

Checking In a Single Instrument

An instrument may be manually Checked In from any tree structure. Click on the
mouse's secondary button to open a context menu above a Checked Out Position or
Device.

Out the instrument, for users with Supervisor privileges and the Database

0 Note: The Check In option is available only for the user who Checked
Administrator.

Users with the permission to manually Check In and Check Out
instruments may Check In instruments Checked Out by another user.

Checking In Multiple Instruments

To Check In multiple items, click on the mouse's secondary button above a Query
(the uppermost item in a tree as shown in one of the previous pictures). Select
Check In from the context menu.

This method unlocks all items Checked Out by the logged in user. If the logged in
user has Supervisor privileges or is the Database Administrator, all items will be
Checked In.

Note: When doing multiple Check Ins, CMX displays a dialog asking to
o confirm the operation.
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Calibration

CMX supports the following methods for performing and documenting calibrations:

1. Offline Calibration can be performed with Beamex documenting calibrators or
the Beamex bMobile Calibration Application. Instruments to be calibrated are
sent from CMX to the calibrator or bMobile. After calibration, calibration results
are received back to CMX.

For more information, see Selecting Instruments for Calibration and Receiving
Calibration Result Data.

2. Manual Entry allows entering the calibration results directly into the CMX
database.

For more information, see Manual Entry of Calibration Results.

Calibrations can be done after the necessary instrument data is entered into the
database.

A Position must have an installed Device (with Functions) before a calibration can be
performed. A free Device (with Functions) without a Position can also be calibrated.
If a Device is installed into a Position, only a Position calibration can be done, not a
Device calibration.

Manual Entry supports multiple As Found and As Left repeats. In Offline Calibration,
the amount of As Found and As Left repeats depends on the communicating
calibrator. More information can be found in the calibrator's user manual.

additional info on how to calibrate Weighing Instruments can be found in

0 Note: If you use the Weighing Instrument Calibration feature, some
Calibrating Weighing Instruments.

The Typical Calibration Procedure

The typical sequence of phases in a Calibration Procedure is as follows.

Selection of Functions and Downloading

The Functions due for calibration are selected from the database and sent to the
appropriate calibrator. A query or a predefined set could be used to find the Functions
due for calibration.
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Figure 14: Selection of Functions and Downloading

As Found Calibration

The calibrator is moved into the field, and an As Found calibration is performed using
the setup information in the memory. The results are saved in the memory of the
calibrator.

Figure 15: As Found Calibration

Instrument Adjustment

If needed, the instrument function is adjusted with the help of the calibrator
measurement modules. The maximum error is reduced to the Adjust To limit.

Figure 16: Instrument Adjustment

As Left Calibration

The instrument function is calibrated again, to check that the maximum error is at the
desired level. The results are stored in the calibrator memory, and another scheduled
calibration can be performed.
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Figure 17: As Left Calibration

Receiving of Calibration Results

After all calibrations have been performed, the calibrator is reconnected to the
computer, and CMX will receive the calibration results, and save the calibration data
for use in the future.

Figure 18: Receiving of Calibration Results

Printing of Results

CMX can then e.g. produce calibration certificates reports based on saved calibration
data.

Figure 19: Printing of Results

Calibrator Communication

CMX communicates with the following Beamex documenting calibrators:
+ MC6

+ MC6-Ex

« MC6-T
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+ MC6-WS
+ MC2
+ MC4

Several communication methods are available:

1. The calibrator communicates directly with a computer with CMX client installed.

2. The calibrator communicates with CMX over the network connections via the
Calibration Web Service Interface (CWSI). Customers can establish their own
local CWSI environment or use connect.beamex.com - a web service hosted
by Beamex. The CWSI Client must be installed on the computer to which the
calibrator is connected. For more information, see Calibration Web Service
Interface, CWSI.

3. The calibrator communicates with CMX over the network connections via
Beamex Sync - a cloud-based service that enables asynchronous data transfer
between CMX and Beamex calibrators. The Beamex Sync application must be
installed on the computer connected to the calibrator. For more information, see
Syncing of Instruments and Calibration Results.

All available help documents and installation files are included in the CMX
installation package.

Communicating with MC6 family calibrators

The alternative communication interfaces between CMX and MC6 family calibrators
are the USB cable and the wireless communication.

0 Note: The USB cable is included in the standard delivery package.

When you connect the calibrator to a computer using the USB cable, the computer
uses the Windows generic USB driver (WinUSB). No additional driver installation is
required. The supported operating systems are Windows 10 and 11.

The Wireless Communication option is delivered with a Bluetooth adapter and
requires installing a software. Connect the adapter to the calibrator's USB port,
enable Bluetooth communication in the calibrator's settings and pair it with a
computer.

More information on wireless communication, can be found in the Wireless
Communication for MC6 family calibrators Quick-Reference Guide, delivered with the
option.
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Communicating with MC2 and MC4 calibrators

MC2 and MC4 calibrators can communicate with CMX using the USB cable. The
computer connected to the calibrator must have USB drivers installed.

o Note: The USB cable is included in the standard delivery package.

The USB drivers for MC2 and MC4 are included in the CMX installation package.
Drivers can also be found in the Download Center on the Beamex website. Installing
the drivers requires administrator rights on the computer.

If the USB drivers were installed during the CMX installation, they will be
automatically available when the calibrator is connected. If the drivers were not
installed, a user with administrator rights must install them.

Follow the steps to install the drivers:

1. Connect the calibrator to the computer's USB port.

2. Open the Windows Device Manager. You can use the Search tool found on the
Windows taskbar.

3. In Device Manager, open the Other devices list and right-click on the calibrator.
Select Update Driver Software from the pop-up menu.
5. Select Browse my computer for drivers in the window that opens.

P

Tip: To prevent additional prompts from the operating system, check
@ Always trust software from "Beamex Oy Ab" in the next dialog.

operating systems for CMX Client installation. Windows may display a
warning that the driver is not digitally signed. You can ignore this warning
and proceed with the installation. If your system administrator has restricted
the use of drivers without digital signature, please request their assistance.

0 Note: The driver has been tested in 64-bit versions of the recommended

Calibration Web Service Interface, CWSI

Calibration Web Service Interface, CWSI, is a tool for communication between
calibrators and CMX in virtualized environments.

CWSI introduces two new components into CMX: CWSI Server and CWSI Client.
CWSI Server is installed on a server, e.g. the same server as CMX Server is
installed. CWSI Client is installed on all computers where CMX main software is run.
More info of CWSI installation is in CMX Installation Manual and in CWSI Help file


http://www.beamex.com/download-center/

Calibration - 103

included in CWSI Server and CWSI Client. The help file is also available as a pdf file
on CMX's installation disc.

bMobile utilizes CWSI Server or Beamex Sync Server to communicate with CMX.
For more information about Beamex Sync, please see the document 'Beamex Sync
Help'.

Starting CWSI

Before using CWSI, CWSI Client must be started and connected to CWSI Server.

Use Windows' search tool to locate CWSI Client. How to invoke the search tool
depends on the operating system version. The picture below is from Windows® 10.

= i 0 Filters ~v
Best match
Tnt
CWsI Client
Desktop app
Apps

o # CWsl Server Configurator

Ensure that the CWSI Client is found in the system tray:

The context menu of the system tray icon allows you to configure the connection to
CWSI Server and connect to CWSI Server.

Configuring CWSI Server is done similarly, but on the computer it resides in,
provided you have the rights to make changes to the computer. The configuration
software is called CWSI Server Configurator.

Using CWSI in CMX

In CMX, CWSI is available in both Send to Calibrator and Receive from Calibrator
windows. Select CWSI as your Protocol. The small button with three dots allows you
to check/edit CWSI Server settings ensuring connection to CWSI Server. The picture
below presents the default settings.
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Protocel cwsl v Connection
Part Calibrator

Pasttion 1D - Name Status

Server

|connec‘t.beamex.com;‘cwsi |

Port
[443 |

Connection timeout (s)

[180 |
Mumber of reconnect attempts

[10 |

Time between reconnect attempts (s) | (L

4B |
Secure connection

Cancel

Figure 20: Using CWSI

If CMX connects to CWSI Server, then the Connection selection list shows all
matching CWSI Clients where CMX user id (set in CWSI Client's Options) is the
same as User ID in CMX. Each connected calibrator of the CWSI Client is listed in
the Calibrator list. In any other manner both Send and Receive windows can be used
normally.

Note: If your calibrator is missing from the Calibrators list, select
O Connection again. It refreshes the Calibrators list.

If CWSI is configured to require a "Secret" (a password unique to CWSI),
the "Secret" has to be entered before sending and receiving commences.

Selecting Instruments for Calibration

Since a calibrator treats each Function in an instrument as a separate item to be
calibrated, CMX sends Functions to the calibrator, not instruments.

CMX has a separate window for collecting the Functions that will be sent to the
calibrator. The window is opened using one of the following methods:

» Selecting Send from the main window’s toolbar (found in a submenu that opens
from the Calibration button).

+ Selecting Calibration, Send from a suitable Context Menu (pop-up menu).
» Selecting the Send option from the main window’s Calibration menu.
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Adding Functions to be calibrated to the Send to Calibrator window is done using
the following ways:

Selecting Calibration, Send to Calibrator from a suitable Context Menu (pop-
up menu). This option is available for the following items shown in one of CMX’s
Trees:

o A Position with an installed Device. If the Position contains several Functions,
all Functions are added to the list.

o A Function in a Position with an installed Device.

> An uninstalled Device (containing Functions). If the Device contains several
Functions, all Functions are added to the list.

o A Function in an uninstalled Device.

Dragging Functions, Positions or Devices from a Tree to the Send to Calibrator
window.

Selecting the name of a query or a set (the uppermost row in a Tree) and dragging
it to the Send to Calibrator window is also supported. Then all items included in
the query/set are added to the list of Functions to be calibrated.

Dragging a Plant Structure level from the Plant Structure Tree to the Send to
Calibrator window. Then all Functions of Positions/Devices hierarchically below
that Plant Structure level are added to the Send to Calibrator window.

Sending Instruments for Calibration

== Send to Calibrator

Protocol

USB

Serial Port

=N HoN =<~/

Manufacturer  Beamex Oy Ab

Calibrator  MC6 : 601606

Field Calibrator Interface
Position 1D -| Bluetooth Status
CcwslI

Close

When you open the Send to Calibrator window, you first have to select the
Protocol. The options are:

USB for calibrators using USB port for communicating with the PC.

Serial Port for communicating with older calibrators using serial communication
and Beamex's CALIBINT legacy protocol. Remember to select the COM Port too.
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» Field Calibrator Interface is for communicating with calibrators supporting standard
FCINTF protocol.

* Bluetooth for calibrators using Bluetooth when communicating with the PC.

» CWSI is for communicating with calibrators and bMobile via Calibration Web
Service Interface (CWSI). See Calibration Web Service Interface, CWSI.

* Sync is for communicating with CMX, Beamex calibrators and Beamex bMobile.
See Syncing of Instruments and Calibration Results.

The calibrator may also be selected. Use the list of manufacturers and models to
identify the calibrator.

When you press the Send button, the communication with the calibrator starts. The
status column tells you how the communication advances.

O

Note: The 'Auto Detect' option available for Serial Port protocol is fully
compliant with Beamex calibrators. Other calibrator brands may not support
auto detection.

CMX remembers the Protocol, Port and Calibrator settings so the next
time you open the Send to Calibrator window, the settings are already
according to your needs.

Closing the Send to Calibrator window before pressing the Send button
cancels the sending procedure. Next time you open the Send to Calibrator
window, the list of functions to be sent is empty.

When sending instruments to certain newer calibrators, the instrument's
Plant Structure path may also be included in sent data. To activate this
feature, open CMX's Settings window.

Before communicating with the calibrator, you may need to install a USB
driver or pair the device via Bluetooth. For more information, see Calibrator
Communication.

If the Calibration Settings option Warn when Calibrator/Module is
Overdue is checked, CMX warns when you try to send instruments for
calibration to a calibrator with an overdue calibration.

If the field Reject if Calibrator is Overdue in an instrument's Calibration
Procedure is checked, that instrument will not be sent to a calibrator with
an overdue calibration.

Note: If Mobile Security Plus option is in use or CMX is configured to
allow defining Mobile Users:

* Mobile User information is sent from CMX to supported Mobile Device.

+ If Site User Maintenance is used then only users belonging to the same
site are sent to Mobile Device.

* Any possible locked Mobile User accounts are released by sending an
instrument to a Mobile Device.

» Overwriting existing instruments containing calibration results in a
supported Mobile Device is prohibited.
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Receiving Calibration Result Data

To open the Receive from Calibrator window use one of the following methods:

+ Select Receive from the main window’s toolbar (found in a submenu that opens
from the Calibration button).

» Select Calibration, Receive from a suitable Context Menu (pop-up menu).
» Select the Receive option from the main window’s Calibration menu.

CMX remembers the latest Protocol and Port used as well as the latest manufacturer/
calibrator settings, so normally you do not need to change the settings shown in the
upper part of the Receive from Calibrator window. For available Protocol options,
see Sending Instruments for Calibration.

Press the Connect button to see a list of Positions/Functions available in the
calibrator’s memory. The results column indicates whether a Position/Function
contains calibration results or not.

Remember to check/uncheck the check boxes found at the bottom of the window
according to your needs.

Note that the Delete Instruments After Receive from Calibrator checkbox may
be overridden in Calibration Settings. Then you are not able to change the setting
here. See also Receiving Instrument History and Avoiding Duplicate Results.

When you press the Receive button, the communication with the calibrator starts.
The status column tells you how the communication advances.
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Note: The Receive from Calibrator window has a Confirm External
References check box. If it is checked, a window for entering external
calibrator reference data opens for the following input/output methods:

* Input and/or Output Method is 'Keyed'.
* Input Method is set to 'Controlled and Measured'.

If the Instrument data of the instrument to be received differs from the data
in CMX's database, CMX asks whether you want to receive the calibration
results and update the instrument data in CMX or if you want to cancel the
receiving of results.

When receiving calibration results of an instrument that is not in CMX'’s
database, CMX asks if the new Device (Field Entry Device, a.k.a. FED)
should be added to the database.

Adding instrument data is only available in modern calibrator types
supporting this feature. If unsure, check by downloading a new instrument
created in the calibrator. CMX informs you if it finds a new instrument and
asks if the instrument should be added to CMX'’s database.

Before communicating with the calibrator, you may need to install a USB
driver or pair the device via Bluetooth. For more information, see Calibrator
Communication.

Modern communicating calibrators may support long Position ID and
Device ID fields or even instruments without either or both ID fields. CMX
does not support empty ID fields or ID fields longer than 65 characters.
When Positions/Devices with missing or too long IDs are received, CMX
informs the user about it and offers a possibility to give/change Position 1D
and/or Device ID. The information will also be updated in the calibrator.

If the Calibration Settings option Warn when Calibrator/Module is
Overdue is checked, CMX warns when you try to receive calibrated
instruments from a calibrator with an overdue calibration.

If the field Reject if Calibrator is Overdue in an instrument's Calibration
Procedure is checked, you cannot receive calibration results for that
instrument from a calibrator with an overdue calibration.

Note: If you have an instrument capable of communicating with other

devices (e.g. a HART® or a fieldbus instrument) that you want to add to
CMX’s database, do as follows: Connect them to a calibrator with suitable
communication capabilities, e.g. Beamex’s MC6 Advanced Field Calibrator
and Communicator. Read the instrument data into the Calibrator and
connect the Calibrator to CMX. Receive the instrument data from MC6.
This method enables you to build your database without retyping anything
that is already available in the instrument’s memory.
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Note: An overdue calibrator will not prevent results from being received

0 if the calibrator is used as a manual entry tool with Confirm External
References enabled, even if Reject If Calibrator Is Overdue is checked in
an instrument's Calibration Procedure. If Reject If Calibrator Is Overdue
is checked, overdue modules will not be displayed in the Input Module and
Output Module combo boxes in the Calibrator and Module References
window. An overdue calibrator will be selectable for Input or Output
Calibrator, but results cannot be received from a calibrator with an overdue
calibration unless a module that is not overdue is also selected.

Receiving Instrument History

In Receive from Calibrator window:

If the Status column of the list of instruments contain data (e.g. 'Current’), the
instrument data has changed in the calibrator, e.g. the measurement span has
been edited. If you want to save the instrument history and corresponding results,
make sure you check the Show Instrument History check box below the list of
instruments. The status may be:

» Original. In this calibration, the instrument is as they were during the earliest
calibration.

» Current. In this calibration, the instrument is as it currently is in the calibrator.
» Edited X where X is a number starting from 1. These are intermediate versions
between the 'Original' and 'Current'.

This feature is available in modern calibrators.

Avoiding Duplicate Results

When receiving calibration results, CMX compares the calibration date of the results
to be received with calibrations already received. If the dates and, when applicable,
the errors match, CMX prompts you to confirm receiving these kind of results.

Receiving duplicates is easily avoided by deleting already received results from

the calibrator. As mentioned earlier, this functionality is available with the Delete
Instruments From Calibrator After Receive check box in Receive from Calibrator
window.
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Syncing of Instruments and Calibration
Results

Beamex Sync is a service enabling asynchronous communication between CMX,
Beamex calibrators and Beamex bMobile. For more information about Beamex
Sync, please see the document 'Beamex Sync Help'.

Sending an Instrument for Calibration

The sync functionality is used like any other of the communication protocols provided
in the Send to Calibrator window. Select Sync and you are provided with additional
selections. Assigned to is where you select to whom the instrument is assigned. The
Device type selection allows you to select the target device on which the calibration is
performed. Once everything is set up you press send to initiate the synchronization.
For more information about Beamex Sync, please see the document 'Beamex Sync
Help'.

Sync

By pressing Sync you open the list of calibration results that are ready to be
synchronized back to CMX. Pressing Refresh will update the list with the latest
modifications. Only results from your own organization are shown in the list. You

can either select all results in the list by checking the checkbox on the header row or
individual results from the list according to your needs. Once the desired results are
selected, press Process to begin processing the result data. Depending on your CMX
configuration, you might be presented with different dialogs requiring actions from
you. For more information about Beamex Sync, please see the document 'Beamex
Sync Help'.

Manual Entry of Calibration Results

If calibrations are carried out with a calibrator that is unable to communicate with
CMX then Manual Entry is the solution. In Manual Entry calibration results and all
calibration related data is typed into the database.
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you to, e.g. calibrate several temperature sensors at the same time, each

ﬂ Note: CMX supports opening several Manual Entry windows. This allows
sensor having its own Manual Entry window open.

If you utilize the Weighing Instrument Calibration feature, additional info on
how to calibrate Weighing Instruments is presented in Calibrating Weighing
Instruments.

Selecting Functions for Manual Entry

There are several ways of selecting a Function for Manual Entry:

» Select the Position/Device/Function to be calibrated from a Position Tree, Plant
Structure Tree or a Device Tree and then select Manual Entry from the toolbar
(found in a submenu that opens from the Calibration button).

» Select the Position/Device/Function to be calibrated from a Position Tree, Plant
Structure Tree or a Device Tree and then select Manual Entry from the main
window’s Calibration menu.

» Click the Secondary Button on the mouse above a Position or a Function seen in
the Position Tree. Then select Calibration, Manual Entry.

» Click the secondary button on the mouse above a Position or a Function seen in
the Plant Structure Tree. Then select Calibration, Manual Entry.

* Click the secondary button on the mouse above a Device or a Function seen in the
Device Tree. Then select Calibration, Manual Entry.

Using any of the above mentioned methods opens the Manual Entry window ready
for data entry.

Manual Entry, only the first (the uppermost) Function of the Position/
Device is sent to the Manual Entry window. This is because CMX’s Manual
Entry currently only supports the calibration of one Function at a time.

To select any other Function (as well as the first Function) in a Position/
Device for Manual Entry, click the secondary button on the mouse above
the Function instead of the Position/Device.

o Note: When selecting a Position/Device and choosing Calibration,

Note: To be able to calibrate a Position, a Device (containing Functions)

o needs to be linked to it. A Device (containing Functions) may be calibrated
although it is not linked to a Position. When a Device is linked to a Position,
Manual Entry may be invoked for the Position only.

Note: If Position/Device function contains data entered in Before
Calibration Note field on procedure level, it is shown to the user separately
after Manual Entry is started.
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Entering Calibration Results

Enter the results in the grid shown on the Results tab. Also check the Calibration
Date field and the Calibrated By fields shown in the same tab. You can select one or
two users as the ones that carried out the calibration.

Enter calibration related data (e.g. the environment temperature) into the Conditions
tab.

The Procedure tab contains read-only data about the Calibration Procedure,
including possible instructions to guide you through the calibration.

Depending on your Calibration settings, you may have to select input and output
calibrators and modules used in the calibration. See Calibration Settings. Note that
you may select multiple input/output calibrators and modules for each calibration
point.

Overdue calibrators and modules will be displayed in red when opening the drop
down lists. When entering older result the overdue status of the calibrators and
modules will be based on the calibrators and modules due date at the time of the
calibration date (if there exists calibration history for the calibrator/module used,
otherwise current due date will be used).

The way the Calibrators and Modules (references) are sorted in the Manual Entry
window depends on settings defined in the Settings window's Calibration section.

Field level information is available in the webhelp delivered with CMX.
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Note: For unstable readings, you may add the “~” character (tilde) after
or before the calibration point values, e.g. 12.045~. If you enter the “~”
character before the numbers, CMX moves the character at the end of the

number. This is done to avoid mix-up between the minus sign and the “~
character.

Input values outside the calibration point's Max. Deviation limit are
indicated in red. This does however not affect any calculations.

When entering older results i.e. changing the Date value to a previous date,
the Date value is no longer updated when entering calibration point values
to manual entry table.

If the Calibration Settings option Warn when Calibrator/Module is
Overdue is checked, CMX warns if you select a calibrator or module with
an overdue calibration.

If the field Reject if Calibrator is Overdue in an instrument's Calibration
Procedure is checked, it is still possible to save the calibration even when
the calibrator is overdue, as long as the selected module is not overdue.

If Calibration Setting option Chronological Date/Time Validation is
checked, saving results that have the same date and time stamp is not
allowed for a single calibration event. Each repeat must have a unique
time stamp in the correct chronological order and use the same format
throughout. Certain repeats may not, e.g. have just the date and others
both date and time.

Also: No As Found results may be saved after the first As Left result.
Skipping Calibration Points may be prohibited or a skipped point may
require a comment.

If Mobile Security Plus option is in use:

The calibration date/time can be prohibited by using the permission ‘Manual
entry - Calibration time edit'. More about Mobile Security Plus in Mobile
Security Plus.

New Repeat

To start entering the results of the next calibration repeat, press the New button in the

Manual Entry window’s toolbar. If you have entered any data into the Conditions
tab, CMX automatically copies them as part of the new repeat’s data. Edit them, if

needed.

To view previously entered results the click icons on the left side of the Manual Entry

window.

Saving the Results

When you press the Save button in the Manual Entry window’s toolbar, CMX saves
the results in the database. If you continue entering results, they will be saved as a
separate calibration saved on the same day.
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While saving results CMX displays information of each repeat in a window similar to
the one below:

Calibration Completed @

As Found - PASSED
Max Found Error: .56 % of span
Maost Significant Error:  0.50 % of span
Maost Significant Error: 67 %% of limit

L

Figure 21: Calibration Completed

Fields:

* Max Found Error is the repeat's found maximum error value.

* Most Significant Error (value) is the numeric value of the found error that is
closest to corresponding error limit.

* Most Significant Error (percentage) indicates how close to the calibration point's
error limit the most significant error value is. The percentage value is less than or
equal to 100 % if the calibration passed and more than 100 % if the calibration
failed.

When the relative component of the Reject if Error limit is used, the Max Found Error
may differ from Most Significant Error. More of Error Limit Function's components

in CMX's webhelp. Another source for information of Error Limit Function is in CMX
Calculations Help file. Open it from CMX Main Windows' Help menu. Select option
CMX Calculations.

Note: Depending on your calibration settings, results may be save "as
o both" (the results are saved both as As Found and as As Left results). This
setting is among the Calibration settings. See Calibration Settings.

If the field Reject if Calibrator is Overdue in an instrument's Calibration
Procedure is checked, you cannot save calibration results if you have
selected a module with an overdue calibration or a calibrator with an
overdue calibration and empty module field.

Ending Manual Entry

To end Manual Entry, press the Close button in the Manual Entry window’s toolbar
or select Close from the File menu. If the results of the last repeat was not (fully)
saved, CMX prompts you to save them first.
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Note: If Position/Device function contains data entered in After Calibration
ﬂ Note field on procedure level, it is shown to the user separately after
Manual Entry is closed.

Viewing the Results

The result property window can be opened from the following Trees:

* The Position Tree,

* The Plant Structure Tree and the

* The Device Tree.

* The Position Set and Device Set Trees.

In all cases: Click on the tree to see the results icon. It is located below the Function

icon. Either double click on the results icon or select the Properties button in the
main window’s toolbar.

Figure 22: The Results Icon

The results are shown below in “latest repeat result first” order.

The Valid Result check box allows you to exclude somehow not usable results from
calibration history analysis.

CMX uses the calibrator module specifications to calculate the input and output
uncertainties shown in the result table.

The Environmental Data and the Calibration Notes found among the calibration
results can be edited. Also the status of the Valid Result check box can be changed.
To do it, click the Edit button found in the property window’s toolbar.

12.045~, the reading was unstable. Adding this character is possible
in CMX's manual entry window and when appropriate, the character is
automatically added in a reading when using certain modern calibrators.

0 Note: If an input or output value ends in a “~” character (tilde), e.g.

Note: If calibration time is manually entered by the user instead of using
o automatic system time, it is indicated in parentheses after calibration time
as Saved on calibration time.
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Average Results and Expanded Uncertainty

Average results and uncertainties can be shown among calibration results. They are
individually activated/deactivated in the Settings window's Calibration page. See
Calibration Settings. To open the Settings window, select Tools, Settings in CMX's
main window's menu.

If Show Average Results is checked, the calibration result window includes an
additional table of average results for all calibrations with more than one As Found or
As Left repeat. For Switches: Multiple switch cycles in a single calibration repeat is
enough for CMX to calculate average results.

If Show Expanded Uncertainty is checked, the calibration result window includes an
extra column of Expanded Uncertainty data among each calibration repeat. Also: the
error graph displays uncertainty bars for each calibration point.

More info of average and uncertainty calculations in a separate help file entitled
"CMX Calculations". Open it from CMX Main Windows' Help menu. Select option
CMX Calculations.

Approving Calibration Results

The approval of calibration results vary depending on whether Change Management
option and its Electronic Signature feature is active or not.

+ With Change Management / Electronic Signature in use, a table of signatures and
a Sign button is found at the bottom of the result window.

» Otherwise a table of approvals and an Approval button is found at the bottom of
the result window.

To approve/sign results, press the Approve (or Sign) button and enter required
information.

Note: Approving/signing calibration results is allowed only if you have the
0 appropriate user rights.

Workflows function is enabled and a workflow has been initiated. The
position and/or device will be marked as approved once the user assigned
as the final step in the workflow signs the entity. SeeSignature Workflows
for more information.

o Note: A user cannot approve a position or device when the Signature

Change Management / Electronic Signature is an optional feature in CMX
Professional.
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Locking Calibration Results

Locking Calibration Results is an optional feature in CMX Professional.

Approved calibration results may be locked, provided the user has appropriate rights.
When the results have been locked, the results may not be changed in any way
unless someone with appropriate rights unlocks the results.

To lock/unlock calibration results, position your mouse pointer above a calibration
result icon in CMX's main window's Positions, Plant Structure or Devices tree
structure. Click on the mouse's Secondary Button to open the pop-up menu and
select Lock or Unlock.

Deleting Calibration Results

To delete calibration results, open the Context Menu and select the Delete option.

Note: Deleting calibration results is allowed only if you have the
o appropriate user permissions.

History Trend

This is an optional feature in CMX Professional.

History Trend is a utility for viewing calibration history data. It is available both for
Positions and Devices. The data is displayed graphically and is also available in
numeric format in a table.

The biggest difference between the standard Calibration Results window and the
History Trend window is that you can view several calibration results simultaneously
in the History Trend window. It allows you to evaluate the calibrations of a Position or
a Device for a longer time period compared to the normal calibration result view.

Examples of how to utilize the History Trend feature:

» Get an overview of how a particular device drifts between calibrations and also
whether the drift increases with time.

* How different devices are suited for use in a particular Position.

Note: For Weighing Instrument, the History Trend is available for the
0 actual Weighing Test only.
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Opening the History Trend Window

This is an optional feature in CMX Professional.
The History Trend window is opened using one of the following methods:

» Click the Secondary Button on your mouse above a Position, Function,
Procedure or a Result icon seen in a main window Tree Structure. Select History
Trend from the opened pop-up menu.

+ Click the secondary button on your mouse above a Device, Function, Procedure
or a Result icon seen in the Devices window. Select History Trend from the
opened pop-up menu.

* The View menu of the main window includes a History Trend option.
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Calibration Certificates and Other
Documents

CMX allows the printing of the following document types:

» Calibration Certificates

* Reports,

* Labels

» History Trend graphs

* Data Loader and

* Audit Trail reports

To print documentation from CMX, use the Documents button found in the main
window’s toolbar or select the document type to be printed from the Documents

Menu. A third possibility is using the Context Menu. In all cases: A more detailed print
selection window will be open for that document type.

Exception: Audit Trail Reports are printed from the Audit Trail window. See The Audit
Trail Window.

It is also possible to configure CMX to save the documents in files. See Automated
Document Generation.

Printing Certificates

Select the certificate layout from the list available in the Print Certificate window.
Then drag the Position, Device, Function or Result icon from a Tree to the print list.
Note that a Position can only be dragged from a Position Tree, Position Set Tree and
the Plant Structure Tree. A Device can only be dragged from a Device Tree and the
Device Set Tree.

Use the Preview button to see on the screen how the printed certificate looks like.

Note: Only Positions/Devices/Functions with saved calibration results may
0 be dragged to the Print Certificate window.
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Printing Reports

Select the report layout from the list available in the Print Report window. Then drag
the Position from the Position Tree, Position Set Tree or the Plant Structure Tree and
the Device from the Device Tree or the Device Set Tree.

About the check boxes:

If none of the check boxes are checked, the report contains data based on the latest
repeat of the latest calibration.

If only All Repeats is checked, the report contains data based on all repeats of the
latest calibration.

If History is checked, the report contains data based on all repeats of all
calibrations for the selected items. In this case the All Repeats setting does not
matter.

If Results is checked, then the report includes data for all Calibration Points.
Otherwise the data is presented on repeat level.

Example: If a 5 point up-down calibration is done, then the report includes either
one row of data (Results unchecked) or nine rows of data (Results checked).

If AVG Only is checked, then the report includes average results only, omitting
the individual repeats. If only one repeat was done, i.e. no average results are
available, then that single repeat is printed no matter if AVG Only is checked or
unchecked.

Use the Preview button to see on the screen how the printed report looks like.

Average Results is checked.

0 Note: AVG Only is visible only when Calibration Settings field Show

AVG Only can be changed when either History or All Repeats check box
is checked.

One of the available reports is called Manual Entry Form. Print it to have a
practical form for manually entering calibration results.

Printing Labels

Select the label layout from the list available in the Print Label window. Then drag
the Position from the Position Tree, Position Set Tree or the Plant Structure Tree and
the Device from the Device Tree or the Device Set Tree.

Use the Preview button to see on the screen how the printed labels look like.
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Printing History Trend Graphs

History Trend is an optional feature in CMX Professional.

Select the history trend layout from the list available in the Print History Trend
window. Then drag the Position, Device or Function icon from a Tree to the print list.
Note that a Position can only be dragged from a Position Tree, Position Set Tree and
the Plant Structure Tree. A Device can only be dragged from a Device Tree and the
Device Set Tree.

Use the Preview button to see on the screen how the printed history trend graph
looks like.

Note: Only Positions/Devices/Functions with saved calibration results
o may be dragged to the Print History Trend window.

Printing Data Loader

Data Loader is an optional feature in CMX Professional and CMX Enterprise.

Data Loader printing saves the instrument data to an excel file, which can be edited
and imported back to CMX via Data Loader.

Select data loader layout from the list available in the Print Data Loader window.
Then drag the Position from the Position Tree, Position Set Tree or the Plant
Structure Tree and the Device from the Device Tree or the Device Set Tree.

Use the Preview button to see on the screen how the saved excel file content looks
like.

See Data Loader.

Printing Audit Trail Reports

Audit Trail and Change Management are optional features in CMX Professional.

Audit Trail window has a toolbar button for printing a report of displayed Audit Trail
data.

See The Audit Trail Window.
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Importing/Exporting Document Layouts

Sometimes you need to copy document layout from a CMX database to another. The
tools for doing that are in the File menu. To copy the document layout, do as follows:

1. Open the database where the document layout to be copied exists. Then select
File, Export, Document Layouts.

2. Select the Layout Type and press the corresponding Export button. A dialog for
selecting the folder appears.

3. Select appropriate folder and press Save.

4. Open the database where you want to have a copy of the exported document
layout. Then select File, Import, Document Layouts..

5. Select correct Layout Type and then Browse to the folder where the exported
layout is.

6. If applicable, edit the Layout Name and Description.
7. Press the Import button.

Note: If you receive a standalone document layout, sent by mail from,
o e.g. Beamex, start from phase 4 in the list above. Just replace the word
‘exported' with 'standalone’.

Creating Your Own Certificates

This is an optional utility in CMX Professional.
The Report Design tool allows you to make your own Certificate, Report etc. layouts.

Since the software module used for creating layouts for Certificates, Reports etc.
is a third party software it has its own online help made available while creating the
layouts.

Adding/editing e.g. a new Calibration Certificate layout is done using menu
commands: Documents, Certificates, Design. Others are added/edited similarly. Just
change the document type.

Exception: Editing Audit Trail Reports is invoked in the Audit Trail window. More of
this in The Audit Trail Window.

Also note that you can have only one Audit Trail Report Layout for each CMX
database. You may however edit the existing one to suit your needs, provided you
have the rights and tools to edit document layouts.

CMX is shipped with a Help folder called CMX Report Variables. It presents all
variables available in the Report Designer. Open it from CMX Main Windows' Help
menu. Select option CMX Report Variables.
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you'll need to run CMX as administrator to be able to save the edited
documents. Otherwise you will get an error message and your edits are not
saved.

ﬂ Note: If you have activated Window's UAC (User Account Control) feature,

Automated Document Generation

CMX documents can be saved in files instead of printing them on paper. Document
file saving can be automated, so the same rules are always used when printing.

Automated Document Generation Settings is started by selecting Settings... from
the Documents menu. 'Setting maintain - Automated Document Generation User' -
permission is needed to be able to configure Automated Document Generation.

File naming and printing rules are configured in this window.

User defines here how the filename is generated when saving document in a file in
Print windows. The filename is built in the following way:

Vari abl el + Constantl + Vari able2 + Constant2 + Date + . +
File Type

If any of the items, except File Type, is empty, it is not used in the file name
generation.

Press Ok to save the configuration.
Each document type can be separately configured on its own page.

When Automated Document Generation is configured for a document type, CMX
Print window uses these rules to preselect settings.

Note: If both Show File Dialog and Show Print Settings are disabled,
0 Printing to file is done automatically. File saving is confirmed with Print
successful message, which shows the folder where the file is saved.

Field level information is available in CMX webhelp.
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Change Management and Audit Trall

This is an optional feature in CMX Professional.

Change Management and Audit Trail includes tools for keeping track of changes
made to CMX's database. Additionally, whoever makes a change to the database
may also be asked to give a description for the change.

Users with the proper authorization may review the change log (Audit Trail) and mark
the changes reviewed.

The feature also includes a possibility to utilize electronic signatures.

Briefly, CMX’s Change management feature includes all the tools required to
comply with regulations of which most important are GAMP4 (Good Automated
Manufacturing Practices) and 21 CFR Part 11 (Electronic records; Electronic
signatures).

How to Change or check your Change Management and Audit Trail settings is
described in The Settings Window.

The Audit Trail Window

The Audit Trail window can be opened from the main window’s Tools menu. Use the
Display button in the toolbar to select the type of records you want to see.

Large Audit Trail databases (containing more than 50 000 rows) are opened showing
the Audit Trail events according to "How many days back is the AT shown by default"
setting. Use the date fields below the toolbar to select another time period for
viewing.

To mark events as reviewed (requires that you have the rights to do it), press the Edit
button in the toolbar. Then you can use one of the following methods:

* Use the check box in the next to last column to mark a single event as reviewed.
* Use the Review All button in the toolbar to mark all events as reviewed.

Hints.

» To sort the Audit Trail data, click on the header of the column you want to sort by.

» To copy Audit Trail data to the clipboard (for pasting into, e.g. Excel), highlight
the part you want to copy. Then use the Windows standard keyboard shortcut for
copying (Ctrl C).
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» To print Audit Trail data, use the Documents button in the toolbar. The Print and
Print Preview options print/display the Audit Trail data for the selected date range.

The Documents button also has the Design option. It is active, provided
the Report Design option is part of your CMX software. More of Reports and
Calibration Certificates in Calibration Certificates and Other Documents.

The Audit Trail window toolbar contains the Filter button for filtering the Audit Trail
data.

The Audit Trail window toolbar contains the Archive button for selecting how the
archived Audit Trail events are shown:

1. Only active lists active Audit Trail events according to the Active archive period
in months setting value.

2. In same set and active lists active Audit Trail events and events from the same
Archive set, to which the selected Audit Trail event belongs. This is available only
when opening Audit Trail from Electronic Signature table from position, device or
calibration result view.

3. All lists all audit trail events. Note that this setting might take long time to list the
audit trail events in big database.

The Audit Trail window toolbar contains the Archive sets button for opening the
Manage Archive Sets view. See Audit Trail Archiving.

The fields available for filtering are presented in the webhelp delivered with CMX.

items, dependent on the field that was changed, in the database. Changes

o Note: Making changes that are recorded in Audit Trail may affect other
in the dependent fields are not recorded in Audit Trail. Examples:

* A Function's span is changed from 100 mbar to 120 mbar. The change
is automatically recorded to Audit Trail. If the Function is calibrated in
three points (0 %, 50 % and 100 %), the original Calibration Points were
0 mbar, 50 mbar and 100 mbar. After the span change, the points are 0
mbar, 60 mbar and 120 mbar. The change of calibration points are not
recorded in Audit Trail.

* A Weighing Instrument's d/e values are edited. The change is
automatically recorded to Audit Trail. However, the change in d/e values
may affect the Maximum Permissible Error (MPE) limits. The possible
change is not recorded in Audit Trail.

If the same CMX database is contacted from several time zones, consider
setting the time format in CMX Settings windows' General Settings Fields
and Change Management Settings Fields in CMX webhelp to suit your
needs.
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Audit Trail Archiving

The Audit Trail Archive -functionality makes it possible to mark Audit Trail events
as archived. Archiving makes Audit Trail searches faster by hiding older Audit Trail
events.

The functionality has to be enabled in Tools > Settings > Change Management >
Audit Trail Archive.

Users with Audit Trail Archive Management modify permission can create and
unarchive the archive sets and can be prompted to create new archive sets based on
the settings.

Users with Audit Trail Archive Management view permission can open the Manage
Archive Sets view and select single archive set to see its audit trail rows.

Other users can use Audit Trail Archive filter to show or hide archived items.

Permitted users are notified about the need to create Audit Trail Archive set on CMX
startup or when Audit Trail window is opened. It is recommended to allow CMX to
create Audit Trail Archive sets.

Audit Trail Archive sets are sequentially created according to theArchive set length in
months setting value.

Note: Gaps between archive sets are NOT allowed. It could cause empty
o Audit Trail Archive sets, if no events exist in a certain period of time.

Manage Archive Sets Window

The Manage Archive Sets window can be opened from Audit Trail window's toolbar
Archive sets button.

This window lists existing Audit Trail Archive Sets.

Note: Archive Sets need to exist in sequential order without any gaps
0 between periods.

Content of an individual Archive Set can be viewed by selecting desired Archive Set
and pressing View archive set rows button. Audit Trail window containing Audit Trail
events in the selected Archive Set is opened.

If other than non-regular Archive Set needs to be created, it can be done by defining
Archive set period and pressing Create archive set button.

Last Archive Set can be unarchived by selecting latest Archive Set and pressing
Unarchive button. Note that only the latest Archive Set can be unarchived.
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Electronic Signature

If the Electronic Signature is activated, every time a change concerning Device,
Position or Calibration data is made to the database, a window opens where the
following fields are available:

+ Status. A list of status values is presented. The following values are pre-entered
in the database: Approved, Draft, Pending Second Approval, Reviewed and
Withdrawn. The list is editable so you may also add your own status values.

* Approved. The master approval check box. Only user with permissions to
approve may change this field.

» User ID and Password. The ID of the logged user is pre-entered, but any valid
User ID may be entered. Remember to utilize password security!

+ Use the same electronic signature for every position deletion. Optional
selection to use the same electronic signature for every position when deleting
plant node containing several underlying positions.

« Comment. Optional user comment for the signature being given, which is saved
together with the Electronic Signature.

This window will also open if the Electronic Signature for Calibrators is activated
and when changes concerning Calibrator or External Module data are made to the
database.

The Electronic Signature history of a Position, Device, Calibration, Calibrator or
External Module can be found in the last items in the Properties window. Use the
Sign button to change the status of the Device/Position/Calibration/Calibrator/
External Module.

Electronic Record

Electronic Record is the name used for the group of data that has been approved
with the Electronic Signature (see Electronic Signature). If anything that is part of
a certain Electronic Record is changed after it was signed, the data requires a new
approval using the Electronic Signature.

The following list describes what type of data belongs to the available Electronic
Records:

Table 16: Data in Electronic Records

Type Data belonging to the Electronic Record
Position Data shown in the following property windows:
» Position,

* Function and
* Procedure.




Change Management and Audit Trail - 128

Type Data belonging to the Electronic Record
Device Data shown in the following property windows:
* Device,

* Function and
* Procedure.

Calibration Data shown in the Calibration results property window.
Calibrators Data shown in the following property windows:
 Calibrator,

+ Calibrator Modules and
» Calibrator Module Ranges.

External Modules Data shown in the following property windows:

» External Module and
« External Module Ranges.

Signature Workflows

Enabling this feature will extend the current electronic signature functionality by
letting users create dynamic and temporary signature approval workflows and as
such require a set amount of target signatures before an instrument will be approved.

Entities that currently can be assigned a workflow are positions and/or devices with
their functions and procedures. Creating workflows for references such as calibrators
and external modules is currently not supported but may however indirectly be in
case the reference has been linked to a position.

When enabled, a workflow can be optionally created when signing a position or
device. When signing and creating a workflow, the entity will not be approved until it
is signed by someone assigned as the last step of the workflow.

Users that can be assigned to a workflow are those that both have access to the
instrument in question as well as belonging to any role with the new "Electronic
Signature-Workflow signing" permission.

An active workflow can only be signed by the user(s) targeted by its current step.
Rejecting a workflow can be done by anyone that is expected to sign the workflow or
by the user who created it as long as a comment is given.

Email notifications can be optionally enabled for workflow state changes, such as
when rejecting or proceeding to the next step. For more information on how to enable
messages for this event, see Messages Settings Fields.

Apart from enabling the 'Signature workflow' event, the target user(s) also need to
have a valid email address.
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Note: The last person signing an entity with an active workflow must also
belong to a role having the position or device approve permission as the
entity will after this last signature be marked as approved. CMX will indicate
whether the last user or users in a user group lack the require permission
but will still allow for creating such a workflow.




Calibrating Weighing Instruments -

Calibrating Weighing Instruments

Weighing Instrument Calibration feature is an optional feature in CMX Professional.

CMX's Weighing Instrument Calibration feature includes a possibility to add Weight
Sets and Weights as well as Weighing Instruments to be calibrated into CMX’s
database. Weighing Instruments can then be calibrated by using either the Manual
Entry window (see Manual Entry of Calibration Results) or by using bMobile.

CMX's Weighing Instrument Calibration feature is based on:

OIML International Recommendation OIML R 76-1: 2006 (OIML = Organization
Internationale de Métrologie Légale or International Organization of Legal
Metrology).

European standard EN45501:2015 + AC:1993.

NIST Handbook 44 — 2017 / 2.20. Scales (NIST = The National Institute of
Standards and Technology, US).

EURAMET cg-18, Version 4.0 (11/2015) Earlier: EA-10/18 EA Guidelines on the
calibration of non-automatic weighing instruments (EA = European co-operation
for accreditation).

U.S. Pharmacopeial Convention’s Chapter 41 (briefly USP 41). In USP 41,
repeatability is assessed by weighing one test weight 10 times. Details of pre-
USP 41 calculations and USP 41 calculations can be found in CMX Calculations,
available in CMX main window's Help menu.

European Pharmacopoeia supplement 10.6 (briefly Ph. Eur.). In Ph. Eur.,
repeatability is assessed by weighing one test weight 10 times. Sensitivity is
assessed in a separate test using a single test load with a mass of between 5
percent and 100 percent of the capacity of the balance.

Weighing Instruments are and how they are calibrated in general. This
document gives you help in how to do calibrations using CMX. To get
deeper Weighing Instrument information, read the documents presented
above and other Weighing Instruments related material.

0 Note: This document do not give an exhaustive presentation of what

This section presents Weighing Instrument Calibration specific information.
Where the functionality of CMX’s Weighing Instrument Calibration is similar
to other type of instruments and calibrators, this section refers to the more
general presentation elsewhere in this document.
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Basic Settings for Weighing Instruments

This chapter and its subchapters present basic settings specific for Weight Sets
and Weights. Subjects like creating a Plant Structure are not described here. This is
because Weighing Instrument Calibration does not affect it at all. See Basic Settings.

Entering Weight Sets and Weights

For CMX, Weight Sets, Weights and process instrument Calibrators are analogous in
the following way:

» A set of weights used for calibrating Weighing Instruments equals a calibrator used
for calibrating process instruments.

* A single weight equals a measurement module in a process instrument calibrator.

» Finally, the specifications of a weight equal a measurement range in the module of
a process instrument calibrator.

Only the fields that have a specific meaning for Weights and Weight Sets are
described in the following chapters. Equally important fields that have the same
meaning for weights and calibrators are not discussed here. For descriptions of other
fields, refer to section Description of Fields in the webhelp:

» Calibrator Fields,
« (Calibrator Module Fields and
+ Calibrator Module Range Fields.

Finally, the following chapters present a straight forward method of adding Weight
Sets, Weights and Weight Specifications. CMX’s flexible user interface allows you to
do the same thing using other views/windows too. Feel free to also experiment with
the other possibilities, but use this as the way to get into entering Weight Set, Weight
and Weight Specification data.

Weight Sets

To add a Weight Set, open the Calibrators window. Use the following menu
commands when you are in the Main Window: Database, Calibrators.

To add a Weight Set, click the mouse's secondary button anywhere in the
Calibrators tree structure. Select New, Calibrator (remember, a Weight Set is a
'Calibrator for Weighing Instruments').
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File Database Tools Help

i Mew 3¢ Delete | IEII Edit I-, Cancel H Save | a[]use | '_@I Help

m Properties
mﬁllc:alibratnrs -
Y Al calibratog |
Mew [ Calibrator...
T Madule..,
Delete
||

A window like the one below opens:

Calibrator Model [New v]
Calibrator S/ Beamex : MC4 pi
Beamex : MCH
| Azzet Mumber Beamex : MCE-I5 = I
Beamex : MCEHP ﬂ
Active Calibrator Beamex : MCG

Select the New option in the Calibrator Model combo or select an existing Weight
Set from the list if you are adding a new similar set. In the latter case, advance to
Adding 'New Calibrator' Data.

Adding a New Calibrator Model

Model T51

Manufacturer [Sartorius ']
Description

\weight Set

When adding a new Weight Set, enter the set’s name as the Model. Also, assure that
you check the Weight Set check box. Then CMX treats the new Calibrator Model as
a Weight Set, not a Process Instrument Calibrator.

Full field level information is available in the webhelp delivered with CMX.

When ready, press the OK key to return to the Add New Calibrator window.
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Adding 'New Calibrator' Data

When the Calibrator Model is entered/selected, add a serial number to the Weight
Set. The Serial Number field is a required field in CMX (together with the Calibrator
Model field they identify the Calibrator / Weight Set). If the weight set has no serial
number, enter its purchase date as a serial number.

Calibrator Model [iSartnrius S v]
Calibrator 5/M 15-Jun-2006
Asset Number

Full field level information is available in the webhelp delivered with CMX.

Weights

To add a Weight to a Weight Set, click the mouse's secondary button above the
Weight Set in the Calibrators window. The Calibrators window can be opened from
the Main Window’s Database menu. Select the Calibrators option. Select New,
Module (remember, a Weight is a 'Calibrator Module').

File Database Tools Help

|_n| New ¢ Delete | IEII Edit .-? Carcel H Save | a[]nse | .

Calibrators | Modules Properties | installed Modules |
m Al calibrators - Calibrator Model
@ Al calibratars Calibrator S/IN
'm' o Aoget Mumber

Mew k Calibrator...

Copy.. Module..,

—— Calibrated

T

Calibration Interval

A window like the one below opens:

Maodule Madel Iy -
Module S/N

Asset Number
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Select the New option in the Module Model combo or select an existing Weight from
the list if you are adding a new similar Weight. In the latter case, advance to Adding
‘New Calibrator Module' Data.

Adding a New Calibrator Module Model

Add new Calibrator module mode

Calibrator module model

Madel 1g
Manufacturer [ e i ]
Module Type [Weight "]

When adding a new Weight, enter it's weight as the Model. Also, assure that you
select Weight from the Module Type combo. Then CMX treats the new Calibrator
Module Model as a Weight, not a Process Instrument Calibrator Module.

Full field level information is available in the webhelp delivered with CMX.
When ready, press the OK key to return to the Add New Calibrator Module window.

Adding 'New Calibrator Module' Data

When the Calibrator Module Model is entered/selected, add a 'serial number' to the
Weight. The Serial Number field is a required field in CMX (together with the Module
Model field they identify the Module/Weight).

Add new Calibrator Modul

Module Model [1g -
Madule SN *TSq
Asset Number

Active Module

weight to the set it belongs to. If you have several weights with the same
nominal weight, include the identifying symbol (*) or number (1, 2 ...) to the
serial number.

0 Note: Enter the Weight Set name as the Serial Number. This 'ties' the

Full field level information is available in the webhelp delivered with CMX.

Weight Specifications

To add Weight Specifications to a Weight, click the mouse's secondary button above
the Weight in the Calibrators window. The Calibrators window can be opened from
the Main Window’s Database menu. Select the Calibrators option. Select New,
Module Range (remember, a Weight Specification is a “Calibrator Module Range”).
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File Database Tocls Help

|_n| Mew 3¢ Delete | IEII Edit EJ Cancel H Save | %Dnse | L3

Calibrators | Modules Properties |
(3 All calibrators - Manutacturer
@ Al calibrators Module Model
- @ 1g-TS1
- Aszet Number
New k Calibrator...
Delete Module...
Meodule Range...
[T

IH:“l—r:"'_:d-'

A window like the one below opens:

Add new Module Rang

Range Mame

Quantity

Method

Mominal Mass

Conventional Mass

Constant Error

Rel. Error (% of RDG)

Some important fields are highlighted in the picture above. Enter a Range Name and
set the Method field to “Keyed”. Enter both the Nominal and Conventional (“true”)
mass for the weight.

If you want CMX to calculate uncertainties, a Constant Error (the uncertainty of the
Conventional Mass or the Nominal Mass, depending on the instrument's Calibration
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Procedure settings) need to be entered and an Error Calculation Method need to

be selected.

Full field level information is available in the webhelp delivered with CMX.

Weighing Instrument Function Templates and Calibration

Procedures

CMX is shipped with pre-entered Function Templates and Calibration Procedures.
This makes it easy to create new Functions for Positions and Devices. There is also
a Function Template and Calibration Procedure suited for Weighing Instruments.
Select them when creating a Weighing Instrument Function and edit them to suit the
specifics of your Weighing Instrument.

The subchapters further on only present the Weighing Instrument specific fields.

Templates and Calibration Procedures using the Function Templates
utility presented in Basic Settings section. See Function Templates.
CMX automatically adds the Weighing Instrument specific fields if the new
Function’s Input/Output Quantity field is set to “Mass”.

o Note: You can also make you own Weighing Instrument Function

Function Fields Specific for Weighing Instruments

The table below presents the function fields specific for weighing instruments.

Table 17: Function Fields Specific for Weighing Instruments

Field Description
Partial Weighing | Select the amount of unique partial weighing ranges found in
Ranges the Weighing Instrument at hand.

Example of Partial Weighing Ranges:

A Weighing Instrument with a 100 gram span has two partial
weighing ranges.

* 0to 20 g with a 0.001 resolution and
* 20 to 100 g with a 0.01 resolution.

Required field for Weighing Instruments.
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Field Description

*d1 ... d4 Actual Scale Interval.
OIML R 76-1: 2006
the difference between the values corresponding to two
consecutive scalemarks, for analogue indication, or the
difference between two consecutive indicated values, for
digital indication.
This is the smallest change in mass that corresponds to a
change in displayed value. On analog (mechanical) scales,
this is the smallest subdivision of the scale dial or beam for
analog indication. Example:
A known weight of 12.0512 g is weighed on a scale with actual
scale interval 0.1 g. The reading will be 12.1 g.
Note that the 'Partial Weighing Ranges' setting determines the
amount of Actual Scale Intervals seen.
Required field(s) for Weighing Instruments.

el...ed Verification Scale Interval.

The 'Partial Weighing Ranges' setting determines the amount
of Verification Scale Intervals seen.

Required field(s) for Weighing Instruments.

The smallest scale interval that can be used to determine
price, when using a particular Weighing Instrument.
Verification Scale Interval need not be the same as Weighing
Instrument's Actual Scale Interval.

Note: Editing the Scale Intervals affect the MPE
0 values found among a Weighing Instrument's
Calibration Procedure data (see Calibration
Procedure Property Window Fields, CMX webhelp)
unless you are using a custom Accuracy Class.

Scale Range 1 ...

ScaleRange 4

Defines the Scale's Partial Weighing Range.

Visible only for Weighing Instruments with more than one
weighing range.

Required field(s) for Weighing Instruments.

ﬂ Note: Make sure both input and output methods are set to 'Keyed'.

Full field level information is available in the webhelp delivered with CMX.
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Calibration Procedure Fields Specific for Weighing Instruments

The table below presents the Calibration Procedure fields specific for weighing

instruments.

Table 18: Calibration Procedure Fields Specific for Weighing Instruments

Field

Description

Accuracy Class

Weighing Instruments are grouped according to the amount of
weighing ranges and actuall/verification scale divisions (d and
e). Accuracy Class determines the intended area of use for a
Weighing Instrument.

CMX presents a list of standard Weighing Instrument accuracy
classes and a possibility to make a customized accuracy
class. Available standard accuracy classes:

- HB44|

- HB441l

« HB44 1l

« HB 44 1l

 HB 44 lllIL

« OIMLI

 OIML Il

« OIML 1l

o OIML 1

HB 44: NIST Handbook 44: ‘Specifications, Tolerances and

Other Technical Requirements for a Weighing and Measuring
Devices’. Used in USA.

OIML: ‘International Recommendation OIML R 76-1’, 2006.
Used in Europe.

Note: Selecting a standard Accuracy Class
o affects the MPERange and MPE fields. New

MPE limits are calculated based on the Weighing

Instrument's Verification Scale Interval data found

among Function data. See Function Property

Window Fields, CMX webhelp.
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Field

Description

MPE Range

Maximum Permissible Error range(s) and their corresponding
Maximum Permissible Error (MPE). The amount of MPE
ranges depends on the selected Accuracy Class. Also note
that selecting a standard Accuracy Class automatically
defines the MPERanges. Edit the MPERanges and MPE
limits only when using custom Accuracy Classes.

Available error calculation methods:

* % of accuracy class limit
* % of load

» absolute error

Repeatability
Stdev. Limit

Maximum permissible standard deviation for repeatability test.
If field is left empty, repeatability test's standard deviation error
limit is not in use.

More info of CMX’s calculations can be found in a help file
entitled 'CMX Calculations'. Open it from CMX Main Windows'
Help menu. Select option CMX Calculations.

Note: This field is visible for Weighing instruments
o and enabled only when USP 41 / Ph. Eur.
Repeatability check box is unchecked.

Minimum Weight
Limit

Maximum permissible minimum weight deviation error limit.
Default value: 0.001

If the Minimum Weight Limit unit is changed to %, then the
default value is 0.1 %.

If you make a custom minimum weight test, make sure it
requires at least ten repeats. Otherwise this deviation error
calculation always fails.

If field is left empty, minimum weight test's error limit is not in
use and CMX indicates the test's status is "Passed".

More info of CMX’s calculations can be found in a help file
entitled "CMX Calculations".

Note: This field is visible for Weighing instruments
o and enabled only when USP 41 / Ph. Eur.
Repeatability check box is unchecked.
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Field

Description

Minimum Weight
k-value

Is the coverage factor in a Weighing instrument's Minimum
Weight Test.

Default value is 3, which is for 99 % confidence level (USP
requirement before USP 41).

Note: This field is visible for Weighing instruments
O and enabled only when USP 41 / Ph. Eur.
Repeatability check box is unchecked.

More info of CMX’s calculations can be found in a help file
entitled "CMX Calculations". Open it from CMX Main Windows'
Help menu. Select option CMX Calculations.

Repeatability
Limit

Replaces Minimum Weight Limit when USP 41 / Ph. Eur.
Repeatability is checked.

This is the pass/fail limit for USP 41 / Ph. Eur. Repeatability.
Default value: 0.0010.

If the Repeatability Limit unit is changed to %, then the default
value is 0.10 %.

Note that the trailing zero is significant.

Note: This field is visible for Weighing instruments
O and enabled only when USP 41 / Ph. Eur.
Repeatability check box is checked.

Repeatability k-
value

This field replaces Minimum Weight k-value when USP 41 /
Ph. Eur. Repeatability is checked.

The value of this field should be 2 (USP 41 requirement /
Ph. Eur. requirement).

Note: This field is visible for Weighing instruments
O and enabled only when USP 41 / Ph. Eur.

Repeatability check box is checked.

Repeatability
Accuracy Limit

Accuracy limit for the repeatability test.
Default value: 0.10 % of load

Needed when USP 41 / Ph. Eur. Repeatability is in use. (The
Sensitivity Test check box needs to be unchecked).

Visible for Weighing Instruments only (part of Weighing
Instrument Calibration feature).
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Field

Description

Sensitivity Limit

Sensitivity limit for the sensitivity test.
Default value: 0.05 % of load.

Note: This field is visible for Weighing instruments
o and enabled only when USP 41 / Ph. Eur.
Repeatability check box is checked.

USP 41/ Ph. Eur.
Repeatability

Checked if USP 41 / Ph. Eur. rules rules are enabled for
Repeatability test.

Default value: Not Checked.

Checking this field affects the following Calibration Procedure
fields:

* Repeatability Stdev. Limit is disabled
* Minimum Weight Limit changes to Repeatability Limit

* Minimum Weight k-value changes to Repeatability k-
value

* Repeatability Accuracy Limit is enabled
* Minimum Weight Test Calibration Points are hidden.

Note: Repeatability test also contains the
0 Accuracy Test according to USP 41.

Sensitivity Test

Can only be checked if USP 41 / Ph. Eur. Repeatability is
checked first.

Default value: Not Checked.

Checking this field affects the following Calibration Procedure
fields:

* Repeatability Accuracy Limit changes to Sensitivity
Limit
» Sensitivity Test Calibration points are shown.

Note: When Senstivity Test is enabled, the

0 Accuracy Test will not be used in the Repeatability
Test. The Sensitivity test is defined in the European
Pharmacopoeia standard.
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Field

Description

MPE in Service

Check if service error limits should be used.

Maximum permissible errors are doubled when service error
limits are used.

If MPE in Service field is checked, both error limits, 'normal’
limit and service error limit, are shown in graph in Manual
Entry, Result view, Certificates and in bMobile.

Hysteresis in
Uncertainty

Check if the found hysteresis of a Weighing Instrument is to be
included in uncertainty calculation.

Weight Mass

The mass value that is used when calibrating Weighing
Instruments.

Available options:

* Conventional Mass
 Nominal Mass

Note: This selection affects the calculations.
0 More of this in CMX's webhelp files.

See Calibrator Module Range Fields, CMX
webhelp:

* Nominal Mass
* Conventional Mass

» Constant Error

Eccentricity

How the found eccentricity should be included in uncertainty

Uncertainty calculation.

Available options:

* Full Value

* Half Value

* Not Included
Uncert. at No How uncertainty at no load point is calculated.
Load Point

Available options:

» As with other loads (default value)

* No Load resolution (uncertainty only)

+ Zero

More info of uncertainty calculation in a help file entitled 'CMX

Calculations'. Open it from CMX Main Windows' Help menu.
Select option CMX Calculations.
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Field

Description

No Load Resol.
Uncert.

How the no load resolution uncertainty is calculated.
Available options:

» d0/(2*sqrt(3)) (default value)

» d0/(4*sqrt(3))

More info of uncertainty calculation in a help file entitled 'CMX
Calculations'.

Eccentricity Test
Calibration Points

In how many points the Eccentricity test is done. Select a
value from the combo box. CMX updates the table below
accordingly and shows a picture of the eccentricity test points.

Repeatability Test
Calibration Points

How many repeats are done in the Repeatability test and what
mass is used in the test.

When USP 41 Repeatability Test check box is checked:

The amount of similar Repeatability Test Calibration Points
needs to be at least 10. They need to be between 5% and
100% of the balance capacity. If the points are not correct then
an instructional error message is shown and the procedure
cannot be saved before the test points are correct.

Weighing Test
Calibration Points

Calibration Points to be used in the actual weighing test
(linearity test). Select one from the list.

Minimum Weight
Test Calibration
Points

Select how many minimum weight test repeats are done and
what mass is used for in test (percentage of full scale).

To get minimum weight deviation calculation results, at least
10 repeats is needed.

Note that this table of Calibration Points is visible for Weighing
instruments only when USP 41 Repeatability Test check box
is unchecked.

Full field level information is available in the webhelp delivered with CMX.

Adding Weighing Instruments to the
Instrument Database

Weighing Instrument Calibration feature is an optional feature in CMX Professional.

Adding Weighing Instruments to CMX is done just as any other instrument.
Remember to select a Function Type meant for Weighing Instruments when adding
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the Function(s). The fields unique for Weighing Instruments are presented in the two
previous chapters. See:

* Function Fields Specific for Weighing Instruments

» Calibration Procedure Fields Specific for Weighing Instruments

General presentation of adding instruments is in Adding Instruments to the Database.

Templates and Calibration Procedures using the Function Templates
utility. See Function Templates. CMX automatically adds the Weighing
Instrument specific fields if the new Function’s Input/Output Quantity field
is set to “Mass”.

o Note: You can also make you own Weighing Instrument Function

Weighing Instruments Calibration

Weighing Instrument Calibration feature is an optional feature in CMX Professional.

Calibrating Weighing Instruments requires good knowledge of Weighing Instrument
Calibration practises. CMX gives you tools to document the calibration, but does not
offer full Weighing Instrument Calibration theory. One of the following subchapters
does however offer some basic terminology for the uninitiated.

Terminology

This section presents some Weighing Instrument Calibration related keywords. The
focus is on the different types of calibrations that are part of Weighing Instrument
Calibrations. The descriptions are based on the standard mentioned in the beginning
of this section and 'EA-10/18 EA Guidelines on the calibration of non-automatic
weighing instruments' .

(EA = European co-operation for accreditation).

Eccentricity Test

The test consists of placing a test load in different positions on the load receptor in
such a manner that the centre of gravity of the load takes positions indicated in the
adjacent picture.
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Figure 23: Eccentricity Test

The test load should not be below 10 % of full scale. Otherwise the uncertainty
component of the eccentricity test may be too large for uncertainties close to full
scale.

Repeatability Test

The test searches the difference between the results of several weighings of the
same load. The conditions should, as far as possible, be identical. This applies to the
handling of the load and the instrument as well as environmental conditions.

U.S. Pharmacopeial Convention’s Chapter 41 (briefly USP 41) and European
Pharmacopoeia supplement 10.6 (briefly Ph. Eur.) define a new procedure for doing
the repeatability and minimum weight tests. CMX supports calculating both the old
Repeatability and Minimum Weight tests and the new test according to USP 41 / Ph.
Eur. The standard to be used can be defined in Weighing Instrument's Calibration
Procedure. When USP 41 / Ph. Eur. Repeatability is enabled, the Repeatability test
also includes an Accuracy Test as defined in USP 41.

Weighing Test

This test is performed with at least five different test loads distributed fairly evenly
over the normal weighing range. The purpose of this test is an appraisal of the
performance of the instrument over the whole weighing range.

For people more familiar with calibrating process instruments, this test equals the
typical “up/down” calibration of a process instrument.

Minimum Weight Test

Minimum weight test (also known as: Minimum Weighing Capability Test) determines
the smallest weight the Weighing Instrument is able to detect. This test is based on
USP's (United States Pharmacopeial Convention) definition of Minimum Sample
Weight.

See also Repeatability Test above.

Sensitivity Test

The sensitivity test assesses the parameter that most significantly influences the
accuracy of the balance. The sensitivity deviation increases with the load, and thus
is more significant in the upper part of the weighing range. Sensitivity is assessed
using a single test load with a mass of between 5 percent and 100 percent of the
capacity of the balance. The Sensitivity Test is defined in European Pharmacopoeia
supplement 10.6.
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The Sensitivity Test can only be used when USP 41 / Ph. Eur. Repeatability is
enabled. When the Sensitivity test is enabled, the Repeatability test will not include
the Accuracy Test.

Sending Weighing Instruments to Manual Entry Window or
to bMobile

Sending Weighing Instruments to the Manual Entry window or to bMobile is done
as any other kind of instruments. Similarly, receiving the results do not require any
special duties. Just do it as you have done for other kind of instruments.

For more information of selecting/sending, see Selecting Functions for Manual Entry
and Sending Instruments etc. to bMobile.

Eccentricity, Repeatability, and Weighing tests. You may however do

o Note: You can do one As Found test and one As Left test for
several As Found and As Left Minimum Weight tests.

After the first As Left test is saved, you may only do As Left tests.

Using

Manual Entry

When entering calibration data of a Weighing Instrument, the Manual Entry window’s
result table adapts to the needs of Weighing Instrument Calibration.

Select the type of calibration from the list on the left. Then enter the results in the
grid shown on the Results tab. Columns with a gray background are read-only data.
Depending on your Calibration settings, you may have to select a Weight Set and
Weight(s) used in the calibration. More about this in Calibration Settings.

Also check the Calibration Date field and the Calibrated By fields shown in

the same tab. You can select one or two users as the ones that carried out the
calibration. Additionally, if a calibration certificate number is not automatically created,
a field for adding the certificate number is shown. Whether the certificate number is
automatically set by CMX or not, is part of CMX’s configuration options. More of this
in Certificate Settings.

Enter calibration related data (e.g. the environment temperature) into the Conditions
tab.

The Procedure tab contains read-only data about the calibration procedure,
including possible instructions to guide you through the calibration.

Full field level information is available in the webhelp delivered with CMX.
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Maintenance Inspection

Maintenance Inspection is an optional feature in CMX Professional.

The CMX Maintenance Inspection feature enables the planning, execution, and
digital documentation of various maintenance inspection activities. Checklists are
created, maintained and scheduled in CMX, then executed and documented through
the Beamex bMobile Calibration Application. Once complete, results are received in
CMX for analysis and reporting.

Checklists can be added to the database like any other instrument, with the Input
Quantity CHECKLIST. The checklist procedure differs from standard instrument
calibration procedures since there are no calibration points. The procedure for
checklist includes checks that can either pass or fail.

Maintenance Inspection in CMX

All Checklist definitions are done in CMX. The following subchapters present how the
Checklists are defined.

Function

Hazardous area inspections are a typical use case for maintenance inspections.

To support these tasks, function templates according to standard IEC 60079-17
Explosive atmospheres - Part 17: Electrical installations inspection and maintenance,
Tables 1 and 2 are provided. Additionally, a fully customizable template is available.

CMX has the following function templates for checklists:
» Checklist, includes a fully customizable Checklist with three pre-entered checklist
items.

* Checklist, IEC60079-17, Table 1. A checklist based on IEC 60079-17 Table 1 —
Inspection schedule for Ex “d”, Ex “e”, Ex “n” and Ex “t/td” installations.

* Checklist, IEC60079-17, Table 2. A checklist based on IEC 60079-17 Table 2 —
Inspection schedule for Ex “I” installations
The predefined templates can be customized if needed.

The function templates have Input Quantity CHECKLIST. There is no Output for
checklists.
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Procedure

The checklist procedure can contain an unlimited number of checklist items. Each
item has an ID and description detailing the inspection to be executed. WWhen using
the IEC60079-17 templates, the description aligns with the inspections defined by
this standard.

The result for each checklist item is recorded as Passed, Failed, or Skipped. The
"Require Result Note" setting specifies whether a note is required for checklist items
marked as Passed, Failed and/or Skipped. It is possible to specify that skipping
points is not allowed.

Checklist items can also be organized into groups, which is convenient for long
checklists.

The picture shows a checklist with three checklist items in a single group (Group 1).
Buttons allow for sorting, adding, and deleting checklist items and groups.

Check List Description Check List's Description <
Reguire Result Note [] Passed [ Failed [ Skipped
Add Check List Group &2
Groupl (&) @& 183 &Y
D Checklist item 1 ege
Description |Descrfpn’on of item 1
D Checklist item 2 ege
Description |Descrfpn’or} of item 2
D Checklist item 3 ege
Description |Descrfpn’on of item 3

Figure 24: Checklist

Sending Instruments etc. to bMobile

To send instruments to a device with bMobile installed, first connect bMobile to a
CWSI server.

Open the Send to Calibrator window and select CWSI or Sync as the protocol.
Follow the instruction provided in bMobile's help. Send procedure is similar to
sending any other instrument to a calibrator.

0 Note: bMobile can be used with only one CMX database at a time.
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Execution with bMobile

After configuring the checklist in CMX, send it to bMobile for execution. The sending
procedure is like sending any other instrument to bMobile; for more information, refer
to Sending Instruments for Calibration.

bMobile runs through the checks as configured in CMX. At the end of the execution,
master pass/fail status for the checklist must be given. For more details on executing
checklists, refer to the bMobile documentation.

# Beamex bMobile 2 - ] X

32 0,

FFFFFF

Figure 25: bMobile Execution

# Beamex bMobile 2 - [m] X

AILS
Checklist, IEC60079-17, Table 2 n
OVERALL

sssssss

ENVIRONMENT

VERDICT
v

Figure 26: Pass/Fail Status

Once completed, the results are sent back to CMX. The receiving procedure is
similar to receiving any other instrument in CMX; for more information, refer to
Receiving Calibration Result Data.
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Receiving Results from bMobile

Open the Receive from Calibrator window and select CWSI as the Protocol

or by pressing Sync you open the list of calibration results that are ready to be
synchronized back to CMX. The receive procedure is similar to receiving any other
instrument from a calibrator. In this case, the bMobile is the 'calibrator' and the
Checklist is the 'instrument'.

o Note: bMobile can be used with only one CMX database at a time.

Checklist Results

The result view displays a status summary for checklist items, as well as a master
pass/fail status. Each checklist item shows its result and includes a Result Note if one
has been added.

= (===
¥ Delete | lEE Edit | f>, Close | @ Help
Position 1D 101DR-PI0014 Description Checklist for 101DR-PI0014. IEC60073-17. Table 2
Device ID Pl0D43
Function Name Checklist, IECE0073-17, Table 2
Valid Result ]
Certificate Number BX-10491-CAL
Position Work Order Number 11052000 - 034
Due Date
10.5.201613.33.45 Clark Kent @ Passed: 30 €3 Failed: 1 (&) Skipped: 1 PASSED
EQUIPMENT
o} Al
Description |Circuit and/or equipment documentation is appropriste to the EPL/Zone
Result o Passed
D AZ
Description |Eq|_npmerrt installed is that specified in the documentation
Result o Passed

Figure 27: Checklist Results

Certificates and reports can be printed for checklists like for any other instrument in
CMX. The certificate is called “Inspection certificate” instead of calibration certificate.
If groups were defined for checklist items, the results are shown in groups.

Checklist Reports

Reports for checklists include instrument data as presented in regular certificates.
The checklist results are shown below the instrument data in table format.
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Work Order Handling

Enhanced Work Order Handling is an optional feature in CMX Professional. It should
also be enabled in CMX database via Work Order Settings Fields, CMX webhelp.

Enhanced Work Order Handling is a tool available in CMX. To fully utilize it, an ERP
(Enterprise Resource Planning) or CMMS (Computerized Maintenance Management
System) software together with Beamex Business Bridge software should be part of
the system. The latter does the communication between the ERP/CMMS and CMX.

General

Enhanced Work Order Handling eliminates retyping calibration data/information to
the ERP/CMMS software. Business Bridge takes care of transferring information
between CMX and ERP/CMMS software.

CMX's Basic Work Order Handling

CMX has had, even from the beginning, basic non-optional work order handling for
Positions. You can manually enter a work order to a Position.

However, with basic work order handling, there is no possibility to automatically reply
from CMX back to the ERP/CMMS software. When the calibration/calibrations are
done, the Work order has to be manually set to "Done" in the ERP/CMMS software.

CMX's Enhanced Work Order Handling

CMX's Enhanced Work Order Handling option makes CMX's work order handling
more useful, especially when working with CMX in conjunction with the ERP/

CMMS software. Business Bridge software provides a transfer channel for sharing
instrument, work order and basic calibration data between CMX and the ERP/CMMS
software.

When CMX's Enhanced Work Order Handling option is active, the following fields are
shown among instrument's Calibration Procedure data:

* Work Order Number

* Work Order State

* Work Order Start Date
* Work Order End Date
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See also Work Order related fields, CMX webhelp.
Work Order State field has six possible states:

* Empty, (Currently no work order assigned),
* Open, (Work order assigned, but not calibrated, yet),
* In Progress, (Work order calibrated, but not completed, yet),

* Pending Second Approval, (Work order calibrated and approved, but one or
more calibrations require a second approval),

* Done, (Work order completed),

* Force Complete, (Work order force completed),

» Cancelled, (Work order cancelled),

* Failed, (Failed to return work order to ERP/CMMS).

Work Order Flow

Business Bridge and CMX change the Work Order State automatically based on
information from ERP/CMMS software and CMX:

* When a Work Order is entered into ERP/CMMS software, Business Bridge
communicates the Work Order Number, Work Order Start Date and Work
Order End Date.

Additionally: the Work Order State is set to Open in CMX.

+ CMX fields included in Work Order message are locked in CMX side for editing.
See Work Order Related Fields.

* When a calibration for a work order is saved in CMX, the state is changed to In
Progress.

* Depending on settings in the Settings window's Work Order page, the state is
changed to Done either manually or automatically in CMX. See Changes in CMX
User Interface.

o The procedure work order status may change to Pending Second Approval
in case a calibration result has been automatically invalidated. See Automatic
Result Validation and Automatic Result Validation with Work Order for more
information.

o The procedure work order status is set to Done only when all calibrations after
the work order was issued have been approved and when work order trigger
level is “Approved”. This includes results that have been manually marked
invalid.

* When a calibration is completed or canceled in CMX, Business Bridge
communicates state Done or Cancel to ERP/CMMS software, then automatically
sets the Work Order State in CMX to Empty and clears the Work Order Number,
Work Order Start Date and Work Order End Date fields.
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* When needed, the Work Order State can be manually changed in CMX to Cancel
from the pop-up menu available in Work Orders Tree view or with Cancel button
on Calibration Procedure page. See also Changes in CMX User Interface.

i

Note: The Work Order Number sent from ERP/CMMS is always located
in a Procedure's Work Order Number field. Depending on your Business
Bridge settings, it can also be located in a Position's Work Order Number
field.

Free Devices do not have a Work Order Number field on their Device
page. If you want to see the Work Order Number in the Device page,
consult Beamex's support. Remember that the Work Order Number is
always shown on free Device's Procedure page.

If a work order message from an ERP/CMMS software contains both the
Position ID and the Function abbreviation, only the matching Function's
Calibration Procedure will receive the Work Order.

If a work order message from an ERP/CMMS software contains the
Position ID only, Position's all Functions / Calibration Procedures will
receive the Work Order.

Work Order Start Date and Work Order End Date are not mandatory
fields. Those fields can also be empty.

» If Work Order Start Date is included in a work order message, only
calibrations made after this date are taken in account.

deleted if it or any underlying item is checked out or a related

O Note: Plant node, Position, Function or Procedure cannot be
Work order status is other than Open.

Multiple Work Orders

It is possible to create more than one work order with different work order number for
a CMX instrument. Business Bridge can be configured to define in which order the
work orders are handled in CMX. Available orders are:

FIFO - First In First Out.
LIFO - Last In First Out.

Work order data is displayed in the different views according to the active work order,
unless the view is opened from within the Work order tree. When the active work
order is completed and returned to ERP/CMMS system, next work order from the list
becomes active.

Work order tree view shows all work orders. From there any work order can be
separately calibrated at any time.
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Work Order Related Fields

When CMX receives work order from ERP/CMMS it may also contain data for other
fields, which are then related to that work order. CMX shows data for these fields
from currently active work order. The original data of these fields is kept in CMX and
will be available again when instrument no more contains any work order.

Fields included in work order message can be configured via Business Bridge
software schema. Following fields can be defined via work order message:

* Position, Device and Procedure Free text fields
» Position, Device and Procedure Free checkbox fields
* Procedure fields:

o Calibration Interval and interval unit
o Calibation Due Date

o Before Note

o Adjust Note

o After Note

Filtering Work Order Related Data

Filtering (including the “due within” and “due for calibration”) using any of the work
order related fields will check the active work order's data of a position or device. The
equivalent position, device or procedure field is checked if the data in the active work
order is empty.

Active work order depends on FIFO/LIFO setting, see Work Order Flow.

When work order is completed, returned back to ERP/CMMS system and position/
device does not contain any work order, CMX base data is used in CMX filtering.

See work order related fields in Work Order Related Fields.

Changes in CMX User Interface

When Enhanced Work Order Handling is Active, CMX's main window includes an
additional tab beside the Position tree and the Plant Structure tree: Work Orders
tree. It lists all existing work orders in the CMX database. Above the work order tree
list it is possible to enter search rules to find specific work order numbers.

Any work order on the list can be cancelled via Context Menu (pop-up menu) on
Work Order level. Select Work Order and Cancel Work Order

» Cancel Work Order sets a Work Order State to "Cancelled".
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Calibration procedure page contains following buttons:

» Complete button sets work order state to Done. It can be used, when work order
completion is manual and work order is in In Progress state. Note that work order
completion rules needs to be fulfilled, otherwise an error message will be shown.

* Force Complete button is only active when certain conditions are met, see Force
Complete of a Work Order for a more detailed description. This button sets the
Work Order state to "Force Complete".

+ Cancel button sets the Work Order State to "Cancelled".

Note: A Work Order item in the Work Orders tree has no property data. It
0 is a virtual element in the tree structure.

Remember to Cancel/Complete all Functions/Procedures belonging to the
Work Order. Otherwise, Business Bridge will not forward the data to ERP/
CMMS.

CMX Work Order Settings

In CMX's main window, select Tools, Settings, Work Order Settings to edit
Enhanced Work Order Handling options.

The following options are part of Enhanced Work Order Handling:

+ Enhanced Work Order Handling enables/disables the Enhanced Work Order
Handling feature in CMX.

* Automatically Update Work Order State

When checked and when all Work Order related calibrations are done/approved,
CMX changes Work Order State to "Done". Then Business Bridge software sends
the Work Order State to ERP/CMMS software.

* Work Order State change is allowed when calibration is

This is read only information received from Business Bridge software. Available
options:

o Saved. CMX sets the Work Order State to "Done" when all required
calibrations are saved.

o Approved. CMX sets the Work Order State to "Done" when all required
calibrations are saved and approved in CMX.
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* Work Order Sequency Policy

This is read only information received from Business Bridge software. Available
options:

o First In-First Out (FIFO). CMX handles work orders in order. The work order
that came first stays active until it is completed/cancelled. Once completed/
cencelled, next WO becomes active, with relevant information and can be
completed/cancelled until whole WO queue is empty.

o Last In-First Out (LIFO). CMX handles received work orders in reversed order.
Latest received Work Order becomes active in Calibration Procedure and can
be completed or cancelled. Once completed/cancelled, previous WO becomes
active, with relevant information and can be completed/cancelled until whole
WO queue is empty.

 Work Order Saved in Device Level Field

This is read only information received from Business Bridge software. It defines
Device Free field, which contains work order number.

Calibration Using Enhanced Work Order
Handling

When calibrations are done using Enhanced Work Order Handling, everything
starts from your ERP/CMMS software. The work order is created in the ERP/CMMS
software, transferred to CMX using Business Bridge software.

The actual calibrations are done just as always, nothing new there. The Work Order
State changes according to CMX's settings:

+ If the Work Order State is set to be automatically updated, the state is set to
'Done’.
 If the Work Order State is set to be manually updated, a dialog opens when the

calibrations are saved/approved asking whether the state should be changed to
'Done’.

Then Business Bridge transfers data to your ERP/CMMS software, specifying the
work order is done.

allow you to change the Work Order State, when necessary. See Changes

O Note: The pop-up menu on Work Orders tree and procedure page buttons
in CMX User Interface.
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Special Situations

This chapter presents Enhanced Work Order related special situations.

Cancelling a Work Order in CMX

Sometimes there is a need to cancel a calibration. This can be done in CMX using
the pop-up menu or Cancel button presented in Changes in CMX User Interface.

If an instrument has already been calibrated, you can still cancel it, provided the full
work order is not yet set to 'Done'. Then Business Bridge communicates the value
'‘Aborted', for that particular instrument, to ERP/CMMS software.

Emergency Calibration

An emergency calibration means that there is an acute need to calibrate an
instrument but there is no time or no means to create a work order in the ERP/CMMS
software first. CMX supports emergency calibrations as follows:

* Do the calibration normally and save the results in CMX's database.

» Afterwards, in ERP/CMMS software:

Create a Work Order Number and set the Work Order Start Date to a date prior
to the moment the emergency calibration was performed. Send the work order to
CMX.

+ A person with Calibration - Modify permission edits the instrument's results to
add the Work Order Number sent from ERP/CMMS software to the calibrated
instrument's Calibration Result page.

* Depending on Work Order State's update settings in CMX, the state is either set to
"Done" automatically or CMX asks you whether to update the state or not.

» When the Work Order State is "Done", Business Bridge communicates the Work
Order Number and the Work Order State "Done" to the ERP/CMMS software.

This allows doing emergency calibrations without a pre-made work order.
However, the work order state will still be included afterwards to ERP/CMMS
software just as for "normal” calibrations.

0 Note: Emergency calibration of free devices is not supported.
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Work Order Synchronization when Linking a Device

When position and device is unlinked or linked and position or device contains
existing work order, the work order is synchronized as follows:

* Unlinking a device from a position having an open work order will also unlink the
work order from the device and its procedure(s).

+ Linking a device when the position doesn't contain any work orders, but the device
does, will link the device's work orders to the position.

« Linking a device when the position contains work orders, but the device doesn't,
will link the position's work orders to the device.

* Linking a device when both the position and the device contains own work orders
is not allowed.

Work Order during Calibration Procedure Activation
Change

When calibration procedure activation is changed and position or device contains
assigned work order, the work order is handled as follows:

 If a calibration procedure is deactivated when having an open work order, then
work order information is removed from the particular calibration procedure.

 If a calibration procedure is activated when having an open work order, then work
order information is copied to the particular calibration procedure.

* A position/Device must have at least one active calibration procedure with Work
Order information to enable completion.

Force Complete of a Work Order

Sometimes there is a need to force complete a work order. A common situation
where Business Bridge cannot process the work order according to the normal \Work
Order Flow, is when a backdated calibration result is saved for the work order to
CMX, and the Work Order Start Date was not set during the work order import. In
this context, backdated calibration denotes that the calibration event was performed
on the previous day or earlier.

This can be done in CMX using the Force complete button when it is visible in the
CMX User Interface, either on calibration procedure level or as a menu item in the
Work Order tree view. User permission Work Order - Force Complete is required to
perform this action. The work order is possible to force complete if an instrument has
already been calibrated and there is at least one calibration event that contains the
Work Order Number that matches the work order that is in progress.
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Automatic Result Validation with Work
Order

If enabled, approving calibration result triggers the automatic result validation. In case
a validation rule invalidates the result that is being approved, it is signed by CMX as
'Pending Second Approval'.

In the above use case, if the instrument has an active work order and work order
trigger rule APPROVED is used, the procedure's work order status will also change
to 'Pending Second Approval'. When all calibrations related to the work order have
been approved, having required second approval or not, the work order is or can be
marked as 'Done'.

If work orders are used with Business Bridge, it is strongly recommended to set the
work order trigger rule to APPROVED when enabling the automatic result validation.
For example, if the work order trigger rule in the use case above would have been set
to SAVED, then the work order could have been marked as 'Done' before the related
calibration(s) has/have been given the second approval. This all depends on whether
the Enhanced Work Order Handling option and/or Automatically Update Work Order
State settings are enabled.
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Mobile Security Plus

Mobile Security Plus is optional in CMX Professional.

Data integrity has become a focal point in Pharmaceutical industry. Both, MHRA and
FDA have published their own guidance document for the subject:

* MHRA: GMP Data Integrity Definitions and Guidance for Industry (March 2015)
* FDA: Data Integrity and Compliance With CGMP Guidance for Industry (April
2016, Draft)

Beamex's Mobile Security Plus is an optional tool in CMX, giving answers to
problems presented in the documents mentioned above.

In addition to CMX Mobile Security Plus is supported in modern Beamex calibrators
and other Mobile Devices as follows:

« MC6 Advanced Field Calibrator and Communicator, from firmware version 1.80
onwards.

* MC6-WS Advance Workshop Calibrator and Communicator, from firmware version
1.80 onwards.

* MC6-Ex Intrinsically Safe Advanced Field Calibrator and Communicator, from
firmware version 3.00 onwards.

bMobile A software available in Windows® 10 or 11, Android® with operating
system version 7.0 or later or iOS with operating system version iOS 13, iPadOS
13 or later.

Terminology

Mobile Security Plus option terms are defined in the table below.

Table 19: Terminology

Term Description

Mobile User A CMX user that also uses any of the Mobile Devices
listed in previous chapter.

When Mobile Security Plus is active, CMX users
defined as Mobile Users are the only ones allowed to
calibrate instruments in supported Mobile Devices.

When Mobile Security Plus is not active, but CMX is
configured to Allow defining Mobile Users, CMX sends
only Mobile Users to Mobile Devices.

More details in Users and Permissions Window.



https://www.gov.uk/government/uploads/system/uploads/attachment_data/file/412735/Data_integrity_definitions_and_guidance_v2.pdf
http://www.fda.gov/downloads/drugs/guidancecomplianceregulatoryinformation/guidances/ucm495891.pdf
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Term Description

Mobile Supervisor When Mobile Security Plus is active and a Mobile
User may also be defined as a Mobile Supervisor, e.g.
allowed to change date and time of a Mobile Device.

Note that a Mobile supervisor must also be defined as
a Mobile User.

More details in Users and Permissions Window.

Mobile Password When Mobile Security Plus is active and a when

a CMX user is also defined as a Mobile User, a
Mobile Password is also defined. Note that the Mobile
Password is separate from the CMX user's password.

More details, including supported characters, in
Settings Window.

Mobile Security Plus Option in CMX

The following chapters present Mobile Security Plus related settings etc. in CMX.
Note that the things presented here are not the full settings available in CMX. This is
a collection of items that may be useful when taking Mobile Security Plus in use.

Caution: Before activating Mobile Security Plus in CMX, ensure that all
existing calibration results on all mobile devices (MCB6, tablet etc.) are
received to CMX.

Settings Window

To activate Mobile Security Plus option, open Tools menu on CMX's Main Window
and select Settings.

In General Settings (the page that opens first) is a check box labelled Mobile
Security Plus. It activates Mobile Security Plus Page.

Note: If the check box is disabled, your CMX does not include Mobile
0 Security Plus option.

When Mobile Security Plus is activated, a Mobile Security icon is visible in the list of
icons/subjects shown on the left side of the Settings window. Select the icon to open
Mobile Security page.
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The following settings are available:

+ Password Required. This allows you to activate a Mobile Password. This
password is asked when utilizing supported Mobile Devices. When a CMX user
has been defined as a Mobile User and a Mobile Password is required, the first
time user logs into CMX, he/she can enter a Mobile Password. The allowed
characters are listed below. The password is saved in CMX's database. See also
notes below.

When utilizing this feature, the user has to be defined as a Mobile User in CMX.
See Users and Permissions Window.

* Minimum Password Length. When Mobile Password is required, you may define
the minimum password length here.

+ Password Change Interval (days). Here you may define how often the Mobile
Password should be changed.

+ Warn before password expires (days). Time period for warning that the Mobile
Password should soon be changed.

* Number of previous passwords not accepted. How many of the previous
passwords are refused when changing the Mobile Password.

0 = no check for previous passwords.

* lllegal Login Attempts. How many illegal attempts (i.e. wrong password entered)
are allowed before Mobile User is locked from the Mobile Device. See also notes
below.

+ Enforce Password Complexity. When checked, the Mobile User's password has
to include at least one of all the character groups presented below.

Supported characters for Mobile Passwords:

Table 20: Supported characters for Mobile Passwords

Character Group Description

Upper Case ABCDEFGHIJKLMNOPQRSTUVWXYZ
Lower Case abcdefghijkimnopqgrstuvwxyz

Numbers 1234567890

Special Characters @'-"#S%&()*,./; 2\ {}~+<=>

Calibration related settings in CMX's Mobile Security page
These settings are sent to Mobile Device when connecting to CMX:

* Do not allow instrument to be deleted until all results are received for an
instrument. Instrument may not be deleted from Mobile Device's memory before
they are received to CMX.

* Restrictions for undo and result deletion on mobile devices. A setting for
defining what are the restrictions when trying to undo a calibration point and
deleting results in Mobile Device.
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+ User ID selection. A setting for defining how user is identified in Mobile Device.

MC6 Family Calibrator related settings in CMX's Mobile Security page

* Required firmware version. A list of firmware versions supporting Mobile Security
Plus in MC6 family calibrators.

* Require Mobile Security Option. Check this item to require that the MC6 family
calibrator communicating with CMX must include Mobile Security Plus option.
Devices not Supporting Mobile Security settings in CMX's Mobile Security page

» Disable communication. Check this to prevent communication with calibrators
that do not include Mobile Security Plus.

Note: A description of available options related to Mobile Security is
0 available in the webhelp delivered with CMX.

Mobile Users must enter their Mobile Password in CMX before sending
instruments for calibration to a Mobile Device.

Mobile Password can be entered/changed while working with CMX. In
CMX's main window, do the following menu commands: Tools, Security,
Change Mobile Password.

If a Mobile User's account has been locked in a Mobile Device, e.g. after
too many illegal attempts, the account can be re-activated by synchronizing
the Mobile Device with CMX.

When Mobile Security Plus is in use, Use Electronic Signature ID as
Calibrated By ID field in Change Management Settings Fields, CMX
webhelp is disabled.

Calibration Settings Page

Some of Calibration Settings are useful to keep in mind when using Mobile Security
Plus:

+ Add Database Name as 1st Plant Path Level. This setting is of use if several
CMX databases are in use, e.g. each plant has their own CMX database. Then
when sending instruments to a supported Mobile Device, it is possible to identify
instrument's source.

* Deny Skipping Points. When checked, calibrator technician may not skip a
calibration point.

* Require a Note for Skipped/Abnormal Points. \When checked, calibrator
technician need to write a comment for all skipped calibration points.

Users and Permissions Window

Open Users window by doing following menu commands in CMX's main window:
Tools, Security, Users.
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In User Properties

User properties include two Mobile Security Plus/Mobile User related check boxes:

* Mobile User. When checked, CMX User also uses the Mobile Devices supporting

Mobile Security Plus. If Mobile Security Plus is not part of your CMX or it is
deactivated, this setting is obsolete.

A Mobile User may not perform certain actions in a Mobile Device, e.g.
deleting calibration results. The restrictions depend on settings done by Mobile
Supervisor(s).

If CMX is configured to Allow defining Mobile Users, Users can be defined as
Mobile User. List of Mobile Users is then sent to Mobile Devices.

* Mobile Supervisor. If checked, a Mobile User also has supervisor rights. It allows

the supervisor to define functionality restrictions for ordinary Mobile Users, e.g.
deleting instruments with calibration results.

The available functionality restrictions depend on the Mobile Device at hand. Refer

to its own manual for details on what can be restricted.

Note that a Mobile Supervisor has no Supervisor rights in CMX, unless he/she is
also a CMX Supervisor.

A Mobile Password may be set for Mobile Users in CMX;, if Mobile Security Plus is
activated. Open main window's Tools menu and from there Security and Change
Mobile Password. See also Settings Window to get acquainted with Password
related settings.

Note: At the Users window's bottom left corner is a check box: Show
O only mobile users. When checked, all non-Mobile Users are temporarily
hidden.

Permissions

The Permissions tab of User Groups has new Mobile Security Plus related items.
Some of them are visible only when Mobile Security Plus option is included in your
CMX:

» Calibration - Lock. Permission to lock approved calibration results so no further
edit is allowed. More of locking and unlocking results in Locking Calibration
Results.

+ Calibration - Unlock. Permission to unlock previously locked calibration results
making it possible to edit the results.
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+ Manual Entry — Calibration time edit. Allowed by default, but with this setting
you may restrict certain User Groups from changing calibration date when doing
calibration using Manual Entry, see table below.

Mobile User User group has Expected resulit
security plus "Calibration time (calibration time
license option edit" permission editing possible)

OFF Normal - Yes
ON Normal/mobile No No
ON Normal/mobile Yes Yes
ON CMX supervisor No Yes
ON Mobile supervisor No No
ON Mobile supervisor Yes Yes

» Setting maintain - Mobile Security. Permission to edit Mobile Security options.

Manual Entry in CMX

This chapter presents CMX Manual Entry's new items related to Mobile Security Plus.

Not all items are uniquely part of Mobile Security Plus, but they are good to take into
account when performing calibrations using the Manual Entry window.

* Depending on permissions, user may or may not alter the calibration time. See
Users and Permissions Window.

* Depending on CMX Settings, user may or may not skip calibration points. See

Settings Window.

 If skipping a calibration point is allowed, user may be required to enter a note. This

is also defined in CMX Settings.

The note may not be "invisible" characters.

Again, see Settings Window.

Calibration Results in CMX

The following settings do not require that Mobile Security Plus is active:

» When viewing results, any skipped points are indicated in the result window. If in
CMX Settings, the skipped point is required to have a note, it is seen among the

results.

» Also, if the calibration was saved as an incomplete calibration, it is indicated in the

result page.
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If Mobile Security Plus is active:

» Clicking the secondary mouse button above a calibration result icon in CMX main
window's tree view, opens a pop-up menu where you can Lock or Unlock the
calibration result.

Note that locking/unlocking requires permission to do changes to calibration
results. See Users and Permissions Window.

A locked result's icon:

Figure 28: Locked Result

Note: When Mobile Security Plus feature is in use, an electronic signature

o can only be given by the user who is logged in to the CMX. When Mobile
Security Plus is not in use, then functionality is as before: Anyone can give
the electronic signature.

Mobile Security in Mobile Devices

Mobile Devices have their own Mobile Security Plus related settings, provided their
firmware support Mobile Security Plus. Refer to Mobile Device's own manual/help on
what the settings are. When a Mobile Device is connected to CMX, CMX "pushes"
some data/settings to the Mobile Device.

Mobile Security Plus related things when connecting CMX and a Mobile Device:

» CMX synchronizes the calendar and clock of a Mobile Device and the Computer
CMX is installed to. The Mobile Device's clock is the one that is adjusted, if
needed.

0 Note: This does not apply to tablets with bMobile.

« CMX also synchronizes Mobile Security related settings in CMX to the Mobile
Device.

+ If Mobile Password is in use (see Settings Window), CMX sends Mobile User
credentials to the Mobile Device. Then the Mobile Device requires users to
authenticate themselves when starting calibrations and also when saving a
calibration result.
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If Mobile Password is not in use, the Mobile Device does not require a login or
authentication when saving a calibration. However, Mobile Users defined in CMX
are transferred to the Mobile Device. This allows calibration technician, a Mobile
User, to select his/her name from a pick up list when saving a calibration.

When communicating with a Mobile Device, CMX reads the Device's firmware
version. If the firmware version does not support Mobile Security Plus, user is
asked to update the firmware in the Mobile Device.

If a Mobile Device contains an instrument with results, the same instrument may
not be sent to the Mobile Device, overwriting the existing results.

MCG6 supports receiving instruments to it from several CMX Databases. When
calibrating instruments, you first select a database and then the instrument.

O Note: This is not supported in bMobile.
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Data Loader

The Data Loader Tool can be used to import or populate instrument data from
another system via an excel file to CMX database.

General

Data Loader is optional in CMX Professional and a standard functionality in CMX
Enterprise.

Data Loader is a quick and easy way to add or edit large numbers of instruments in
your CMX database, saving time, reducing the risk of typing errors and promoting
high-quality and harmonized data.

CMX also allows you to create a Data Loader excel file, which makes it possible to
mass update CMX data. Data Loader Print saves the excel file. Its content can be
modified and imported back to CMX database via Data Loader.

To use Data Loader, the user must have the "Data Loader" license option enabled
and Data Loader permission enabled. See chapter Permissions.

The Data Loader window can be opened from the CMX main window’s Tools menu.

Data importing is started by selecting an excel file using the Browse... button in

the Data Loader window and after that Validation and Import can be executed. File
content is verified and file path is shown in Data Loader window whenever that file is
Data Loader compatible. File content summary is shown.

function types (transmitter, switch, weighing instrument and checklist) using
designated excel files. CMX contains separate excel file templates for
different function types. They are located in CMX application folder under
Files\Data Loader\Templates. By using these templates, it is easier to fill
only function type related fields in separate excel file, instead of having all
possible fields in one excel file.

0 Note: It is recommended to make separate Data Import for different

Validation

Excel file content must be validated before importing is allowed. Validation checks
excel file's content for possible warnings/errors in entered data. Validation does not
check the data against the CMX database, which is done during the Import phase.

Validation is enabled when user has selected a Data Loader compatible excel file.
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Validation is started by clicking Validate button in the Validate tab or in the Data
Loader window's toolbar.

The progress of the Validation is shown in the progress bar during validation. The
summary is shown under the progress bar.

When validation is completed, status of each instrument row in the excel file is shown
in the Log table.

Validation log rows can be saved to a text file using the Save Log button. File name
and location can be entered.

The Import button is enabled when at least one of the items passes validation.

gives warning message for such existing excel fields. Locked field data is

O Note: If CMX contains locked fields configuration, Data Loader validation
not imported from excel file. See more in Field Locking.

Import

Instrument data from excel file can be imported to the database after excel file
content is successfully validated.

Importing is started by clicking Import button in the Import tab or in the Data Loader
window's toolbar.

A reminder to do a backup is shown as the first thing when Import is started.

It is possible to execute importing only when at least one of the items in the excel file
has passed the validation. Only passed validations are imported.

Import progress is shown in the progress bar during importing. The summary is
shown under the progress bar.

When importing is completed, status of each imported row is shown in the Log table.

Import log rows can be saved to a text file using the Save Log button. File name and
location can be entered.

Instruments will be updated to CMX tree view after Data Loader window is closed.

shows a warning message for such existing excel fields. Locked field data

0 Note: If CMX contains locked fields configuration, Data Loader validation
is not imported from the excel file. See more in Field Locking.

Data Adaptation

CMX contains and references several fixed pick-up lists. One example of such list
is the values for different transfer functions. The items in all of these pick-up lists
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are referred to by their corresponding database code. These do not change and are
required when instrument import is being processed.

Data adaptation helps with use of these seemingly random database codes by letting
the user to use a more descriptive value. The available aliases for all pick-up list
codes are found in the DataAdapterConfig.xml file, located in the CMX installation
folder.

The DataAdapterConfig.xml file contains a set of predefined aliases for each fixed
pick-up list and new aliases can be added if needed. Presented below the example of
adapting different values for Linear transfer function be:

<I--Transfer Function-->
<FunctionTransferFunction>

<LINEAR code="2">

<Alias default="true">Linear</Alias>
<Alias default="false">2</Alias>

<Alias default="false">Lineaarinen</Alias>
<Alias default="false">Linearni</Alias>
<Alias default="false">Linéaire</Alias>
<Alias default="false">Liniowa</Alias>
<Alias default="fal se" >tHHHHHH</Alias>
<Alias default="false">Linea </Alias>
<Alias default="false">Linjar</Alias>
</LINEAR>

</FunctionTransferFunction>

Using the example adaptation above, changing the transfer function of the imported
instrument to a different value than the one defined in the used function template can
be done by using any of the defined aliases or the transfer function code.

0 Note: New codes or lists cannot be added to the DataAdapterConfig.xml
file.

Print

Saving an Instrument to an excel file can be done by opening Data Loader printing
and selecting instruments to be saved to an excel file.

To use Data Loader printing, user must have "Data Loader" license option enabled
and Data Loader Print permission enabled. See chapter Permissions.

Print menu is located in the CMX main window (Documents > Data Loader > Print).

The Print Data Loader window can be opened from the CMX main window’s
Documents menu or CMX Documents toolbar .

See: Printing Data Loader for more information.



CMX includes Default Layouts that can be used to save different collection of fields to

an excel file.

Report designer can be used to define own field collection in the excel file. Report
layouts for Data Loader can be imported/exported using Importing/Exporting

Document Layouts.

Data Loader -

Default Layouts

CMX includes some premade layouts, which helps to save only certain level or
function type related fields to the excel file. Following predefined layouts exist in

CMX:

Plant Structure Excel file for Data Loader.Ist

o Used for creating/modifying plant structure and data.

Position Excel file for Data Loader.Ist

o Used for creating/modifying position data.

Device Excel file for Data Loader.Ist

o Used for creating/modifying device data.

Regular Transmitter Excel file for Data Loader.Ist

o Used for creating/modifying regular transmitter data.

Switch Excel file for Data Loader.Ist

o Used for creating/modifying Switch instrument data.

Weighing Instrument Excel file for Data Loader.lIst

o Used for creating/modifying Weighing Instrument data.

Checklist Excel file for Data Loader.lIst

o Used for creating/modifying checklist instruments.

Descriptions of Fields in Data Loader

For detailed description of all fields available in the Data Loader excel file, please see

CMX webhelp.
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Automatic Result Validation

The automatic result validation requires the change management option. It can
be enabled in order to have CMX automatically validate calibration results. The
validation of a calibration result is triggered upon approving the result.

CMX will sign the calibration result with a 'Pending Second Approval' system
signature if it is invalidated by any of the active validation rules. Approving a result
that is pending second approval requires that another user, with the permission to
approve invalidated results, reviews and gives the final approval.

If work orders are being used, then those are also being marked as 'Pending Second
Approval' until all related calibrations have been given a second approval. When all
related results have been approved, having required second approval or not, the
work order is or can be marked as completed. Do note that this is subject to different
configurations. See Automatic Result Validation with Work Order for more details.

It is also possible to have CMX send second approval requests via e-mail when
calibration results are invalidated. The e-mail message contains relevant data about
the instrument that has a calibration result that requires a second approval.

Apart from enabling the 'Automatic result validation' event, the target user(s) also
need(s) to have:

» A valid e-mail address.

* Access to the instrument. The user must belong to the user- or site group defined
by the accessibility of the instrument's position or device.

» The 'Calibration - invalidated result approve' Permissions. The permission must
either be set directly on the accessible group (normal or site group), or the user
must be part of another normal user group which may or may not be set as an
accessible group.

The rules which CMX can automatically validate calibration results against are
listed in Validation Rules.

Note: Please see Automatic Result Validation with Work Order for
o details about using the feature with work orders.

Validation Rules

The validation rules window lets you manage the list of active validation rules. It is
possible to change the name or to set a custom id for an activated rule.

Field level information is available in the webhelp delivered with CMX.
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Only one instance of a validation rule can be created for most of the types. Multiple
validation rule instances can, however, be created in those cases where the rule
makes use of configuration parameter(s), such as the 'Calibration reference overdue'

rule.

O

Note: Automatic result validation in Change Management Settings needs
to be activated to be able to define Validation Rules.

To create or activate a validation rule, select the desired rule and click 'New'.

To delete a validation rule, select the instance from under the parent type and click

'Remove’.

O

Note: The validation rule is permanently deleted from the database only in
those cases where it has not yet been used. If it has been used, then it is
only marked as removed.

The possible Validation rules to be executed after calibration is approved, are
described in the table below:

Table 21: Validation Rules

Rule Description

Incomplete Invalidates the calibration if it contains an incomplete repeat.
calibration

Failed Calibration |Invalidates the calibration if it contains a failed repeat.

Includes calibration
note

Invalidates the calibration if a calibration note is given.

Includes calibration

Invalidates the calibration if a calibration document or link is

document added.
Checklist item Invalidates the calibration if a repeat contains a failed or
failed or skipped skipped item.

Calibration done
when overdue

Invalidates the calibration if it is done after the procedure's due
date. If an active work order contains a value for the procedure
due date, the calibration date is checked against that value
instead.

Calibration point
deviation exceeded

Invalidates the calibration if a calibration point deviates more
than the defined max deviation. Requires that a max deviation
is set for calibration points.

Calibration
reference overdue

Invalidates the calibration if any of the used references are
overdue. The threshold is configurable and value between 0
and 365 days can be set.
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Rule

Description

Calibration

point error with
uncertainty outside
the error limit

Invalidates the calibration if a calibration point error, together
with the expanded uncertainty, is outside the error limit. This
can be seen in the error graph of a calibration result where the
point's error uncertainty bar crosses the error limit line.

account, the passed or failed status of the saved

ﬂ Note: This rule does not affect, nor does it take into
calibration.

Click 'OK' to save the changes made to the list of active validation rules.

changes. This means that if you cancel the settings window it will discard
your changes. To persist the changes to the database you also have to
save the settings window by clicking 'OK".

0 Note: Clicking 'OK" in the validation rules window will only cache your

174



CMX Database Manager -

CMX Database Manager

CMX Database Manager is a tool for doing backups of your databases as well as
restoring databases using a backup database as the source. Additionally you can
also install/uninstall, create and copy CMX databases.

database and database server users. Using this tool without knowing

0 Note: CMX Database Manager should be used by experienced
what you are doing may result in loss of valuable data.

Starting CMX Database Manager

CMX Database Manager is installed in the same folder as CMX. Look for
BxbDat abaseSet up. exe.

The next chapters describe the use of the Database Manager.

Note: Start the CMX Database Manager in same computer where the
0 CMX database server is.

Server Connection

The upper part of CMX Database Manager’s window contains server connection
data. The data is pre-entered as needed for CMX. If you log into another server, you
need to enter the server login and password accordingly. Click Login, to log into the
server.

Server Authentication (default) or Windows Authentication. Use the

0 Note: CMX Database Manager includes a possibility utilize either SQL
Authentication selection list to choose the one you want.

The following subchapters describe the functionality of the lower part of the window.
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Backup and Restore a Database

Select the database to be backed up or restored from the Database Name list.

When making a backup copy of a CMX database, the backup file is named as the
original file with the addition of the backup date (format: _yyyy-mm-dd_hh-mm). The
path and the backup file name is editable but we recommend you use the default

values.

To restore a database, first select the backup database to be used for restoring and
then click the Restore button.

O

Note: Making database backups is highly recommended. It minimizes
data loss in case of power failure, network problems etc.

CMX Database Manager must be run locally on the computer where the
database is located, you can not, e.g. restore a database remotely (via the
network) to another computer.

If you get the following error message when restoring a backup file:
Restore failed for server '‘computer name'\CMXSQLEXPRESS",

it means you are trying to restore backup file that is located in a path the
SQL server does not have permissions to. An example is the desktop.
Each user may copy files etc. to their own desktop, but the SQL server
does not have permissions to the desktop.

Copy the backup file to, e.g. the root of the C:\ disk. Then retry. Database
backup and restore is not possible if the same database is in use in CMX.
Close CMX before starting backup or restore procedures.

Installing and Uninstalling a Database

Available databases:

+ CMX_Demo_Database, a demo database to see how the user interface looks like
with some data added to the database. This is the default database when CMX is
started for the first time after installation.

« CMX_Database, an empty database for creating your own database. WWhen
needed, you may switch to this database as described in Opening a Database.

If you want to either uninstall or reinstall one of the databases, use the tools found in
the second tab.

First select which database you want to work with and then select the button that
suits your needs (Uninstall/Detach or Install/Attach).
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Note: Uninstalling a Database is not possible if the same database is in
0 use in CMX. Close CMX before starting the uninstall procedure.

If you have entered your own data into either of the databases
shipped with CMX, uninstalling that database results in data loss!

Creating a New Database

Allows you to create an all new (empty) CMX database. Give the new database a
name. Standard Windows file naming conventions apply, except that you do not need
to enter the file extension. Then click the Create button.

Taking the new database into use depends on the type of CMX software you have.

* In CMX Enterprise or CMX Professional with the floating server license option you
first need to add the database to the CMX Application Server.

It

Open the Application Server from the icon found in the system tray ().
Enter the following menu commands in the Application Server window: Tools >
Database Settings.

During login CMX offers to connect to the latest database used. To switch database,
select another (host and) database from the login window.

Alternatively, when CMX is already running, use the main window's menu to select:

» File, Database in CMX Professional without the floating server license option
or

» File, Host in CMX Enterprise or CMX Professional floating server license
option. Then enter required information to log into another database.

Copying a Database

This feature allows you to copy a backup database and create a new CMX database
of it.

Click the Browse button to locate the backup file. The file must be on a local hard
drive or on the CMX installation media, but not on a network drive.

Give the new database a name. Standard Windows file naming conventions apply,
except that you do not need to enter the file extension. Then click the Copy button.

See the end of section in Creating a New Database for information on how to take
use of the copied (new) database.
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Deleting a Database

Select the database to be deleted from the list provided. Click the Delete button to do
it.

Note: There is no way of retrieving a deleted database. Perform the delete
o only if you are sure that the database to be deleted is no longer of use at
all.

Moving a Database

Select the database to be moved and the destination server. You may also rename
the database to be moved.

Note: The source and destination databases have to be in the same
ﬂ computer when moving. If not, use CMX Database Manager's Backup and
Restore tools.

The Move utility includes a possibility to utilize either SQL Server
Authentication (default) or Windows Authentication. Use the
Authentication selection list to choose the one you want.

If source and target SQL Server versions are different you may get a
permission error. To fix this, it is required to give the service account of the
target database engine read permission to the backup folder of the source.
This folder is by default located in the installation folder of SQL server.
Read permission can be given to either all users (builtin\users) or to the
target’s database engine service account directly.
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Additional Information

This section includes additional information not related to CMX alone, but useful
when working with CMX.

Absolute Pressure Measurement and
Uncertainty Calculation

Absolute Pressure Measurement uses two pressure modules simultaneously: a
gauge pressure module and a barometric module. The total uncertainty of that kind
of measurement is a combination of the uncertainties of both modules used in the
calibration.

There's a catch in how CMX calculates the total uncertainty of an absolute pressure,
but first we need to know what kind of pressure modules Beamex offers.

By default, Beamex calibrators use external pressure modules as follows:
* High Accuracy EXT(-IS) modules in
MC5, MC5-IS and MC5P.

« Standard Accuracy EXT-s(-IS) modules in
MC2, MC2-IS, MC4 (and MC3).

The 1 year uncertainties of available external and internal barometric modules are as
follows:

* High Accuracy EXT B:
0.05 kPa /0.5 mbar / 0.0073 psi

* High Accuracy Internal Barometric Module used in
MC5, MC5-IS and MC5P:
0.05 kPa / 0.5 mbar / 0.0073 psi

« Standard Accuracy Internal Barometric Module used in
MC2, MC2-IS, MC4 (and MC3):
0.1 kPa /1 mbar / 0.0146 psi

CMX's catch is that it assumes that the barometric module is of the same type as the
gauge module.

So, if you are consistent with the use of pressure modules, i.e. you measure absolute
pressure using a High Accuracy barometric module together with a High Accuracy
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gauge pressure module or a Standard Accuracy barometric module together with a
Standard Accuracy gauge pressure module, you'll be fine. The uncertainty calculation
works as it should.

But if you combine pressure module types when you measure absolute pressure,
the uncertainty of the barometric module is assumed wrongly. Thus, depending on
the combination, the total uncertainty is either 0.05 kPa (or 0.5 mbar / 0.0073 psi) too
good or too poor.

Examples:

1. A High Accuracy EXT2C gauge module is used in an MC4 with a Standard
Accuracy Internal Barometric Module.

Then CMX assumes that the barometric module is a High Accuracy module too
and uses a too good accuracy component when calculating the total uncertainty.
You should add 0.05 kPa (or 0.5 mbar / 0.0073 psi) to the total uncertainty.

2. A High Accuracy EXT B barometric module is used in an MC4 with a Standard
Accuracy Internal Gauge Module.

Then CMX assumes that the barometric module is a standard accuracy module
too and uses a too poor accuracy component when calculating the total
uncertainty. You should subtract 0.05 kPa (or 0.5 mbar / 0.0073 psi) from the
total uncertainty.

3. A Standard Accuracy EXT2C-s gauge module is used in an MC5 with a High
Accuracy Internal Gauge Module.

Then CMX assumes that the barometric module is a standard accuracy module
too and uses a too poor accuracy component when calculating the total
uncertainty. You should subtract 0.05 kPa (or 0.5 mbar / 0.0073 psi) from the
total uncertainty.

of standard accuracy and high accuracy modules, consider editing the
absolute pressure measuring range specifications for that particular gauge
module. The field in question is Constant Error. More of specifications

in Adding Module Ranges and Calibrator Module Range Fields, CMX
webhelp.

0 Note: If absolute pressure is always measured using the same pair

When performing this customization, you should record the change for
future needs. If you later on purchase more pressure modules / calibrators
and maybe use a different combination to measure absolute pressure, you
need to assure the specifications are valid for that combination.

Temperature Blocks and CMX

When calibrating temperature instruments using Beamex' Temperature Blocks, such
as FB Field Temperature Block series and MB Metrology Temperature Block series,
there are some issues to be taken into account. Here's a brief description of them.
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Specifications of Temperature Blocks

The specifications of Temperature Blocks are divided into several components as
follows:

Table 22: Specifications of Temperature Blocks

Component Description

Display Accuracy The specification of the internal measurement.

Stability The instability of the block's temperature

Axial Uniformity The vertical temperature gradient in the block

Radial Uniformity The horizontal temperature gradient in the block

Load Effect Measurement probe(s) leaking heat to/from the block to
the ambient

Hysteresis The variation in readouts when reaching a certain
temperature from higher or lower temperatures

Reference Connection From reading the reference sensor connected to the
Temperature Block

0 Note: Not all components are valid in all applications using a Temperature
Block.

Detailed specification data is in the Temperature Block's User Guide.

Specifications of Temperature Blocks in CMX

In CMX, the uncertainty for a certain calibrator's/module's (sub-)range is saved as a
Constant Error and a possible Relative Error, % of Reading. For Temperature Blocks,
the Constant Error and Relative Error are combined from applicable components
presented in Specifications of Temperature Blocks.

The possible methods of use are as follows:

Method 1: Temperature Block With Internal Temperature Measurement

A Temperature Block is used for creating the necessary temperature and the
Temperature Block's internal temperature sensor is used for measuring the
Block's temperature. The Input Method setting of the instrument to be calibrated
is “Controlled/Measured” and no external reference sensor is connected to the
calibrator or the Temperature Block.

The following specification components of the Temperature Block are combined in
CMX's Constant Error and Relative Error data:

* Display Accuracy
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« Stability
 Axial Uniformity
* Radial Uniformity
» Load Effect

» Hysteresis

Method 2: Reference Sensor Connected to R-type Temperature Block

An R-type Temperature Block controls the temperature and a reference sensor
connected to the Temperature Block is used for measuring the temperature. The
Input Method setting of the instrument to be calibrated is “Controlled/Measured”.

In this case, the following specification components of the R-type Temperature Block
are combined in CMX's Constant Error and Relative Error data:

 Stability

 Axial Uniformity

* Radial Uniformity

» Load Effect

* Reference Connection

In modern calibrators, communicating with a Temperature Block, you may define

the used reference sensor model. When receiving calibration results to CMX, the
reference sensor and, when applicable, its specifications are included with calibration

result data. Also: The Temperature Block's specifications, as presented above, are
included with calibration result data. See also note below.

in CMX. For other sensors and devices, the model and its specifications

O Note: For Beamex smart sensors, the specifications are already available
need to be added to CMX's database prior to using them in calibrations.

Method 3: Reference Sensor Connected to an External Device

Temperature Block controls the temperature and an external reference sensor is in
the block, but the sensor is connected to an external temperature measuring device.
The Input Method setting of the instrument to be calibrated is “Controlled”.

In this case, the following specification components of the Temperature Block are
combined in CMX's Constant Error and Relative Error data:

« Stability

 Axial Uniformity

* Radial Uniformity

» Load Effect

There are two possibilities for the refrence sensor connection:
A: The reference sensor is connected to the calibrator.

B: The reference sensor is measured using a third party device.

In modern calibrators, communicating with a Temperature Block, you may define
the used reference sensor model and, when applicable, the third party device
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model used for measuring the reference sensor. When receiving calibration results
to CMX, the reference sensor, the third party device and, when applicable, their
specifications are included with calibration result data. Also: The Temperature Block's
specifications, as presented above, are included with calibration result data. See also
note in method 2.

How the Temperature Block's accuracy specifications are converted to
uncertainty data in CMX

Equation:
.2 . .3 D 82
Ll [:I.lu'l. :'t .lu'l.l_ll _‘; I_II
tb = AR AR A
43 4B 3 3
. .7 ) .2 2
LE Hy RC
3 3 3
Where:

* Uy — The standard uncertainty of a Temperature Block.

* DA — The Display Accuracy specification. Zero when using methods 2 and 3.
+ St — The Stability specification.

* AU — The Axial Uniformity specification.

* RU — The Radial Uniformity specification.

* LE — Load Effect specification.

* Hy — The Hysteresis specification. Zero when using methods 2 and 3.

+ RC — The Reference Connection specification. Zero when using methods 1 and
3.

Note: All specifications have a rectangular probability distribution. That is
0 why they are divided by the square root of three.

In CMX, the uncertainties are saved as expanded uncertainties, i.e. the
standard uncertainties are multiplied by two.

Application Logging

Application logging is enabled by default in CMX and can be used to track or
troubleshoot certain issues by analyzing the logged events.
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Most of the logging currently is done by the Data Loader tool but additional events
will be added and logged in future versions.

The logging framework that is used is NLog, which is a free and flexible open-source
logging framework. The default configuration in CMX is to log info or more severe
events to a file in CMX’s application data directory (Y%oappdata%\Beamex Oy Ab\CMX
Calibration Management Software\logs\).

For detailed description on CMX'’s default file target settings, please see CMX
webhelp.

For detailed description on application logging in CMX Server, please see the CMX
Application Server webhelp.

Third Party Licenses

CMX, CWSI Server and CWSI Client include a number of third-party libraries that
are used to provide certain features. Additional copyright and legal notices and
license terms applicable to the third-party libraries may apply. A list of the third-party
libraries included in CMX, CWSI Server and CWSI Client can be found in the PDF
file CMX-3rd-party-components, located in the Documents folder in the installation
media.

By accepting the terms of the Beamex software license agreement, you also accept
the third party terms.

Trademarks

HART® is a registered trademark of the HART Communication Foundation.
FOUNDATION™ Fieldbus is a trademark of Fieldbus Foundation.

PROFIBUS® is a trademark of PROFIBUS International.

Windows, Microsoft Windows operating systems and Activesync are registered
trademarks of Microsoft Corporation in the United States and other countries.

Other trademarks are property of their respective owners.
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B

Business Bridge

Beamex Business Bridge is a software that communicates between CMX and ERP/
CMMS Asset Management software. When purchased, Beamex's support helps
customizing Business Bridge to work between CMX and the Asset Management
software in use.

C

Calibration Points

Calibration Points are the input signal values (sometimes the output signal values)
used in the calibration of a function.

Calibration Procedure

The procedure includes information on how the calibration should be accomplished,
like:

* Can the calibration be performed automatically or is it done manually
» Can the calibration be carried out on the field or not
* Recommended calibrator(s) to be used in the calibration.

D

dl, d2,d3 and d4

Actual scale interval. More information in CMX's help file. Search for "Actual scale
interval".

Device
A Device is the physical instrument that can be installed into a Position.

E

el, e2,e3 and e4

Verification scale interval. More information in CMX's help file. Search for "Verification
scale interval”.

ERP/CMMS

ERP = Enterprise Resource Planning.
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CMMS = Computerized Maintenance Management System.

Both are asset management software.

—

Function

A single task done with an instrument, e.g. temperature transmitter, pressure
indicator etc. Instruments capable of performing several tasks are called multifunction
instruments.

Function Type is the description of the function (input/output quantities and ranges)
and information concerning the calibration of the function (e.g. calibration points and
error limits).

See also Multi-function.

Input Method

How the input signal of the instrument is obtained into CMX. Examples of Input
Methods:

* Measured by the calibrator

» Sourced by the calibrator

» Controlled by a pressure controller and measured by the calibrator etc.
Instrument

For CMX, any Position seen on the main windows’ Positions Tree are instruments.
No matter what kind of function the instrument contains.

Instrument Collection

A collection of instruments located in the same database.

M

Multi-function

A multi-function Position or Device can carry out several operations, e.g. a
temperature transmitter and a temperature indicator is an instrument with two
functions.

O

Output Method

How the output signal of the instrument is obtained into CMX.
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P

Position

S

A Position is the location in a process where a device can be installed. Positions
often have symbolic names (tags) like TTI1 215 in instrumentation drawings.

A Position can be calibrated only when a device is installed because a location
cannot be calibrated.

Secondary Button

Sets

U

User ID

uTC

The mouse’s secondary button is the rightmost one, if you are using the mouse with
your right hand.

Sets are groups of Device's or Position's Functions that the user may create with the
Set Maintain utility. Usually Devices or Positions belonging to a set have something in
common, e.g. they are all calibrated during the same week, they are all located in the
same unit of plant etc.

How the sets are devised depend on the user application requirements.

An abbreviation for identifying each user of CMX. Needed, e.g. when starting CMX.
Using the same User IDs as is used on your network login is recommended.

UTC (abbreviation of Coordinated Universal Time) is the primary standard time,
common to every place in the world. Formerly it was called Greenwich Mean Time
(GMT). UTC is expressed using a 24-hour clock. An offset value is used to indicate a
time zone's time difference to Greenwich Mean Time (UTC+0).

Table 23: Examples of Time Zones Presented in the UTC Format

Time zone uTC

Central European Time UTC+1
Central European Summer Time UTC+2
US Central Standard Time UTC-6
US Central Daylight Time UTC-5
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